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Introduction UNITLINTRODUCTION Computers! An amazing machine! We are living in the computer age today
and most of our day to day activities cannot be accomplished without using computers. Sometimes knowingly and
sometimes unknowingly we use computers. Whether we have to withdraw money from the ATM (Automated Teller
Machines retranslated as Any Time Money), publish a newsletter, drive a motorbike, design a building or even a new
dress, go to a grocery shop and buy from cookies to tyres for our car - all involve computer in one way or the other. We
are breathing in the computer age and gradually computer has become such a dire necessity of life that it is difficult to
imagine life without it. Computer is affecting every sphere of our life. Be it government, business, education, legal
practice, entertainment, defense or home - computer has become an indispensable and multipurpose tool. Whereas
supercomputers can forecast weather, embedded computers make smart devices like washing machines that beep
when washing is complete or the automobiles that give you warning before breaking down. In this unit we will see how
computers affect our daily lives, its positive and negative effects, characteristics, history, the various types of computers
and the tasks associated with them. Need for Computer Literacy Computers have shaken up the world. They have made
us dependent upon them. We expect them to be present at every place: be it the reservation counter, the microwave
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LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Introduction ? Characteristics of Computers ? Evolution of Computers ? Early Electronic Computers ? Computer
Generations

2 Basic Computer Skills cooking or even driving a car. Now that computers have moved in our society so rapidly, one
needs, at least the basic computer skills to pursue one's career goals and function effectively and efficiently. We can say
that computer literacy is the need of today and voice of tomorrow to survive in the fast changing world of computers.
For most of the people computer literacy is restricted to using the keyboard for typing a document or making use of it
for the calculations. But this is not enough. One must know the fundamental concepts about what computers constitute
of and how do they work. Take an example, you drive a motorbike and you take it for the servicing. There is one way that
you tell the service boy to service the motorbike and | will collect it in the evening. The another way could be that you
tell him that, apart from servicing, please change the engine oil and clean the carburetor too. This way the service man
would be more careful while doing the job of your motorbike and you too will be able to solve at least some of the small
problems when the mechanic is not available. The lack of knowledge sometimes leads to getting into great troubles.
Lack of knowledge can cause mistakes while using the computer also. Sometimes this lack of knowledge causes some
fear in the people. This fear is termed as CYBERPHOBIA. (This is not a technical term, it is just used for the people who
are scared of using the computers.) Computer: The Definition For most of the people, computer is a machine used for
calculations or computation, but actually, it is much more than that. Precisely, "“Computer is an electronic device for
performing arithmetic and logical operations”, or "Computer is a device or flexible machine to process data and convert
it into information”. Now, in the above two definitions, three words are tricky that need some explanation. Let us start
with logical operations-these are the type of operations in which decision(s) is/are involved. Data is simply raw facts or
figures collected whereas the information is what one gets after processing the data. Information is always useful and
meaningful for the user. Let us consider an example in which marks of various subjects are collected for a particular
group of students. Now, these marks independently (data) are of no use as such for the class teacher, but once she he
adds the marks of all the students and calculates their respective percentages, this becomes information and it serves
her/him in finding out the answer for the queries like Who has stood 1st in the class? or How many people have got
distinctions in the class? or What is the overall performance of the class? Computers are not only used for the purpose of
calculations. An accountant, a grocery shop owner, a bank or an ATM uses it like a computational device, where as an
author uses it as a writing tool, a musician as a device for controlling the music, kids as a machine for playing games and
so on. Now, you must be thinking that what is so special about this machine that people from diversified fields can use it
so flexibly for entirely different functions. The answer is that "computer is programmable” meaning that it all depends
upon what program computer is using for performing a particular function.

3 Introduction Now, the next question that comes into one's mind is, what is a program? In a very simple language we
can say that "A Program is
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a set of instructions telling the computer what to do.”
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a set of instructions telling the computer what to do.”

Broadly computer can be said to be made up of hardware and software. The computer hardware (actual machine) is
defined in such a way that it does whatever the software (computer programs) tells it to do. There are 4 basic operations
which a computer performs irrespective of the program which is running on it. They are classified as: - Figure 1.1 1. Input:
This is for the purpose of inserting or feeding data into the computer by means of an input device like keyboard. 2.
Processing: Some kind of processing is done in the computer to take out or transform the data in some way. 3. Output:
The computer produces output on a device, such as printer or a monitor, that shows the result of processing operations.
4. Storage: The computer stores the result of processing operations for future use in some storage device like hard disk
or a floppy disk. These operations are often referred to as IPOS cycle. But, the four steps of IPOS cycle - input,
processing, output and storage - may not necessarily appear in the same sequence as they are defined. Figure 1.2

4 Basic Computer SkilsCHARACTERISTICSOFCOMPUTERS?Speed: Acomputer is a very fast and
accurate device. It can process thousands of instructions within a few seconds for which a human being can take several
days or months. ? Accuracy: Degree of accuracy of the computer is very high. Errors can occur in computerized system
also but most of them occur due to human mistakes rather than technical problems in the computer. ? Versatility: We
can perform many different tasks on the computer. One moment it might be busy in calculating the statistical data of a
business organization for annual performance evaluation and at next moment it is capable of working on inventory
control. ? Permanent Memory: We can store very large amount of information in the secondary storage devices. This
information stays with the computer for further use where as humans tend to forget things. ? No Intelligence: A
computer can perform the information processing and reasoning only on the basis of the intelligence provided by
human beings (in terms of programs developed) but it cannot make decisions on its own. ? Diligence: Computer is free
from problems like exhaustion, lack of concentration, confusion, etc., unlike human beings. EVOLUTIONOFCOM
P UT E R S History of Computers Actually speaking electronic data processing doesn't go back more than just half a
century i.e. they are in existence merely from early 1940's. The very first modern electronic computer became
operational only in early 1940's. Infact, its only a little more than just five decades ago since the first modern electronic
computer was brought into existence for the purpose of business data processing. Computers before that were only
used in scientific and technological field. Although the present modern electronic computers are very recent but the idea
was conceived far back. The same could be seen by the advents of the history. In early days when our ancestors used to
reside in caves the counting was a problem. Still it was easier as he could count on his fingers but gradually it started
becoming difficult. As the belonging and possession increased, the need of more counting tools grew. It was not
possible to have more fingers. The record keeping switched to number of stones and then to scribbling on the walls of
their caves . But it was not possible to restrict oneself to stones and walls and they had to look out for some other
counting devices. As the civilization grew in mid-seventh century, the adding tools and devices started developing across
the world. Thus we can say that idea of computing is as old as the
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5 Introduction civilization itself. It is very important to learn how people attempted to create early computers as they
played very important role in reaching this stage. When they stared using stones to count their animals or the
possessions, they never knew that this will lead to a computer of today. People started following a set of procedures to
perform calculations with these stones, which later led to creation of a digital counting device, which was the
predecessor of a computer. 1450 B.C. Abacus—China The abacus is the first known calculating device. This illustrates
how the ancient computers worked. It was invented by the Chinese and is still widely used in the far east for commercial
calculations. In its primitive form, it consists of a wooden frame with a number of wires with beads strung through them.
The beads are used for counting and calculations. To show a number, beads are pulled down so that each rod represents
a digit. 1600 Napier Bones Another counting device "John Napier”, a Scottish mathematician, invented it. The "bones”
were strips of ivory with numbers written in them. When the bones were arranged properly, the user could read the
numbers in adjacent columns to get the answer of a multiplication operation. During the 16th to 19th centuries,
Europeans contributed in calculating machine by inventing several machine that used existing technologies like
clockwise gears and levers. 1642 A.D. Adding Machines—Blaise Pascal-France The well known French Scientist and
Mathematician, Blaise Pascal invented the first machine which could add, carry digits automatically. He was only
nineteen years old at that time. His machine was so revolutionary that the principle behind it is still used in most of the
mechanical counters being used today. He became European great philosopher and mathematician. His father was a tax
commissioner and he used to accompany his father to his office. There he felt the need of some calculating device,
which could save people like his father from that boring and tedious job of doing sums over and again. He came out with
a machine "Pascaline” that worked with clockwise gears and levers. The machine was basically developed to perform
addition and subtraction operations. The machine rotated wheels to register values and lever was used to perform the
carrying operations from one wheel to another. Although the machine was not accepted by the business but it initiated a
series of inventions. To give honour to Pascal, a computer programming language was named after him. This language,
Pascal, is generally used to teach programming to budding programers.

6 Basic Computer Skills 1692 A.D. Multiplying Machine—Gottfried Leibnitz— Germany Gottfried improved upon Pascal's
machine and introduced a mechanism to carry out automatic multiplication of numbers. Leibnita is best known for his
work with Sir Isaac Newton in developing a branch of mathematics known as calculus. The calculator invented by him
could add, subtract, multiply and divide accurately. It could even perform square root function, although not always
accurately. 1813 A.D. Difference Engine—Charles Babbage— England Since early 19th Century, Charles Babbage, an
Englishman, had been working on the development of a machine, which could perform complex calculations. In 1813
A.D., he invented the 'Different Engine’ which could perform complex calculations and print them out as well. This
machine was a steam - powered machine. While Babbage was working on his doctorate, he had to solve many complex
formulae and he found it difficult to cope up with them in the given time period. Early 1800's Jacquard Loom—-Joseph
Marie Jacquard In the early nineteenth century, a French weaver Joseph Marie Jacquard developed a programmable
loom, which used large cards and holes punched in them to control the pattern automatically. The output was a thick
rich cloth with repetitive floral or geometric patterns. Jacquard patterns are still produced to this day. Others adapted the
punched cards and used as the primary form of input. They were used till about 20-25 years ago. 1862 "Arithrometer”—
Charles Xavier Thomas— France This was the first calculator with commercial prospects. Frenchman Charles Xavier
Thomas (known as Charles of Colmar) developed it. He won a gold medal at the International Exhibition in London. The
machine performed addition, subtraction, multiplication, division and square root functions accurately. 1863 A.D. Analytic
Engine-Charles Babbage— England Babbage had been working on a very elaborate machine all this time. By 1863 he
had all the plans ready for the machine, which he named the Analytic Engine. He had conceived of a mechanism, which
could carry out long sequence of complex calculations under automatic control. It would have the ability to store 1000,
50-digit numbers in one second and multiply 20-digit numbers in three minutes.
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7 Introduction Babbage used a form of punched cards for inputting the data. That would have been a complete modern
computer but technology at that time was not advanced enough to provide him with the hardware he required. He was
thinking too far ahead of his time and his ideas could not be implemented. However, he was the first person to conceive
of the "Stored Program Concept”. Babbage worked on his plans for years. He was accompanied by Augusta Ada Byron
(the daughter of famous poet Lord Byron), a brilliant mathematician whose contribution to Babbage's work is
tremendous. She is the first female computer scientist and a programer. A computer programming language, Ada has
also been named in her honour. Charles Babbage is recognized as "the father of Computers”. Although his plans could
not be materialized and his analytical engine could not be completed in his life span but a working analytical engine was
finally developed from his plans in year 1991 and is on the display at the Charles Babbage Institute at Minnesota. 1896
A.D. Punch Card Machine— Dr. Hermann Hallerith—USA Dr Hallerith is also a great figure in the history of computers. Dr
Hallerith used the idea of using cards and punching holes in them for speeding up the collation job of the American
Census of 1880 (The US Constitution calls for the census of the population after every ten years so as to determine the
representation in the US House of representatives). He devised a card in which holes would be punched to indicate the
presence of a particular criteria in a respondent. Using wire brushes in his machine the hole punched earier in the card,
enabled a wire to touch a metal plate which carried on electric charge. The charge was transmitted to respective electric
counters which automatically incremented the numbers. After the census was completed, Hallerith perfected his
punched card equipment and marketed it. He founded the Tabulating Machine company in 1896 to continue his work.
Although the machines were in great demand but then Hallerith was not happy as he could not pursue his research
work. In 1911 the Tabulating- Machine Company merged with other two companies to form Computing-Tabulating-
Recording Company. Then Hallerith again started concentrating in inventing better equipment. One of the partners, the
marketing expert named Thomas Watson Sr, led the new company. Under his guidance, the company wrote a great
success story. Finally in 1924, management decided a new name for the company and then Computing- tabulating-
Recording Company converted to International Business Machines Corporation (IBM) Corp. His idea has been refined
and improved and punch cards are still used for recording data items to be input to computers. During the Second World
War, an acute need for fast calculating machines was felt to carry out complex defense calculations. The British and the
American Governments sponsored a number of projects in major Universities for the development of fast and accurate
calculators and computers. This proved to be a boon for the industry which has never looked back since then.

8 Basic Computer SkilsEARLYELECTRONICCOMPUTERS1930s’ Turing Machine Alan Turing in late 1930s
the English mathematician wrote a paper describing the capabilities and limitations of a hypothetical general purpose-
computing machine "Turing Machine”. Turing also helped constructing Robinson, the British Computer used during the
World War Il to decode German messages that were encrypted by the German Enigma machine. In 1950, Turing also
published a book titled "Computer machinery and Intelligence”, in which he proposed the Turing test of Artificial
Intelligence. That test is still used by scientists. Turing test basically explains that computer is capable of "interacting” with
the user. 1939 ABC (Atanasoff berry Computer) John Atanasoff Professor John Atanasoff is remembered because of his
contribution of some concepts, which led to the development of the electronic computer. He with a graduate student,
Clifford Berry built an electronic calculating machine that could solve the problems of equations. ABC was first special
purpose, electronic computer. 1944 Mark |-Dr. Howard Aiken Dr Howard Aiken, who read the notes of Ada Byron was
keenly interested in constructing an "Analytical Engine”. He approached IBM. In spite of doing very well with punched
card equipments, IBM hired Aiken and allocated $1 million for the Research. Aiken, with his tearm members, came out
with Mark I. Mark | was partly electronic and partly mechanical. It was bulky- 8 feet high and 55 feet long. It took 3to 5
seconds to perform a single multiplication operation. 1940s A.D. Mark | — University of Pennsylvania—USA A group of
scientists devised the Mark-I, which was the first Electromechanical calculators in the world. It utilized the punch-card
concepts the Hallerith and powers, and it functioned by a series of electromagnetic relays and mechanical arithmetic
counters. During the World War II American Military asked Dr John Mauchy of University of Pennsylvania to develop a
machine which can quickly calculate the trajectories for missiles. A graduated student Presper Eckert helped him in
building the device. This is another thing that the computer could not be completed until the two months after the war
ended.

9 Introduction 1943 A.D. ENIAC—-Harvard University—USA Closely following on the heels of Mark-I, scientists of Harvard
University brought out
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Electronic Numerical Integrator and Calculator (ENIAC) which was the first electronic computer. It

weighed nearly 5 tons and occupied space equivalent to 2 big rooms and could perform all the calculations that a small
pocket calculator of today can perform. It used vacuum tubes and was able to do 300 multiplications per second. This
was faster than Mark | but the major problem of using this computer was that the staff had to rewire the machine
completely for carrying out the new instructions. 1947 A.D. EDSAC-Cambridge University— England Electronic delayed
Storage and Calculation was the name given to the first electronic computer in the world. It was the first one to
implement the 'stored program concepts’. Known later as the 'Von Neumann Concept, it proposed the use of binary
numbers and the internal storage of instructions in digital form. 1951 A.D. UNIVAC — | — USA By now number of
commercial companies were working on the development of computing systems. Sperry Rand Corporation of USA
introduced the first commercial computer to the world and named it UNIVAC-I. Its introduction was followed by the
entrance of IBM into the computer field with IBM-701 Computer. COMPUTERGENERATIO NS Inrecent years,
the computer industry has grown at a phenomenal pace. In a short time of 35 years or so computers have improved
tremendously. In the last decade the speed of computer has increased 200 times. Not only that the reliability curve has
also taken a sharp increase. The cost per unit of calculating has gone down by 500 times. The storage capacity is
increasing so fast that now it seems that nothing is impossible to store. Large data can be stored in very small devices.
The term "generations” was initially introduced to distinguish between different hardware technologies. Gradually it
shifted to both hardware and software as the total systems consists of both of them. The computers can be divided in
five past generations, i.e, depending upon the technologies used. The five generations of computer are: First Generation
Until 1951, electronics computers were the exclusive possession of scientists and the military. Till then nobody tried to
use them for business purpose. The idea of marketing them was conceived by Mauchly and Eckert, creators of ENIAC's.
As US census bureau was already using IBCP cards, they were the pioneers in buying this computer for the

10 Basic Computer Skills first time in 1951. The company created by M and ETS became UNIVAC division of Sperry and
Corporation (later known as UNISYS). The bringing of first UNIVAC (Universal automatic computers) general purpose
electric digital computer, marks the beginning of the first generation of electronic computers. These computers used
valves and all the components were joined by copper wires. Due to large size of the components and due to the facts
that the components had to be spaced apart as the valves dissipated a lot of heat, the computers were very bulky and
required huge electric power, airconditioners, maintenance and space for their installation. Further, the speed of
operation was very slow and had a very low reliability factor as vacuum tubes failed frequently. They were still given the
name of "electronic brains " by the journalist. They also said that these electronic brains will change the world one-day.
Later IBM corporation developed IBM 701, IBM 702 and IBM 650 and few other systems. These were called the first
generation computers. The popular brand of first generation computer was IBM 650, which had a magnetic drum
memory and utilized punch cards for input and output. This type of computer was of an intermediate size and was
designed to meet the requirements of business and scientific applications. The available memories ranged from a few
hundred thousand words of main storage. The cycle time was of the order of few milli seconds. It was only after 1957
that magnetic tapes were introduced as a faster and convenient storage medium. A single tape could hold approximately
1100 P cards (i.e. about 2 pages of information). IBM made 19 IBM 701 computers and at that time industry felt that these
19 computers are sufficient enough to take care of American business. These computer required special facilities and
highly trained personnel. The instructions given to FGC were in machine language (i.e. 0's and 1's). As the language was
tough and understood by very few people. There were very few personnel available for it. Computer belonging to this
generation had the following characteristics: i. Comparatively large in size as compared to present day computers. ii.
Generated lot of heat, they were not consistent and reliable as the valves tended to fail frequently. iii. Low capacity
internal storage. iv. Individual, non-related models. v. Processors operated in the milliseconds speed range. vi. Internal
storage consisted of magnetic drum and delay lines. Second Generation FGC were very unreliable, mainly because of
vacuum tubes which kept on burning out. Users had to be prepared all the time with dozen of extra tubes to replace
them. The

11 Introduction computers of this generation were characterized by the use of Solid State devices (transistors) instead of
vacuum tubes.

MATCHING BLOCK 5/291 SA Computer Application.pdf (D166063658)

Transistorized circuits were smaller, generated little heat, were less expensive and consumed less power than vacuum
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tube circuits and were much greater in processing capacity. Since transistors had a faster switching action, this
generation computers were significantly faster and smaller and were more reliable too than first generation computers.
The use of magnetic cores as the primary internal storage medium and the introduction of removable magnetic disc
pack were other major developments of the second generation. Although magnetic tapes were still used commonly.
These computers had built in error detecting devices and more efficient means were developed to input and retrieve
from the computer. They were easier to work with. More efficient programming methods and higher level languages like
FORTRAN and COBOL become available. It was easily understandable by people especially because no codes (like
Assembly language) had to be remembered by the programers. Moreover unlike Assembly language the high level
language were not machine specific i.e. same set of programs could be used on computers produced by different
manufactures. The instruction cycle time dropped from several hundred microseconds of the first generation in tens of
micro- seconds of the second generation. The main memory in these systems could store several hundred thousand
words. This generation of computers could communicate with others using telephone lines. Transmission of data from
one computer to another was possible in this generation of computers. Although the processing was very slow but the
idea was convenient which was further developed in next generations. The problems which second-generation
computer faced was that input and output devices were too slow. The projects started in second generation to solve
these problems. They used second generation technology but finally proposed results in third generation. Dr Daniel
Slotnick worked out first solution. He was working with Burroughs Corporation, at that time. He designed a computer for
the US department of Defence and tried to solve the problem of machines sitting idle waiting for input and output. The
computer known as ILLIAC IV was developed. It has 4 control units and thus was able to perform input/output and
processing (mathematical operation) at the same time. Slotnick was granted a patent for "Parallel Processing”. They were
also called as first super computer. The second super computer was proposed by MIT (Massachusetts Institute of
Technology) by a group of students and professors. The name of the project was MAC (Multiple Access Computer) and
concept of multiprogramming was developed there. The system could process the programs concurrently which were
run by different users. Some of the popular models in this generation of computer systems, we IBM-1401, IBM-1620,
BURROUGHS B-200 SERIES, HONEY-WELL H-400, NATIONAL CASH REGISTER NCR-315, 500 AND UNIVAC-1004. Many
of these computers were used for business applications.

12 Basic Computer Skills Computers of this generation had the following characteristics: i. Smaller in size compared to
the first generation computers. ii. Generated a lower level of heat, as components were much smaller. iii. Greater degree
of reliability because of solid state technology. iv. Higher capacity of internal storage. v. Use of core storage instead of
magnetic drum and delay lines. vi. Related series of processors -the family concept. vii. Processor operated in the
microsecond speed. viii. High cost direct accesses storage. Third Generation A revolution in the computer developments
took place with the development of Integrated Circuits (IC) on a single silicon chip.
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In 1958, Jack St Clair Kelby and Robert Noyce invented the first IC.
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IC incorporated number of transistors and electronic circuits on a single wafer or chip of silicon. IC is called chip because
of the way they are made. They are also called as semi conductors as combining layers of materials that have varying
capacity to conduct electricity form them. This ushered in the third generation of computer systems in 1964. The
integrated circuits enhanced considerably the processing capability and the speed of the computer. During the period
1964 to 1970, capability of placing 12 or more logic gates on a single chip was developed into a well-defined technology
of Small-Scale Integration (SSI). A logic gate is a circuit to perform arithmetic of addition, subtraction, multiplication or
division. In 1970 this technology was redefined to a point where hundreds or more gates could be placed on a chip of
silicon and incorporated as functional logic block in an overall system. This technology was termed as Middle Scale
Integration (MSI). There was intense pressure on the semiconductor manufacturer to provide greater densities of gates
on a single integrated circuit chip. Consequently more complex chips were developed with the ultimate goal of
obtaining a central processor on a single physical circuits element. These circuits had higher reliability and lower power
consumption and substantially reduced size. Component densities of 1,000 to 10,000 gates on a single silicon chip
became possible. The technology consisting of 1,000 gates per chip, termed Large- Scale Integration (LSI), started to
become commercially viable in 1975. The later technology consisting of more than 10,000 gates per chip is called Very
Large Scale Integration (VLSI) or Grand Scale Integration (GSI). These circuit became very useful in assembling
computers.

MATCHING BLOCK 8/291 SA Computer Application.pdf (D166063658)

Some of the popular third generation computers are-IBM- 360, series, IBM-370 series

and ICL-2900 series. The large advanced computer systems are usually called ‘Main Frame'. Integrated circuits
technology is responsible for bringing in revolution in the computer industries. Scientists were aware that more powerful
computers can be built by building more complex circuits, but as these circuits had to be wired by hand, these computer
were too complex and expensive. |C solved this problem by introducing a computer

13 Introduction that costed lower then first generation computer and offered more memory and faster processing. In
1962, a new company built a plant in "Silicon Valley", near Sanjose, California. DEC (Digital Equipment Corporation)
revolutionised the total computer industry with this computer which used IC's. The first commercially available
minicomputer was introduced in 1965. The PDB-8 (Programmed Data Processor) could fit easily in the corner of a room
and did not require any attendant to it. The computer could be accessed by number of users from different locations of
the building. (That was actually implementing time-sharing, which was developed in second generation). The price was
one tenth of the traditional main frame, which made it possible for smaller companies to afford. IBM was dominant in the
market by releasing 360 series of computer. They were of different sizes of main frame computers. The main advantage
of using this computer was use of same machine language compatibility thus making it easy and cost effective specially
when upgraded. By 1967, IBM decided to change its track as number of programming language came in the market. This
was the beginning of software industry as the languages grew and people who had the skills to translate user
requirements in these languages were high on demand now. One more technology development which look place now
was the launching of first telecommunications satellite. The communication stations on the earth were now in a position
to send and receive data by means of satellite enabling communications between the computer systems around the
world. Admiral Grace Nurray Hopper, also known as "the mother of COBOL" and "Amazing Grace" was sent to Harvard to
work on the first large scale digital computer. She travelled to various computer conferences and gave lectures in various
colleges about the data processing insights. She wrote more than 50 papers and articles on software and programming
language. Dr Hopper tells about the origin of Bug and Debug in her book "understanding computers”. It was 1945, when
students were working on Mark Il and it stopped working. Programmers kept trying to figure out what's wrong with the
computer, finally discovered that there was a moth caught in one of the relays causing the whole trouble. They removed
it and the computer started working fine. There the terms "Bug” and "Debug” were introduced. The first bug can still be
seen taped on a page in a logbook at the Naval Weapons Museum in Dahlgren, Virginia. Computers of this generation
have the following characteristics: 1. Smaller in size as compared to second generation computers. 2. Higher capacity
internal storage. 3. Remote communication facilities.
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14 Basic Computer Skills 4. Multiprogramming facilities. 5. Reduced cost of direct access storage. 6. Processors, which
operate in nanosecond speed range. 7. Ranges of computers with a common architecture whereby models were upward
compatible. 8. Use of high level languages such as COBOL. 9. Wide range of optional peripherals. Fourth Generation The
1970's marked the beginning of a new generation of computers, produced by computer giants like IBM, ICL, NCR and
Burrought. From design viewpoint, the new generation provided increased input-output capability, longer component
life as well as greater system reliability. From the functional view point, new powerful language were developed to
broaden the use of multiprogramming and multiprocessing and major shift from batch processing to on line, remote
interactive processing. The development of microprocessor chip, which contains an entire central processing unit (CPU)
on a single silicon chip led to the mushroom growth of inexpensive computers. They are not computers by themselves
but they can perform all the functions of arithmetic logic unit and control units of the CPU. When these microprocessors
are connected with memory and input-output devices, they become microcomputers. The semiconductor memories
are also very small and very cheap. There are several types of memory chips. Three of the most commonly used are - (a)
Random Access Memory (RAM) in which data can be read or written corresponding to the main memory of the
conventional computer, (b) Read Only Memory (ROM) and (c) Programmable Read Only Memory (PROM). In the ROM
chips, the data is ‘burnt’ into the chip at the manufacturing time. It cannot be changed. These chips are used in systems
where the data need not to be changed. Even when power supply fails, the data remains in the memory. In case of
PROM a user can program and even correct the data if necessary. The fourth generation of computers may be called
microcomputer generation. The input-output devices used with the fourth generation computers are quite advanced.
Among the advanced input-output devices employed in fourth generation computers are optical readers by which
whole documents can be led into the computer, audio response terminals by which an operator can vocally introduce
data or instructions and graphic display terminals by which an operator can feed pictures into the computer. The use of
very large integrated circuits (VLSI) has made the fourth generation (micro) computers very compact, much less
expensive, faster, more reliable and of much greater data processing capacity than equalized third generation computers.
Some computers belonging to fourth generation are DEC-10, STAR-1000, PDP-11 and APPLE Series Personal Computers.
15 Introduction Fifth Generation Till fourth generation of computers, the major stress was on improving the hardware
from valves to transistors and then to integrated circuits, which resulted in miniaturization and fast speed of computers.
However, the lack of thinking power has forced the scientists to work further for fifth generation computers. The
concept of "Artificial Intelligence” is being used in these computers and Japanese call them "Knowledge Processors".
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Automatic programming, computational logic, pattern recognition and control of robots, the processes

and which need skill and intelligence are examples of Artificial Intelligence. These computers, when developed, will be
able to execute
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billions of instructions per second and will have unimaginable storage capacities.

The present day high level languages will become obsolete on these machines and new computer languages and related
software will be needed. The fifth generation gives the highest priority to making systems that are easy and natural to
use. Its other objective relates to the types of technological support needed to support “problem solving systems”
according to the fifth generation committee. “In these systems”, the Committee adds,” Intelligence will be greatly
improved to approach that of a human being. When compared to conventional systems, the man -machine interface will
be closer to that of human behaviour.” The fifth generation has three functional requirements: ? easy to use computers
with high intelligence and natural human input and output mechanism; ? reliable and efficient software development by
new languages, new computer architectures and systems software which overcome previous problems and ? improved
overall functions and performance aimed at making computers smaller, lighter, faster, of greater capacity, more flexible
and more reliable. It is these objectives which set the main themes for the future of computing, whatever techniques are

used to achieve them. EXERCISEFillintheblanks:a. ____________ can forecast weather. b. ____________
invented the first machine which could add, carry digits automatically. c. Sperry Round corporationof ____________
introduced UNIVAC-I. d. The computer known as ILLIACIVhas ____________ controlunits.e. ____________ tells

about the origin of Bug and Debug.
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16 Basic Computer Skills Unsolved Questions 1. What do you understand by the Word computer? 2. Write down the
basic characteristics of a computer. 3. Describe the evolution of computers. 4. What are the features of first generation
computers? 5. What are the advantages of second generation computers over first generation computers? 6. Describe
about the third generation computers. 7. What are the main features of fourth generation computers? 8. Write a short-
note on fifth generation computers.

Structure of Computer UN I T 2 In the

last unit, we discussed that there are many types of computers.

3-Introduction to Information Technology-Block ...
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The internal architectural design of computers differs from one model to another, however the basic
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internal architectural design of computers differs from one model to another, however the basic

components of a computer remain the same for all models.

In this unit, we will discuss

the basic structure of a computer system. The diagram of a generalised architecture of a computer system is shown in
Figure 2.1.

Before discussing the details of computer architecture, we would define the computer system as follows:

A complete computer installation including the central processing unit, the peripherals such as hard disk drives, floppy
disk drives, monitor, printer, mouse and operating system which are designed to work and interact with each other and
with the user is called a computer system. A computer system has the following main components: a. Input/OQutput Unit
b. Central Processing Unit c. Memory Unit

MATCHING BLOCK 13/291 W

LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Input/Output Unit ? Central Processing Unit ? Memory Unit ? Logic Gates/ Circuits ? BITS and BYTES ? Number System
for Data Representations ? Hardware and Software

18 Basic Computer Skills Input Device Output Device Arithmetic Logic Unit Control Unit Registers Primary Memory
Secondary Memory USER

Figure 2.1 Functional diagram of a generalised architecture of a computer system.

INPUT/OUTPUTUNIT

We know that the computer is a machine that processes the input data according to

a

given set of instructions and gives the output. Before a computer does processing, it must be given data and instructions.
After processing, the output must be displayed or printed by the computer. The unit used for getting the data and
instructions into the computer and displaying or printing output is known as an Input/Qutput Unit (I/O Unit). The

100% MATCHING BLOCK 14/291 w

Input Unit is used to enter data and instructions into a computer.

There are many peripheral devices which are used as input/ output units for the computer. The most common form of
input device is known as a terminal. A terminal has an electronic typewriter like device, called keyboard along with a
display screen, called Visual Display Unit (VDU) or monitor. Keyboard is the main input device while

the

monitor

can be considered both as an input as well as

an output device. There are some other common input devices like mouse, punched card, tape, joystick, scanner,
modem etc., which

are explained

in
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the next chapter.

Monitor, printer and plotter are the main peripheral devices used as output units for the computer.
CENTRALPROCESSINGUNIT

Central Processing Unit (

CPU) is the main component or “brain” of a computer, which performs all the processing of input data.

Its function is to fetch, examine and then execute the instructions stored in the

main

memory of

a

computer. In microcomputers, the CPU is built on a single chip or Integerated Circuit (IC) and is called as

a Microprocessor. The CPU consists of the following distinct parts: 1. Arithmetic Logic Unit (

ALU) 2. Control Unit (CU)

19 Structure of Computer 3. Registers 4. Buses 5. Clock

Arithmetic Logic Unit The arithmetic and logic unit of CPU is responsible for all arithmetic operations like addition,
subtraction, multiplication and division as well as logical operations such as less than, equal to and greater than. Actually,
all calculations and comparisons are performed in the arithmetic logic unit.

ControlUnit

The control unit

is responsible for controlling the transfer of data and instructions among other units of a computer. It

is considered

as
the ”
Central Nervous System”
Participant Guide Fundamentals of Computers.docx
)
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of computer, as it manages and coordinates all the units of the computer. It obtains the instructions from the memory,
interprets them and directs the operation of the computer. It

also performs the physical data transfer between memory and the peripheral device.
Registers
Registers are small high speed circuits (memory locations)

100% MATCHING BLOCK 17/291 w

which are used to store data, instructions and memory addresses (

memory location numbers), when ALU performs arithmetic and logical operations. Registers can store one word of data
(1 word = 2 bytes & 1 byte = 8 bits.

Details of BITS & BYTES are discussed later in this chapter) until it is overwritten by another word. Depending on the
processor’s

capability, the number and type of registers vary from one CPU to another.

Registers can be divided into six categories viz. General Purpose Registers, Pointer Registers, Segment Registers, Index
Registers, Flags Register and Instruction Pointer Register, depending upon their functions. The detailed functions of each
and every register

is beyond the scope of this book.

Buses Data is stored as a unit of eight bits (BIT stands for Binary Digit i.e. O or 1) in a register. Each bit is transferred from
one register to another by means of a separate wire. This group of eight wires, which is used as a common way to
transfer data between registers is known as a bus. In general terms, bus is a connection between two components to
transmit signal between them. Bus can be of three major types viz. Data Bus, Control Bus and Address Bus. The data bus
is used to move data, address bus to move address or memory location and control bus to send control signals between
various components of a computer.
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20
Basic Computer Skills

°1:74 MATCHING BLOCK 18/291 W

Clock Clock is another important component of CPU, which measures and allocates a fixed time slot for processing
each and every micro-operation (smallest functional operation). In simple terms, CPU is allocated one or more clock
cycles to complete a micro-operation. CPU executes the instructions in synchronization with the clock pulse. The
clock speed of CPU is measured in terms of Mega Hertz (MHz) or Millions of Cycles per second. The clock speed of
CPU varies from one model to another in the range 4.77 MHz (in 8088 processor) to 266 MHz (in Pentium Il). CPU
speed is also specified in terms of Millions of Instructions Per Second (MIPS) or Million of Floating Point Operations Per
Second (MFLOPS).

MEMORYUNIT

MATCHING BLOCK 19/291 w

Memory Unit is that component of a computer system, which is used to store the data, instructions and information
before, during and after the processing by ALU. It is actually a work area (physically a collection of integerated circuits)
within the computer, where the CPU stores the data and instructions. It is also known as a Main/Primary/Internal
Memory. It is of

the
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following three types: a. Read Only Memory (ROM pronounced as "Ra-om”) b. Random Access Memory (RAM
pronounced as "R-aem”) c. Complementary Metal Oxide Semiconductor Memory (CMOS)

ReadOnlyMemory
99% MATCHING BLOCK 21/291 W

Read Only Memory is an essential component of the memory unit. We know that the computer, being a machine, itself
has no intelligence or memory and requires instructions which are given by man. Whenever the computer is switched
on, it searches for the required instructions. The memory, which has these essential instructions, is known as Read
Only Memory (ROM). This memory is permanent and is not erased when

the
100% MATCHING BLOCK 22/291 w

system is switched off. As appears with its name, it is read type of memory i.e. it can be read only and not be written by
user/ programmer. The memory capacity of ROM varies from 64 KB to 256 KB (1 Kilobyte = 1024 bytes) depending on
the model of computer. ROM contains a number of programs (set of instructions). The most important program of
ROM is the Basic Input Output System (BIOS, pronounced as “bye-0s") which activates the hardware (physical
components of computer) such as keyboard, monitor, floppy disk etc. in communicating with the system and
application software (set of instructions or programs). Types of ROM There are many types of ROM available for
microcomputers like Mask ROM, PROM, EPROM, EEPROM and EAPROM. 21

Structure of Computer i.
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Mask ROM: Mask ROM is the basic ROM chip. In this type of ROM, the information is stored at the time of its
manufacturing. So, it cannot be altered or erased later on. ii. PROM:

100% MATCHING BLOCK 24/291 W

PROM: PROM stands for Programmable Read Only Memory. In this type of ROM, the information is stored by
programmers after its manufacturing. It

also

cannot

be altered or erased later on. iii.

EPROM: EPROM stands for Erasable Programmable Read Only Memory. It is similar to PROM, but its information can be
erased later on by ultra violet light and it can be reprogrammed.

91% MATCHING BLOCK 25/291 W

EEPROM: EEPROM stands for Electrically Erasable Programmable Read Only Memory. It is similiar to EPROM, but its
information can be erased by using an high voltage current. v. EAPROM: EAPROM stands for Electrically Alterable Read
Only Memory. As compared to EPROM and EEPROM, the information stored in EAPROM can be altered later.

RandomAccessMemory
Random Access Memory (RAM) is another important component of the

95% MATCHING BLOCK 26/291 w

Memory Unit. It is used to store data and instructions during the

execution
of programs. Contrary to ROM, RAM is temporary and is erased when
the
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computer is switched off. RAM is a read/ write type of memory, and thus can be read and written by

the
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user/ programmer. As it is possible to randomly use any location of this memory, therefore, this memory is known as
random access memory. The memory capacity of RAM varies from 640 KB to several megabytes (1 Megabyte = 1024
KB) with different models of PC. Types of RAM There are two types of RAM used in PCs - Dynamic and Static RAM.

100% MATCHING BLOCK 29/291 W

Dynamic RAM (DRAM): The information stored in Dynamic RAM has to be refreshed after every few milliseconds,
otherwise it is erased. DRAM has higher storage capacity and is cheaper than Static RAM.
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Static RAM (SRAM): The information stored in Static RAM need not be refreshed, but it remains stable as long as power
supply is provided. SRAM is costlier but has higher speed than DRAM.

ComplementaryMetalOxideSemiconductorMemory

100% MATCHING BLOCK 31/291 w

Complementary Metal Oxide Semiconductor (CMOS) memory is used to store the system configuration, date, time and
other important data. When

the
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computer is switched on, BIOS matches the information of CMOS with the peripheral devices and displays error in case
of mismatching. 22

Basic Computer Skills LOGICGATES/CIRCUITS We have discussed that all the computer operations are
performed by passing signals in Os and 1s. The computer has a block of built-in-devices through which these signals are
generated and passed. These hardware devices are basically electronic digital circuits and are known as Logic Gates or
Logic Circuits. There are two more names for these devices - Switching Circuits and Digital Circuits. To understand how
these devices work, let us discuss what is meant by binary logic and its application in making logic gates. Definition
ofBinaryLogicBinary logic deals with binary variables and logical operations. The binary variables are denoted by
x,y.z,A,B,C etc., which can have two and only two distinct values (e.g. 1 and 0, TRUE or FALSE, YES or NO, etc.). There are
three basic logical operations - AND, OR and NOT. In binary logic, if x and y are two binary variables, then x.y (read as x
AND vy) represents AND operation and x+y (read as x OR y) OR operation. The NOT operation is represented by x'. It
follows that for each combination of the values of x and y, there is a value for x4y, x.y and x' as specified by the definition
of logical operations. The definitions of AND, OR and NOT logical operations is demonstrated in tables, called truth
tables and are shown in Table 2.1. Table 2.1 Truth tables of logical operations. Binary Variables AND OR NOT x y x.y x+y x’
y000011010110100101111100 ltisclear from the truth tables that the value of - AND operation, x.y is 1
only if x=1 and y=1. OR operation, x+y is 1 only if either value of x or y is 1 or values of both x and y are 1. NOT operation,
x'islifx=0.ApplicationofBinarylLogic The use of binary variables and definition of logical operations can be
better understood by considering an example of simple switching circuits as shown in Figure 2.2. We consider two types
of switching circuits - switches in serial and switches in parallel.

23 Structure of Computer The switches in serial represent AND and the switches in parallel OR operation. P and Q are
two switches that represent two binary variables x and y respectively. When the switch is open, then the value of binary
variable is 0 and when the switch is closed, then the value is 1. There is a lamp (L) in each circuit that represents a third
variable, z with a value 1 if it is on and O when off. The lamp turns on only if both switches P and Q are closed in the
circuit with switches in serial. It follows that the value of z is 1 only if the values of both x and y are 1. In the case of circuit
with switches in parallel, the lamp turns on only when one or both of the switches are closed. It follows that the value of
zis lonly if either x oryis 1 or both x and y are 1. Logic gates that perform the logical operations AND, OR and NOT are
known as AND gate, OR gate and NOT gate (inverter circuit) respectively. The symbols for representing these logic gates
are shown in Figure 2.3. Figure 2.2 Demonstration of binary logic by Switching circuits Figure 2.3 Symbols of AND, OR
and NOT logic gates. BITSAN D
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BYTES BIT stands for Binary Digit. It is single digit in a binary number which can be either 0 or 1. Within the computer, a
single bit can be stored
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in many ways, generally by using transistor, multivibrator (flip-flops - circuits made of Logic Gates) or a capacitor as on/
off switch. If a bit is OFF then its value is considered 0 and if it is ON, its value is 1. BIT is the smallest unit of data in a
computer. A single bit alone does not provide much information, but a combination of 8 bits is enough to store all
alphabets, numbers and other characters used by the computer. Voltage Source Voltage Source Q P Q P L L Switches in
Serial Switches in Parallel z = x.y z = x + y x X' AND Gate OR Gate NOT Gatey x x y

24 Basic Computer Skills The group of 8 BITS is known as a BYTE. For example, when the user types A (1 byte) on the
keyboard, the system delivers a signal which sets the input location to the bit value 01000000.

3-Introduction to Information Technology-Block ...
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In memory, each byte occupies a unique address (storage location). Byte is considered as the smallest unit of memory.

There are higher units of memory such as Word, Kilobyte, Megabyte, Gigabyte and Terabyte which are illustrated in
tabular form in Table 2.2. Table 2.2 Different

3-Introduction to Information Technology-Block ...
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units of memory along with their equivalents. Unit of Memory Equivalent Units Byte 8 BITS Word 2 Bytes Doubleword 4
Bytes Quadword 8 Bytes Paragraph 16 Bytes

Kilibyte (K) 1024 Bytes Megabyte (MB) 1024 K Gigabyte 1024 MB Terabyte 1024 GBNUMBERSYSTEMFORD ATAR
EPRESENTAT IO N The number system that is commonly used for calculations is the Decimal Number System. It has
10 symbols or digits i.e. 0,1,2,3...9 which are known as Arabian numerals. It has a base or radix (humber of different digits
which can occur in each position) of 10. Although this number system provides a great advantage to man as compared
to earlier used binary numbers, it is not considered suitable for data representation in computers. The memory cells used
in computers are bistable in operation. They are capable of storing only one bit (either O or 1). Therefore, the Binary
Number System is used to store and represent numbers in computers. The binary number system has only two digits or
symbols (0 and 1) and base of 2. Each decimal number can be represented in its equivalent

3-Introduction to Information Technology-Block ...
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binary number. Two other number systems which are used in computers are Octal (base of 8) and Hexadecimal (base
of 16) Number Systems. These

number systems are useful in representing binary numbers in a compact form. The octal number has 8 digits i.e.
0,1,2,3...7 and the hexadecimal number has 10 digitsi.e. 0,1,2,3...9 and 6 alphabetsi.e. AB,C,D,E and F Some of the
examples of binary number along with their equivalent hexadecimals, octals and decimals are shown in Table 2.3.
25 Structure of Computer Table 2.3 Some examples of equivalent decimal, binary, hexadecimal and octal numbers.
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Decimal Binary Hexadecimal Octal 0 0000001 0001112001022 30011334010044501015560110667
0111778100081091001911101010 A 12111011 B 13121100 C14 131101 D 1514 1110 E 16 15 1111 F 17

Conversion of Numbers One number system of data representations can be converted into others by several methods.
We are discussing on the following pages the most easiest methods for converting a number from one system to
another. Figure 2.4 A method for converting a decimal number to binary. 2 54 Remainder227021312612302110
1 Hence, (54) 10 = (110110) 2
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26 Basic Computer Skills Converting Decimal Number to Binary Number For converting a decimal number to a binary
number, the decimal number (e.g. 54) is repeatedly divided by 2 as illustrated in Figure 2.4. The remainder obtained after
each division indicates the various digits of the converted binary number. These digits are written from the bottom up to
form the converted binary number. In the example illustrated above, the equivalent binary number of decimal number 54
is 110110. Converting Binary Number to Decimal Number For converting a binary number to decimal number, each of
the digits of a binary number (e.g. 110110) is multiplied with 2 to the power of its position number (starting with O for the
rightmost digit) as shown in Figure 2.5. Each of these calculated values are then added to derive the converted decimal
number. In the example illustrated above, the equivalent decimal number of binary number 110110 is 54, Figure 2.5 A
method for converting a binary number to decimal. Converting Decimal Real Numbers to Binary Real Numbers A
decimal real number (e.g. 54.625) consists of two parts - an integer and a fraction. The binary equivalent is determined
by the following steps: 1. Convert integer part (i.e. 54) to its binary equivalent as described above. 2. Convert fraction part
(i.e. 0.625) to binary as explained below- To convert decimal fraction to its binary equivalent, the fraction number is
repeatedly multiplied by 2 as illustrated in Figure 2.6. After multiplication by 2, the integral part is added to the right of the
binary fraction being formed. The multiplication process is repeated until the remainder of new fraction becomes zero. If
it does not become zero after several multiplications, then only 7 binary digits are added to form fraction part of binary
realnumber.1101100x20=01x21=21x22=40x23=01x24=161x25 = 3254 Hence, (110110) 2 = (54)
10

27 Structure of Computer Figure 2.6 A method for converting a decimal fraction to binary. 3.The integeral and fractional
parts are added to form converted binary real number. Converting Binary Real Numbers to Decimal Real Numbers A
binary real number (e.g. 110110.101) consists of two parts - an integer and a fraction. The binary equivalent is determined
by the following steps: 1. Convert integer part (i.e. 110110) to its decimal equivalent as described above. 2. Convert
fraction part (i.e. .101) to decimal as explained below- To convert binary fraction to its decimal equivalent, each of the
binary digit is multiplied by 2 to the power -1,-2,-3, etc...starting from the leftmost digit as illustrated in Figure 2.7. These
values are then added to obtain the equivalent decimal fraction. Figure 2.7 A method for converting a binary fraction to
decimal. 3. The integeral and fractional parts are added to form converted decimal real number. Converting Decimal
Number to Octal Number The method for converting a decimal number to an octal number is similar to conversion
method for decimal to binary as described above. The decimal number (e.g.153) is repeatedly divided by 8 as illustrated
in Figure 2.8. The remainder obtained after each division indicates the various digits of the converted octal number.
These digits are written from the bottom up to form the converted octal number. In the example illustrated above, the
equivalent binary number of decimal number 153 is 231. 0.625 x 2 1.250 1 0.250 x 2 0.500 0 0.500 x 2 1.000 1 Hence,
(625)10=(101)21x2-3=.1250x2-2=01x2-1=.500.625Hence, (.101) 2 =(625)10.101

28 Basic Computer Skills Figure 2.8 A method for converting a decimal number to octal. Converting Octal Number to
Decimal Number Again, the method for converting an octal number to a decimal number is similar to conversion
method for binary to decimal. For converting an octal number to decimal number, each of the digits of an octal number
(e.g. 110110) is multiplied with 8 to the power of its position number (starting with O for the rightmost digit) as shown in
Figure 2.9. Each of these calculated values are then added to derive the converted decimal number. In the example
illustrated above, the equivalent decimal number of octal number 231 is 153, Figure 2.9 A method for converting an octal
number to decimal. Converting Decimal Number to Hexadecimal Number The method for converting a decimal number
to hexadecimal is again similar to conversion method for decimal to binary as illustrated in Figure 2.10. It is important to
note that the symbols A to F are written for the remainders 10 to 15. Figure 2.10 A method for converting a decimal
number to hexadecimal. 8 153 Remainder 81918238 0 2 Hence, (153) 10 = (231)82311x80=13x81=242x82
= 128 153 Hence, (231) 8 = (153) 10 16 2742 Remainder 16 171 6 16 10 11 16 0 10 Hence, (2742) 10 = (AB6) 16

29 Structure of Computer Converting Hexadecimal Number to Decimal Number The method for converting a
hexadecimal number to decimal number is similar to conversion method for decimal binary to decimal as illustrated in
Figure 2.11. It is again important to note that the digits 10 to 15 are used for calculations in place of alphabets A to F.
Figure 2.11 A method for converting a hexadecimal number to decimal. Converting Octal Number to Binary Number The
method for converting an octal number to a binary number is very simple as illustrated in Figure 2.12. Conversion from
octal to binary is done by converting each octal digit to its three-digit binary equivalent (Refer Figure 2.4). Figure 2.12 A
method for converting a octal number to binary. Converting Binary Number to Octal Number Conversion from binary to
octal is done by a procedure reverse to the above as illustrated in Figure 2.13. First, the binary number is partitioned into
groups of three digits each and then the corressponding octal digit (Refer Figure 2.4) is assigned to each group. Figure
2.13 A method for converting a binary number to octal. 6 x16 0 =611 x 16 1 = 176 10 x 16 2 =2560 2742 Hence, (AB6) 16
= (2742) 10 AB 6 375101 111 011 Hence, (375) 8 = (011111101) 2 011 111 101 3 7 5 Hence, (011111101) 2 = (375) 8
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30 Basic Computer Skills Converting Hexadecimal Number to Binary Number The method for converting a hexadecimal
number to a binary number is similar to the method for converting octal to binary as illustrated in Figure 2.14. Conversion
from hexadecimal to binary is done by converting each hexadecimal digit. (Refer Figure 2.7) Figure 2.14 A method for
converting a hexadecimal number to binary. Converting Binary Number to Hexadecimal Number Conversion from binary
to hexadecimal is done by a procedure reverse to the above as illustrated in Figure 2.15. First, the binary number is
partitioned into groups of four digits each and then the corressponding hexadecimal symbol (Refer Figure 2.7) is assigned
to each group. Figure 2.15 A method for converting a binary number to hexadecimal. Coding Schemes Besides various
number systems for data representations, there are three coding schemes used to represent characters in computers,
which are - a. BCD Code b. EBCDIC Code c. ASCII Code Coding Schemes Besides various number systems for data
representations, there are three coding schemes used to represent characters in computers, which are — a. BCD Code:
The decimal numbers can also be represented directly in computers by using a representation, called

BCD (Binary Coded Decimal) Code. These codes are derived by converting each digit of a decimal number into its 6
bits binary

A B 6 0110 1011 1010 Hence, (AB6) 16 = (101010110110) 2 1010 1011 0110 A B 6 Hence, (101010110110) 2 = (AB6) 16

31 Structure of Computer equivalent. Using this code, only 64 (2 6 ) characters can be represented, which are not
sufficient to represent all characters used in computers. b. EBCDIC Code: Due to the problem in representing all the
characters by using BCD Code, this code was extended from a 6 bit Code to 8 bit Code, which is known as Extended
Binary Coded Decimal Interchange (EBCDIC) Code. Using this code, 256 (2 8 ) characters can be represented. c. ASCII
Code: Microcomputer manufacturers have now adapted a standard code for representation of characters to facilitate the
transfer of data between different computer components. This standard code is known as the ASCII (Amercican Standard
Code for Information Interchange) code. ASCll is a 7 bit code providing 128 possible character representations. An
extended version of ASCII is an 8 bit code, thus allowing 256 different character combinations. The equivalent ASCII/
EBCDIC codes of different alphabets and numbers are given in Table 2.4. Table 2.4 Equivalent ASCIl/ EBCDIC codes of
different alphabets and numbers. Character ASCIlI EBCDIC Charcater ASCII EBCDIC
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A 10100001 11000001 S 10110011 11100010 B 10100010 11000010 T 10110100 11100011 C 10100011 11000011 U
10110101 11100100 D 10100100 11000100 Vv 10110110 11100101 E 10100101 11000101 W 10110111 11100110 F
10100110 11000110 X 10111000 11100111 G 10100111 11000111 Y 10111001 11101000 H 10101000 11001000 Z
10111010 11101001 1 10101001 11001001 0 01010000 11110000 J 10101010 11010001 1 01010001 11110001 K
10101011 11010010 2 01010010 11110010 L 10101100 11010011 3 01010011 11110011 M 10101101 11010100 4
01010100 11110100 N 10101110 11010101 5 01010101 11110101 O 10111111 11010110 6 01010110 11110110 P 10110000
11010111 7 01010111 11110111 Q 10110001 11011000 8 01011000 11111000 R 10110010 11011001 9 01011001 11111001
32
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Computer components can be broadly divided into two categories - Hardware and Software. Hardware refers to any
physical component of a computer. For example, CPU, Monitor, Keyboard, Hard Disk, Floppy Disk etc. are physical
components and thus, are hardwares. Software refers to the programs which are required to operate the computer.
For example, DOS (Disk Operating System), BASIC, COBOL, dBASE, An Accounting Software etc. are all softwares. An
analogy of hardware can be the book which you are reading and then software would be the text written on this book.
Another analogy could be - ‘brain’ is a hardware but ‘'memory stored in brain’ is a software. Both hardware and
software are dependent on each other. CPU, Memory Unit, Hard Disk etc. are useless unless they are provided with
instructions and data for storage and processing. Similarly, BASIC or COBOL language has no

importance unless they are used alongwith various hardware components of the computer.
The detailed discussion on various kinds of hardware and software is given in subsequent chapters. SUM M ARY
A computer system has four main components — Input/ Output Unit, Central Processing Unit, Memory Unit
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and Logic Gates/ Circuits.
The
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input unit is used to enter data and instructions into a computer.

The output unit is used to display or print the information.

36% MATCHING BLOCK 43/291 SA Module 5.docx (D17190824)

Central Processing Unit, the main component of a computer consists of Arithmetic Logic Unit, Control Unit, Registers,
Buses and Clock. The arithmetic and logic unit is responsible for all arithmetic and logical operations. The control unit
controls the transfer of
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control unit controls the transfer of data and instructions among other units of

a computer.
Registers are the memory locations which store data, instructions and memory addresses. Bus is a connection between
two components

85% MATCHING BLOCK 45/291 W

to transfer data between them. Clock measures and allocates a fixed time for processing each and every micro-
operation. Memory

unit stores the data, instructions and information. It is of three types ROM, RAM and CMOS. ROM (Read Only Memory)
contains those essential programs, which are not erased when the system is switched off. RAM(Random Access Memory)
stores the

data and instructions during execution of programs and is erased when the computer is switched off.

Logic Gates or Circuits are electronic digital circuits through which data signals are generated and passed. Logic gates
that perform the logical operations AND, OR and NOT are known as AND gate, OR gate and NOT gate respectively. BIT
(Binary Digit) is a single digit in a binary number. The group of 8 bits is called a Byte. In computers, data is represented in
various number systems viz. binary, octal and hexadecimal number systems. Besides these representations, BCD (Binary
Coded Decimal),

ASCII (American Standard Code for Information Interchange) and EBCDIC (Extended Binary Coded Decimal

Intechange) are various coding schemes used to represent characters in computers. Hardware and software are two
broad categories of computer components. Hardware refers to the physical component while Software to the programs
required to operate computers.

33 Structure of Computer EXE R C | S E Fillin the Blanks: a.

l |
>
(]
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Input unitis used to enterdataand __________ into a computer.
b is the 'brain’ of a computer. c. The memory capacity of ROM varies from64 KBto __________ .d.

__________ deals with binary variables and logical operations. Unsolved

Questions 1. What is a computer system? Describe in brief the architecture of a computer system. 2. Which component
of a computer is generally called "brain’ of computer and Why? Describe the functions of the distinct parts of this
component. 3. What is ROM? How does it differ from RAM? 4. Name various types of ROM and describe their main
characteristics. 5. How does a Static
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ROM differs from a Dynamic ROM. Which RAM would you prefer in your computer and Why? 6. What are Logic Gates?
Draw the diagrams of 3 basic logic gates. 7. What is binary logic? Define AND, OR and NOT logical operations by making
truth tables. 8. Define the following memory units: a. BIT b. BYTE c. Kilobyte d. Megabyte e. Gigabyte f. Terabyte 9. Name
various number systems and coding schemes used for data representaions in computers. 10. Define the following terms:
a. Bus b. Register c. Hardware d. Software 11.

Write the full form of following abbreviations: a. VDU b. CMOS c. ASCII d.

PROM e. BCD f. EBCDIC g. EAPROM g. CPU 12.
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Convert the following decimal numbers to equivalent binary numbers: a. 64 b. 4096 c. 175.5695 d. 1231 13. Convert
the following binary numbers to equivalent decimal numbers: 34

Basic Computer Skills
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a. 11011 b. 101110 c. 0.001101 d. 1110101.11 14. Convert the following decimal numbers to equivalent octal numbers: a.
332 b. 0.125 c. 632 d. 4429.97 15. Convert the following octal numbers to equivalent decimal numbers: a. 623 b. 0.125
c. 44 d. 453 16. Convert the following decimal numbers to equivalent hexadecimal numbers: a. 375 b. 55 c. 66.3 d.
1343 17. Convert the following hexadecimal numbers to equivalent decimal numbers: a. 15 b. AB4 c. 2AC5 d. 9.1A 18.
Convert the following octal numbers to equivalent binary numbers: a. 33762 b. 2473 c. 623 d. 3146.52 19. Convert the
following binary numbers to equivalent octal numbers: a. 10110111 b. 1001111 c. 011.1011011 d. 11010111 19. Convert
the following hexadecimal numbers to equivalent binary numbers: a. 2AC5 b. CD c. AB2.1A d. 1B 20. Convert the
following binary numbers to equivalent hexadecimal numbers: a. 11101 b. 101101111010 c. 1101.11010 d. 110110100 35
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numbers: a. 332 b. 0.125 c. 632 d. 4429.97 15. Convert the following octal numbers to equivalent decimal numbers: a.
623 b. 0.125 c. 44 d. 453 16. Convert the following
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a.332 b. 0.125 c. 632 d. 4429.97 15. Convert the following octal numbers to equivalent decimal numbers: a. 623 b.
0.125 c. 44 d. 453 16. Convert the following decimal numbers to equivalent hexadecimal numbers: a. 375 b. 55 c. 66.3
d. 1343 17.
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numbers: a. 375 b. 55 c. 66.3 d. 1343 17. Convert the following hexadecimal numbers to equivalent decimal numbers:
a.15b.
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Convert the following octal numbers to equivalent binary numbers: a. 33762 b. 2473 c. 623 d. 3146.52 19. Convert the
following binary numbers to equivalent octal numbers: a. 10110111 b. 1001111 c. 011.1011011 d. 11010111 19. Convert
the following
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a. 33762 b. 2473 c. 623 d. 3146.52 19. Convert the following binary numbers to equivalent octal numbers: a. 10110111
b. 1001111 c. 011.1011011 d. 11010111 19. Convert the following hexadecimal numbers to
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d. 1B 20. Convert the following binary numbers to equivalent hexadecimal numbers: a. 11101 b. 101101111010 c.
1101.11010 d. 110110100 35

Structure of Computer CASESTU DY The Y2K Problem: The Biggest Computer Problem of 20th Century In the late
1960s and early 1970s, computer memory (RAM chips) and external storage devices (hard disks) were extremely
expensive. In those days, bigger storage capacity meant higher costs. At that time, computers were still a new concept
and had just begun to be used for large database applications. When huge databases (like the national census) were
stored on mainframes, programmers faced a major problem with storage space. For solving the problem of storage
space, they tried to reduce storage needs and costs by removing the data which they considered irrelevant. They
thought that the ‘century’ part of the dates was irrelevant and could be removed. They stored dates as MM/DD/YY (two
digits each for month, day and year) rather than MM/DD/ YYYY (two digits each for month and day, and four digits for
year). This method saved two bytes per field, but now causes this century’s biggest computer problem, which is
commonly known as The Year 2000’ or "Y2K' problem. To understand what is the Y2K problem, consider that your
personal data is stored on a computer. Just assume that you were born in 1980. In computer systems, your year of birth
will be stored as just 80. To calculate your age in 1999, which would be stored as just 99, you will subtract 80 from 99.
So, according to computer arithemetic, you are 19 years old which is the correct result. However, if you will calculate
your age in 2001, the computer will subtract 80 from 01, so you are -79 years old (yet to be born). If your program
consider a negative value as zero, then your age is 0. If the program considers negative value as absolute, then your age
is 79 (perhaps much more than your parents). Hence, according to computers in your insurance company, or the one in
your bank, or even the one handling your company’s payroll, you are either not born yet or probably older than your
parents. So, you will not be entitled to get any insurance premium, bank payments or interests and even your salary or
provident fund. So, you can realise the serious impacts of Y2K problem. In the year 2000 or onwards, Y2K problem will
be faced in all applications where some computation is done on any date field. The Y2K problem will be faced in almost
allindustries including railways, airlines, hotels, banks, hospitals, Govt. offices, public and private sectors. Many programs
will generate weird results, probably in the form of massive amounts of interest due or pending payments. The railway
and airline programs may be affected. A weekendonly train or airline may be scheduled for Monday (1-1-1900) instead of
Saturday (1-1-2000). You may not get computerised reservations in trains and airlines for days starting from 1st January,
2000. Your bank’s computers will be affected too. If you will open a fixed deposit account after 1st January, 1999 for the
period of one year, on 1-1-2000 the bank might try to give you a negative 99 years of interest causing a negative balance
in your account. The telephone department’'s computers may also be affected, so you might get a bill of lakhs of rupee
for the duration of 99 years. Safes and strong-rooms with computerized door locks too will need modifications to work
in 2000 AD. The Y2K problem goes well beyond a simple loss of money. Although the Y2K problem seems to be very
serious, it is not impossible to be solved. However, there cannot be a single solution for all applications and moreover
solutions are extremely expensive. As large corporate computer programs consist of millions of lines of code with
amazing amounts of data, a large amount of money has to be spent for re-coding or fixing data and code. Moreover, a
huge number of programmers are needed

36 Basic Computer Skills to be employed to rewrite or edit the parts of the program that have been affected. As each
custom designed program was developed with differing specifications by different teams, no single solution can actually
be applied. Therefore, there is no possibility for development of a single software which could convert the old programs
into new programs automatically. It is estimated that affected companies may have to spend upto $600 billion to fix the
Y2K problem. The solutions to the Y2K problem do exit, but the only problem is how to implement them without
effecting their current working. The simplest approach could be to add one extra ‘flag’ byte with all the date fields. If the
flag is "0’ the date is considered to be between the year 1900 to 1999 otherwise it is taken as a date on or after the year
2000. Although this logic seems to be quite simple but it needs to be implemented for millions of lines of coding, which
make it really difficult to implement. The other technique could be to assume all years lower than a certain value (such as
50) as of year 2000 and greater, as of year 1900. For example, if year is 21, consider it 2021 and if it is 56, take it as 1956.
This approach could be just temporary until the permanent solution is found. The permanent and the most preferred
solution to Y2K problem is to expand the storage of year from 2 to 4 bytes in all database applications. Although this
technique is the best solution for Y2K problem, it is the most expensive and time consuming approach. Questions 1.
What is the Y2K problem? What is the basic cause of this problem? Discuss. 2. Will the Y2K problem effect you and your
organisation? How is your organisation trying to tackle the problem? Discuss. 3. "In the year 2000, all computers will
stop working." Are you satisfied with this opinion? Discuss. 4. The year 2000 is quite near, but nobody has yet found a
single solution for the problem. The Y2K problem seems to be unsolvable in near future'. Discuss.

Hardware Concepts U N | T 3 In the last unit, we discussed that computer components are
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broadly classified into
hardware and software.
Hardware refers to any physical component
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of a computer. In today’s computer industry, a wide variety of hardware components are available for microcomputers.

In order to make good decisions about the purchase of computer systems and also to repair/ maintain them, we
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must be aware of the working and uses of different hardware components.

The hardware components of a microcomputer can be classified into the
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following types : a. Motherboard b. Input Devices c. Output Devices d. Storage Devices e. Cards f. Ports and Cords g.
Power Supply All these hardware devices except motherboard are called peripheral devices, as they are connected to
the motherboard.

In this chapter, we will discuss about the structure and function of these devices along with the basic hardware
concepts.
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LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?
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Motherboard ? Input Devices ? Output Devices ? Storage Devices ? Cards ? Ports and Cords ? Power Supply 38
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Motherboard, also called as System Board, is the most important hardware component of a microcomputer.
Motherboard is so called as all the other boards (printed circuit boards having chips or other electronic components) of
the computer are connected to this board, hence it is like

the

98% MATCHING BLOCK 61/291 W

mother of all other boards. Components of Motherboard A motherboard contains the CPU chip, Memory chip (ROM
and RAM chips), I/O interface, expansion slots and many other logic circuits

as shown in Figure 3.1.
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It may also contain a maths co-processor chip. CPU or processor chip is the main component of
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motherboard The types of CPU chip (8088/ 80286/ 80386/ 80486 etc.) vary from one model of PC to another. The
function of maths coprocessor chip (8088/ 80287 etc.) is to support the CPU chip in processing of mathematical
calculations.

Figure 3.1 A
motherboard.
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Memory chips are physically installed on the motherboard by different packing methods. There are three different
types of packing of RAM chips - DIP, SIMM and SIPP. DIP (Dual Inline Package) is the most common packing, having a
small rectangle box with leads on both sides. SIMM (Single Inline Memory Module) packing contains a number of chips
soldered on an expansion board having an edge connector. SIPP (Single Inline Pin Package) is similar to SIMM, but uses
pin rather than an edge connector. Expansion slots are connectors on motherboard where expansion cards like display
card, hard disk controller card etc. can be connected. I/O interface is the channel between the CPU and peripheral
devices (keyboard, monitor etc.).

INPUTDEVICES

Input Devices are

used to input data, information and instructions into the RAM.

We may classify these devices into the following two broad categories -

39

Hardware Concepts i. Basic Input Devices ii. Special Input Devices We are discussing below
the structure and function of the common input devices of these two categories

indetails. BasiclnputDevicesTheinput devices which have now-a-days

become essential to operate a PC, may be called as Basic Input Devices. These devices are always required for basic
input operations. These devices include Keyboard and Mouse.

Today, every PC has

a keyboard and mouse as the basic input devices

as shown in Figure 3.2. Figure 3.2 A student using basic input devices of a PC. Keyboard
Keyboard (similar to a typewriter)

is the main input device of

a

computer.

It contains 3 types of keys - alphanumeric keys, special keys and function keys.
Alphanumeric keys are used to type all alphabets, numbers and special

symbols like $,%,@," etc. Special keys such as &gt;Shift&lt;, &gt; Ctrl&lt;, &gt Altslt;, &gt;
Homeé&lt;, &gt;

Scroll Locké&lt;

etc are used for special functions. Function keys such as &gt;F1&lt;,&gt;F2&lt;,&gt;F3&lt; etc. used to give special
commands depending upon the software used.

We can understand the function of each and every key actually by working on a PC.

When any key is pressed, an electronic signal is produced.

This signal is detected by

a keyboard encoder that sends a binary code corresponding to the key pressed

to the CPU. There are many types of keyboards but 101 Keys Keyboard,

as shown in Figure 3.3, is the most popular one.

40 Basic Computer Skills Figure 3.3 A 101 keys keyboard. Mous e

Mouse (similar to a

mouse) is another important input device. It is a pointing device used to move cursor, draw sketches/ diagrams, selecting
a text/object/menu item etc. on monitor screen while working on windows (

graphics based operating environment of

a

computer).

Mouse is a small, palm size box containing 3 buttons and a ball underneath

as shown in Figure 34,
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which senses the movement of the mouse and sends the corresponding signals to CPU on pressing the buttons.

MATCHING BLOCK 66/291 SA SLM FOC.pdf (D46802927)

which senses the movement of the mouse and sends the corresponding signals to CPU on pressing the buttons.

Figure 34 A

mouse.SpeciallnputDevices

The input devices which are not essential to operate a PC, are called as Special Input Devices. These devices are used for
various special

purposes and are generally not required for basic input operations. These devices

include Trackball, Light Pen, Touch Screen, Joystick, Digitizer, Scanner, OMR, OCR, Bar Code Reader, MICR and Voice
Input Devices.

41 Hardware Concepts

Trackball A trackball looks like a mouse, as the roller is on the top with selection buttons on the side

as shown in Figure 3.5.

It is also a pointing device used to move the cursor and works like a mouse.

For moving the cursor in a particular direction, the user spins the ball in that direction. It is sometimes considered better
than mouse, because it requires little arm movement and less desktop space.

It is generally used with portable computers.

Figure 3.5 A trackball. Lig h t Pe n

Light pen (similar to a

pen) is a pointing device which is used to select a displayed menu item or draw pictures on the monitor screen

as shown in Figure 3.6.

It consists of a photocell and an optical system placed in a small tube. When its tip is moved over the monitor screen and
pen button is pressed, its photocell sensing element detects the screen location and sends the corresponding signal to
the CPU.

Figure 3.6

Demonstration of a light pen.

TouchScreen

Some special VDU devices have touch sensitive screens. These screens are sensitive to human fingers and act as tactile
input devices. Using touch screen,

the

user can point to a selection on the screen instead of pressing keys

as shown in Figure 3.7. Touch screen helps the user in getting the information quickly. It is mainly used in hotels or
airports to convey information to visitors. 200

Light Pen

42 Basic Computer Skills Figure 3.7 Demonstration of touch screen. Joy s ti

ck

Participant Guide Fundamentals of Computers.docx
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Joystick is also a pointing device which is used to move cursor position on a monitor screen. Joystick is a stick having a
spherical ball at its both lower and upper ends
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is a stick having a spherical ball at its both lower and upper ends
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is a stick having a spherical ball at its both lower and upper ends



as shown in Figure 3.8.
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The lower spherical ball moves in a socket. The joystick can be moved in all four directions. The function of joystick is
similar to that of a mouse. It is mainly used in Computer Aided Designing (CAD) and playing computer games.

The lower spherical ball moves in a socket. The joystick can be moved in all four directions. The function of joystick is
similar to that of a mouse. It is mainly used in Computer Aided Designing (CAD) and playing computer games.
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The lower spherical ball moves in a socket. The joystick can be moved in all four directions. The function of joystick is
similar to that of a mouse. It is mainly used in Computer Aided Designing (CAD) and playing computer games. Figure
38
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The lower spherical ball moves in a socket. The joystick can be moved in all four directions. The function of joystick is
similar to that of a mouse. It is mainly used in Computer Aided Designing (CAD) and playing computer games. Figure
3.8

AJoystick. Digitizer

Digitizer

is used to create drawings and pictures using a digitizer tablet by a process called digitizing. Digitizing is a process by
which graphic representations are converted into digital data. The

digitizer consists of 3 main parts - a flat surface called tablet, a small hand held mouse-like device called puck and a
special pen like device called stylus as shown in Figure 3.9. The puck is used to input existing drawings into the computer.
The stylus is used to trace existing drawings placed on the tablet. It is also used to draw new drawings on a piece of
paper placed on the

tablet. The user makes contact to the

tablet with stylus. As the stylus is connected to the tablet by a wire, the traced image is stored in RAM and displayed on
the monitor. 200

Touch Screen

43 Hardware Concepts Figure 3.9 A digitizer.Scanner

Scanner is widely used in Desktop Publishing (

DTP) applications. It

is used for digitizing images such as photographs, forms, documents etc. into computer memory.

There are many types of scanners as illustrated in Figure 3.10.

Some scanners can also read text by converting them to digital code.

The

scanners are very useful for converting the typed pages into word-processing files. Graphic scanners convert a printed
image into video image without converting

it to digital code.

Figure 3.10 Various types of scanners. OpticalMarkReader(OMR)

Participant Guide Fundamentals of Computers.docx
)
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Optical Mark Reader (OMR) is a special type of optical scanner used to recognise the type of mark made by pen or
pencil. It is used where one out of a few alternatives is to be selected and marked. It is especially used for checking the
answer sheets of examination having multiple choice questions.
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Optical Mark Reader (OMR) is a special type of optical scanner used to recognise the type of mark made by pen or
pencil. It is used where one out of a few alternatives is to be selected and marked. It is especially used for checking the
answer sheets of examination having multiple choice questions.

The answer sheet contains special marks such as squares or bubbles. The student fills in these squares with soft pencil or
ink to indicate the correct choice as illustrated in Figure 3.11. The OMR detects these marks and sends corressponding
signals to the processor. If a mark is present, the amount of reflected light is reduced and thus, OMR detects the
presence of mark for each and every answer. Optical Mark Readers are widely used for almost all competitve
examinations having objective type questions.

Stylus Puck Window Function buttons Tablet

44 Basic Computer Skills Figure 3.11 A

sample of answer sheet that is checked by Optical Mark Reader (OMR).

Bar Code Reader

Bar Code Reader is an optical scanner

used for reading bar-coded data (data in form of light and dark lines)

as illustrated in Figure 3.12.

The bar-coded data consists of a number of bars of varying thickness and spacing between them. The bar code reader
reads the bar coded data and converts

it

into electrical pulses, which are then processed by

the
computer.
Participant Guide Fundamentals of Computers.docx
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Bar-coded data is generally used in labelling goods, numbering the books
Trainer Guide Fundamentals of Computers.docx
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Bar-coded data is generally used in labelling goods, numbering the books

or encoding ID or A/c numbers.

Figure 3.12 A bar code

reader. Optical Character Reader (OCR)

Optical Character Reader (OCR) is an optical scanner, which is capable of detecting alphanumeric characters typed or
printed on paper using an OCR font.

The text, which is to be scanned is illuminated by a low-frequency light source. The dark areas on the text absorb the
light while light areas reflect it. The photocells of OCR device receive
ABCD123451462310916150290187372BarCode Reader Bar Code

45 Hardware Concepts

this reflected light and provide binary data corrssponding to dark and light areas.

OCR devices are used for large volume applications like reading of passenger tickets, computer printed bills of credit
card companies and reading of ZIP codes in postal services.

MATCHING BLOCK 89/291 SA |ITM_B1_Ul.docx (D142211551)
Magnetic Ink Character Recognition (MICR) Magnetic Ink Character Recognition (MICR) is

used to recognise the magnetically- charged characters, mainly found on bank cheques

as shown in Figure 3.13. The magnetically-charged characters are written by a special ink called magnetic ink. MICR
device reads the patterns of these characters and compares them with special patterns stored in memory. Using MICR
device, a large volume of cheques can be processed in a day. MICR is widely

used by the banking industry for
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the

processing of cheques.

Figure 3.13 A cheque showing magnetically-charged characters that can be read by an MICR device.
Voice-input Devices Voice-Input Devices are the latest

input devices that can recognise the human voice. They

seem to be

very useful but are not popular due to storage of limited vocabularies and variations in

the way of pronouncing words by different persons.

OUTPUTDEVICES

Output devices are hardware components which are used to display or print the processed information.
We are discussing below

the structure, working and uses of

the common output devices: Monitor Visual Display Unit (VDU), commonly called

as

monitor is the main output device of

a

computer. It consists of a Cathode Ray Tube (CRT), which displays characters as

an

output.

It forms images from

tiny dots, called pixels, that are arranged in a rectangular form.

The sharpness of the image (

screen resolution) depends upon the number of pixels.

46
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Types of Monitors There are

different kinds of monitors depending upon the number of pixels. Depending upon the resolution, monitors can be
classified as follows :

a. CGA (Colour Graphics Adapter) b. MDA (Monochrome Display Adapter)

100% MATCHING BLOCK 78/291 W

c. HGA (Hercules Graphics Adapter) d. EGA (Enhanced Graphics Adapter) e. VGA (Video Graphics Adapter) f. SVGA
(Super VGA)

The differences between these monitors are summarised in Table 3.1. Depending upon
the
colour

MATCHING BLOCK 79/291 w

of display, monitors can be classified as Monochrome (with single colour black/white display) and Colour (with all
colours display) Monitors.

The pictures of two different models of color monitors are shown in Figure 3.14. Figure 3.14 Two models of

color monitors Table 3.1 Comparison among different types of monitors. Type

of Monitor Display Type Text Resolution Graphics Resolution (Pixels) CGA Text & Graphics Fair quality 320 X 200 MDA
Text only Good quality - HGA Text & Mono Graphics Fair quality 320 X 200 EGA Text & Enhanced Good quality 640 X 350
Graphics VGA Text & Video Graphics Much better than all 640 X 480 the above SVGA Text & Video Graphics Best quality
1600 X 1280 15" Multimedia Color Monitor 20" Color Monitor

47 Hardware Concepts Figure 3.15 Classification of Printers.
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Printer Printer is the most important output device, which is used to print information on paper. Printers are essential
for getting output of any computer based application. Types of Printers There are many types of printers which are
classified on various criteria as illustrated in Figure 3.15. Printers can be broadly categorised into

the following two types :
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a. Impact Printers: The printers that print the characters by striking against the ribbon and onto the paper, are called
Impact Printers. These printers are of two types - i Character;

and ii Line printers. i.
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Character Printers: These printers print one character at a time. These printers are again of two types - Daisy Wheel
and Dot Matrix Printers. Daisy Wheel Printers: These printers print the characters by a mechanism that uses a plastic or
metal hub with spokes, called daisy wheel. The characters are embossed on the radiating spokes and printed by striking
these spokes against the ribbon and paper. Daisy Wheel printers give a good quality but they are more expensive than
Dot Matrix printers.
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Dot Matrix Printers: These printers print the characters by putting dots onto the paper. They do not give better printing
quality than daisy wheel printers, but are faster in speed. The printing speed of a dot matrix printer can be upto 360 cps
(characters per second). They are widely used with microcomputers in most of the offices.

Classification of Printers Impact Printers Non-impact Printers Character Printers Line Printers Daisy Wheel Printers Dot
Matrix Printers Drum Printers Chain Printers Laser Printers Inkjet Printers Thermal Printers
48 Basic Computer Skills
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ii. Line Printers: These printers print one line at a time. Their printing speed is much more than character printers. They
are again of two types - Drum Printers and Chain Printers. Drum Printers: These printers print the line by a rotating
drum having a ring of characters for each print position. The hammers strike each character of the drum
simultaneously, so that entire line is printed for one full rotation of the drum. These printers are also called as Barrel
Printers. The printouts obtained from these printers, have even character spacing but uneven line height. Chain
Printers: These printers print the line by a rotating chain having ring characters for each print position. Their printing
mechanism is similar to drum printers. The printouts obtained from these printers, have uneven character spacing but
even line height b. Non-impact Printers: The printers that print the characters without striking against the ribbon and
onto the paper, are called Non-Impact Printers. These printers print a complete page at a time, therefore, also called as
Page Printers. Page printers are of three types— i Laser Printers,

ii Ink Jet Printers, and iii Thermal Printers. i.
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Laser Printers: These printers look and work like photocopiers. They are based on laser technology, which is the latest
development in high speed & high quality printing. In these printers, a laser beam is used to write the image on a paper.
First, the image is formed by electrically charging thousands of dots on a paper by laser beam. Then, the paper is
sprayed with a toner having the opposite charge and is passed over a heated roller to make the image permanent.
Laser printers are very popular and have become an essential part of Desk Top Publishing (DTP). Although laser printers
are costlier than dot matrix, they are generally preferred in all offices due to their high quality of printing. There are
many models of laser printers depending upon the speed and number of dots printed. The latest model of laser printer
is 1200 DPI (Dots Per Inch), which can print 10 pages/minute. Some high speed laser printers give a speed of upto 100
pages/minute. ii. Ink Jet Printers: These printers print the charcters by spraying the paper with electrically charged ink.
These printers give better quality than character printers but not better than laser printers. They are cheaper than laser
printers, hence used widely in many offices. They also offer an option of using colour cartridges for multi-colour
printing. iii. Thermal Printers: These printers print the characters by melting a

wax-based
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ink off a ribbon onto a special heat sensitive paper. They give Letter-quality printing but are relatively expensive in
maintenance than other printers. 49

Hardware Concepts The pictures of some of the printers are shown in Figure 3.16. Figure 3.16 Various types of printers. P
lotter
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Plotter is an important output device, used to print high quality graphics and drawings. Although the graphics can be
printed on printers, the resolution of such printing is limited on printers. Plotters are generally used for printing/
drawing graphical images 50
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such as charts, drawings, maps etc. of engineering and scientific applications. Some important types of plotters are

shown in Figure 3.17 and
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are discussed below: i Flat Bed Plotters: These plotters print the graphical images by moving the pen on stationary flat
surface material. They produce very accurate drawings. ii Drum Plotters: These plotters print graphical images by
moving both the pen and the drum having paper. They do not produce as accurate drawings as printed by flat bed
plotters. iii Inkjet Plotters: These plotters use inkjets in place of pens. They are faster than

84% MATCHING BLOCK 96/291 SA |TM_Bl1_Ul.docx (D142211551)

Plotters: These plotters print graphical images by moving both the pen and the

flat bed plotters and can print multi-coloured large drawings.
Figure 3.17 Various types of plotters. ComputerOQutputMicrofilm
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Computer Output Microfilm (COM) is a technique to produce output on a microfilm media (microfilm reel or
microfiche card) as illustrated in Figure 3.18. A microfilm is a continuous film strip that can store several thousands
miniaturized document pages. A microfiche card is a 4 X 6 inch film sheet, which can store several hundred pages. The
process of producing microfilm or microfiche takes place on a special COM unit. The information recorded on the
microfilm is read with the help of a microfilm viewing system. It is generally easier to read a microfiche than microfilm.
Computer Output Microfilm is particularly useful for organisations which need to store and manipulate large amount of
data. It helps them in tremendous savings in paper and document handling costs.

Drum Plotter Pen Paper Controls Drum Paper Flatbed Flatbed Plotter

51 Hardware Concepts Figure 3.18 Computer Output Microfim. STORAGED EV I C E S In the last chapter, we
discussed about the primary memory of the

computer.

Primary memory (especially RAM) stores the data, instructions and information temporarily during processing by CPU.
When

the

computer is switched off, this memory gets erased. How does a computer store the data, information and software
permanently, so that they can be retrieved whenever required ? Certainly, there must be some storage devices in

the

computer.

Now,

we will discuss about different Storage Devices, sometimes also called as Secondary Memory

Devices. There are many storage devices used with microcomputers.

Some of the common storage devices are

explained below and

are shown in Figure 3.19. Figure 3.19 Common Storage Devices INVNO DATE AMT 100101/01/99100.00
100201/02/99124.50 Floppy Disk Drives (3.5" & 5.25") Hard Disk Drive CD ROM Drive

52 Basic Computer Skills

Winchester

Disk (Hard Disk) Winchester Disk is the most common storage device of present day microcomputers. It is popularly
called as

the

Hard Disk Drive (HDD) or sometimes

as

Fixed Disk Drive. It is fixed inside the computer and is not easily removable. It is used for storing the software and data
inside

the

computer. It is also known as ‘Winchester Disk’, probably because this drive was first made by IBM at Hursley Laboratory,
located near Winchester in England.

Winchester Disk consists of one or more disk platters, an access mechanism and read/ write heads which are sealed in a
case

as shown in Figure 3.20.

Hard disk size depends upon the disk platter's diameter. There are many different

platter sizes (suchas51/2,31/2,21/2inchetc). The 31/ 2 inch size platter is common with PCs and 2 1/ 2 inch
with laptop/ portable computers.

Read/

write head is used to write any information on the disk surface or to read it back.

Figure 3.20 Internal Structure of a

Winchester

Disk.

There are different types of hard disks depending upon their storage capacities. Storage capacities of hard disks range
from 10 MB to several GBs, but 1.2 GB to 4.1 GB are now-a-days a common part of Pentium computers.
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Floppy Disk Floppy Disk (FD) is another common storage device which is small, flexible and easily removable. It is made
of a plastic disk coated with magnetic material, which is sealed

Figure 3.21 Structure of a floppy disk Read/write head Movable Central shaft Label S.No. Protective Jacket Visible
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inside a square plastic jacket as shown in Figure 3.21.

Itis called as ‘Floppy’ because it is soft having flexible physical property. Data can be written on or read from this floppy
by a drive, called Floppy Disk Drive (FDD), which is fixed inside the computer.

There are many types of floppies depending upon their sizes and storage capacities

as summarised in Table 3.2.

The original floppy, developed by IBM, is an 8" floppy, but the most popular sizes available for present day PCsare 51/ 4
"and 31/ 2". The storage capacity of floppies vary from 360 KB to 1.44 MB. The floppies can store data on both sides (
Double-sided

Floppies) or on single side (Single-sided Floppies) depending upon the floppy drive. Double-sided floppy drives are most
frquently used in present day PCs. The latest floppy drive, that packs two high density floppy

drives (5.25 & 3.5 inch) into a single package, is known as Combo Drive.

Table 3.2

Comparison among different types of floppies. Type of Floppy Size Density Sectors Tracks Storage Capacity DSDD **
5.25 inch Double 9 40 360 K DSLD ** 3.5 inch Low 9 80 720 K DSHD ** Big 5.25 inch High 15 80 1.2 MB DSHD Small 3.5
inch High 18 80 1.44 MB **

DS stands for Double Sided, LD for Low Density and HD for High Density

Compact Disk Compact Disk (

CD) is the latest storage device, used to store data, information and software, which can be read only and not

be

changed or erased. It is an optical read only memory, made up of a resin

as shown in Figure 3.22.

Therefore, it is actually called as

Compact Disk Read Only Memory (CD-ROM). However,

the information is stored on CDs by using an expensive drive, called CD-

ROM drive.

Figure 3.22 A CD ROM Disk
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Now-a-days

compact disks are very popular storage devices for microcomputers because a large number of software including
multimedia, audio and graphics software

are available only on these disks. Compact

Disks can store a large volume of data (upto 680 MB),

which is almost

the same as a storage capacity of a 640

MB Hard Disk.

WORM (Write Once Read Many) is a type of compact disk which can be recorded only once and not erased. It can store
more data than

a CD-ROM, generally measured in gigabytes.

MagneticTape

Magnetic tape is the oldest storage device available for microcomputers. It is generally used to store a large volume of
data that is needed to be sequentially accessed and processed. The tape is made up of a plastic ribbon coated with an
iron-oxide material, which can be magnetised

as shown in Figure 3.23.

The data stored on tape can be read as well as erased and written again.

Figure 3.23 A magnetic tape.

Magnetic tape is a sequential access storage device, hence it is not possible to read the data randomly or directly.
Therefore, magnetic tapes are suitable only for storing data for backups and batch mode applications and not for on-line
applications.

On the other hand, magnetic disks (floppy and hard disks), which are discussed above, are considered best storage
devices for on-line applications. V

ideoDisk

Video disk is used to store text, video and audio data. It is widely used for training applications as

it can be played like a phonograph record.
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MagnetoOpticalDrive Magneto Optical (MO) drive, as shown in Figure 3.24,

is the latest of all storage devices. This drive uses both a laser and an electromagnet to record data on a removable
cartridge, The surface of the cartridge contains tiny embedded magnets. The unique feature of MO drive is that it has a
very high storage capacity. Although MO drive is costier and slower than HDD, it has a long life and is more reliable.

55

Hardware Concepts Figure 3.24 A Magneto Optical (MO) Disk.

DVD ROM/RAM Disk

DVD ROM and DVD RAM disks are optical disks having a storage capacity of 4.7 GB and 5.2 GB respectively. These disks
are becoming the next generation's new standard for higher capacity removable media. They are ideal for storage of hug
amount of information required for multimedia applications.

One can put 133 minutes of high quality of video with digital sound on a DVD RAM Disk.

The picture of DVD RAM disk is shown in Figure 3.25. Figure 3.25 ADVD RAM Disk CARD S

Cards are the printed circuit boards used to hold the chips (integerated circuits). There are many types of cards used in
a

PC, the important ones are Video Card, Sound Card, I/O Card, Controller Card and Memory Card. Video card (Display
Card) generates the text and graphic images for

the monitor while the

sound card generates the sound. Pentium computers, generally, use a PCI (Peripheral Component Interconnect) video
card to speed up graphics. I/O Card provides a place for connecting

the

mouse and printer. Cables of hard disk and floppy disk are connected to controller cards. Memory Card provides a place
for memory chips.

Some of the cards are shown in Figure 3.26.
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Besides the important hardware discussed above,

the computer has several components which are used as pathway for flow of data. The rear of a PC has many empty
holes or external sockets called ports or connectors. There are many types of ports in a PC, the most important
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ones are Serial Port, Parallel Port, Game Port and Video Port. Serial Port is used to connect a mouse, modem or
scanner. Parallel Port is generally used to connect a printer. Game Port is used to connect the joystick while Video Port
is a connector for

the
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monitor. Cords are the cables used to plug into the ports. There are different types of cables for connecting different
types of input, output and storage devices. The important cords used in a PC are keyboard cords, power cords,
monitor cords and printer cords.

POWERSUPPLY
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Power supply is considered as the ‘Heart’ of a PC.
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A computer requires a clean and steady power source for working properly. Power supply is that important hardware,
which provides the power source to a computer. It provides a voltage range of 4.95 to 5.25 volts for the highest
performance of the system. Power supplies vary in size and power (in watt).
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An Uninterrupted Power Supply (UPS) keeps the computer running for
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lm

few minutes even when the electricity supply goes off. UPS is not a part of computer and is purchased separately. It is
optional but mostly preferred to CVT (Constant Voltage Transformer).

The pictures of CVT and UPS are shown in Figure 3.27.
57 Hardware Concepts Figure 3.27 Constant Voltage Transformer (CVT) and Uninterrupted Power Supply (
UPS). SUM M AR Y Hardware refers to the physical component of a computer. The harware components are
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classified into 7 types — i. Motherboard, ii. Input Devices, iii. Output devices, iv. Storage Devices, v. Cards, vi. Ports and
Cords

and vii. Powersupply.

70% MATCHING BLOCK 100/291 W

Motherboard contains mainly the CPU chip, memory chip, |/O interface, expansion slots and logic circuits.

Keyboard and Mouse are the basic input devices of today's PC. Trackball,
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Light Pen, Touch Screen, Joystick, Digitizer, Scanner, Optical Mark Reader (OMR), Optical Character Reader (OCR), Bar
Code Reader, MICR and Voice Input Devices

are the other input devices that are used for various special purposes. Monitor and Printer are the main output devices of
a PC. There are many types of monitors primarily based either on the quality of output. Printers are also of many types

depending upon their printing quality and speed. Plotter, another output device, is used to print high quality graphics and
drawings. Computer Output Microfilm (COM) is also an output device which is used to produce output on a microfilm

media. Winchester Disk (hard disk), Floppy Disk, Compact disk (CD), Magnetic Disk, Video Disk and Magneto Optical (MO)
Disk are the main storage devices of a computer. Cards, Cords and Ports are the other important hardware components.
Powersupply is considered as the "Heart of a PC, because it provides the power source to a computer. EXE R C | S E Fill

in the Blanks: a. All on hardware devices except motherboard arecalled __________. b. Motherboard is
called Board also. c.

Input devices are used to input data, information and instructions intothe ___________.

UPS CVT

58 Basic Computer Skills d. The digitizer consistsof ____________ main parts. e. Scanner is widely used in

_____________ applications. f. COM is a technique to produce output on a media. Unsolved
Questions 1. Define the term hardware. Discuss in brief the classification of hardware components of a microcomputer.
2. What is a Motherboard? Write the names of various components of motherboard. 3.

Name the basic input devices of a PC and explain their functions in brief. 4. What is a trackball ? How does it differs from
mouse and joystick. 5. Name the input device used - a. to create drawings and pictures b. for digitizing photographs and
documents 6. Classify the following devices into an Input (I), Output (O) or Storage (S) Device and write their main
functions: a. Touch Screen b. Video Disk c. Light Pen

d. Plotter e. WORM f. COM g. CD h. MICR 7. How does an OMR differs from an OCR? Which of these devices
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is used for checking the answer sheets of examinations having multiple choice questions? 8.
Explain the differences between CGA, EGA and SVGA monitors. Which of these monitors has the best quality display? 9.
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What is the difference between Impact and Non-impact Printers?

Classify the following category of printers as impact (I) or non-impact (N) printer and write their functions: a. Laser
Printers b. Thermal Printers c. Drum Printers d. Ink Jet Printers e. Chain Printers f. Daisy Wheel Printers g. Dot Matrix
Printers 10. Explain the difference between Character, Line and Page Printers. Give examples. 11.

Name

the main storage devices of a computer. Which device -

a.

has the highest storage capacity and is most commonly used b. has the lowest storage capacity but still is used most
frequently c. is

the oldest of all storage devices d.

used to store data which cannot be erased or altered

59 Hardware Concepts 12. What is the

difference between cards and cords? Explain with examples. 13. What is the difference beween a serial and a parallel
port? 14. Why is powersupply called as a Heart' of a computer? 15.

Write the full form of following abbreviations: a. MDA b. HGA c. DIP d. SIMM e. SIPP f.

HDD g. MO h. WORM i. CVT j. UPS
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60 Basic Computer Skills CASE ST U DY Making of India’s own Supercomputer: Param In 1988, C-DAC (Centre for
Development of Advanced Computing) set up a 10-year mission, divided into three parts to build India’s own
supercomputer, Param. In the first mission, the first Indian supercomputer - the transputer-based Param 8000 was
developed. Param 8000 was designed to deliver one gigaflop computing capability. It was designed board-up which
means that right from the start, it was based on parallel processing technology. In order to take advantage of the
hardware capabilities of Param 8000, many teams worked for the development of system software that can be used on
the supercomputer. After Param 8000, the new series of supercomputer, Param 9000 were developed. Param 8000 and
Param 9000 series were so successful that 30 machines were sold and some of them are still working in Russia, Canada
and Germany. On completion of Mission-l, its achievements were reviewed. There were three significant achievements
of Mission-I. First, as the export restrictions for supercomputer were eased, anybody from the Third world country could
purchase supercomputers. Second, the price tag on the monster number crunches came down significantly, to level
near where the Param was tagged. Third, Param demonstrated to the Indian IT industry that we can develop the
technologies for running mission critical applications. The major drawback of Param 8000 and 9000 series was that the
making of these machines was very time-consuming (i.e. 2 to 3 years) due to their board-up design. In Mission-Il, the
entire project strategy changed. According to the new strategy, the supercomuter was built by making a network of
smaller computers that have been set up for parallel processing. Instead of using board- up design, a scalable high
performance computer was built from the available standard hardware components. In Mission-ll, it was also decided to
use network systems instead of transputers. Mission-Il developed the latest of the Param supercomputers, the Param
OpenfFrame which is built from dual- processor Sun UltraSPARC workstations. The Param OpenFrame has many
components including 3Com FMS Linkbuilder 100BaseT Hub and the APC Smart-UPS 2000. The UtraSPARC
workstations are linked with three different networks viz. Paramnet, Myrinet and 100BaseT Ethernet network. One of the
advantages of using three networks is that if one goes down, the other two are available. The other advantage is that
applications running on the supercomputer can choose one of the three networks depending upon their bandwidth and
latency requirements. The Param Openframe supercomputer also has its own power protection, air conditioning and
system parameters monitoring systems. Presently, out of two in operation, one of these supercomputers is installed at C-
DAC which has eight UltraSPARK workstations. and the other one having four workstations is installed at NIC (National
Informatics centre). These machines can deliver peak performace of 10 gigaflops. Mission-lll, which has to be finished in
1998, is still under progress. The objective of Mission-lll is the development of a new series of Param supercomputers
with a peak performance of 100 gigaflops. Param 10000 is the latest series of Param supercomputer. It has been
designed using the latest 160 UltraSPARK Il processor alongwith C-DAC's own design communication processors and
networks. It will perhaps be the largest supercomputer of Asia barring Japan. (Adapted From: PC Quest, Apr.,1997 )
Questions 1. Describe the achievements of Mission-| for development of India’'s own supercomputer. 2. Discuss the
major features of the Param OpenFrame supercomputer. 3. How does the Param Openframe differ from Param 8000
supercomputer? Discuss.

Software Concepts U N I T 4 In the last unit, we discussed the basic hardware concepts. A computer is a

hardware and it is useless unless it is provided with the necessary software. Therefore, all computer users must be aware
of the basic software concepts besides hardware.

A

software is a program or set of instructions, which is required to use
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the computer. Many types of software are available for various applications. The software development field is so
advanced that day by day existing software are becoming outdated and new software are coming in the market. So, we
must get aware of the latest developments in the software industry.
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In this unit, we are discussing all the important software concepts and providing you the latest knowledge of all the
software available in the market.

Though we

are also providing you the current information about the latest version of
a

software, we are sure that it will be out-dated soon.
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LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Classification of Software ? Operating Systems ? Concept of Programming ? Types of Computer Language ? Language
Translators ? Software Tools ? System Software Utilities ? Windows—A Graphical User Interface (GUI) ? General Purpose
Application Software ? Special Purpose Application Software ? Latest Trends in Information Technology ? Emerging
Information Technologies ? Limitations of Computers

62 Basic Computer Skils CLASSIFICATIONOFSOFTWARE
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Software are broadly classified into following two types : a. System Software b. Application Software System Software
Software that are required to control the working of hardware and aid in effective execution of a general user’s
applications are called System Software. These software perform a variety of functions like file editing, storage
management, resource accounting, /O management, database management, etc. Some of the examples of system
software are DOS (Disk Operating System), Windows, BASIC, COBOL and PC TOOLS. These software are developed by
System Programmers. Types of System Software System software can be further categorised into following three types:
i. System Management Software (Operating Systems, DBMSs, Operating Environments) ii. System Development
Software (Language Translators, Application Generators, CASE Tools) iii. System Software Utilities

A
pplicationSoftware

MATCHING BLOCK 108/291 w

Software that are required for general and special purpose applications like database management, word processing,
accounting etc. are called Application Software. Some of the examples of application software are dBASE, Word Star,
Tally etc. Application software are developed using system software by Application Programmers.

Application software can be further classified into following two types: i.
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General Purpose Application Software (Database Management Packages, Word Processors, Spreadsheets etc.) ii.
Special Purpose Application Software (

Accounting, Inventory, Production Management etc) OPERATINGSYSTEMS

An Operating System is the most essential system software that manages the operation of a computer. Without an
operating system, it is not possible to use the computer. The
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computer is useless unless it is provided an essential software that makes it ready to use. An operating system is
software

which makes the computer ready to use by a process called booting. Before discussing the types of operating systems,
let us first see what exactly is meant by booting?

When we switch on the computer, the instructions stored in ROM are automatically executed. These instructions help
the computer to load the operating system from external storage device (disk) to internal storage (RAM). This process of
loading of operating system from disk to RAM is called

booting.

The term 'booting’ comes from the word - ‘bootstrap’ as bootstrap help us to get our boots on, similarly booting helps
the computer to get ready.

The process of booting is illustrated in Figure 4.1. Figure 4.1 Process of Booting. Type s o f Operating System s
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Many

types of operating systems are available for computers which can be divided into the

following two types - a. Single-user operating systems b. Multi-user operating systems. a .

Single-user Operating Systems: These operating systems are used for mainly computers having only one terminal
(stand-alone PCs). MS DOS (Microsoft Disk Operating System) and PC DOS (Personal Computer Disk Operating System)
RAM DISK Loading of Operating System (

BOOTING) Switch on the Computer Automatic Execution of Instructions Stored in ROM
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are the two important single-user operating systems. Both systems are almost identical and are simply called DOS.
OS/2 and Windows NT are other popular single-user multi-tasking operating systems for microcomputers. i.

MS DOS - MS DOS, developed by ‘Microsoft Inc.” in 1981, is the most widely used operating system of IBM-compatible
microcomputers. The latest version (

identification number of a release of software)

of MS DOS is 7. ii. PC DOS - PC DOS is essentially the same operating system as MS DOS, but developed and supplied by
IBM for its

personal computers.

iii.

0OS/2 - OS/2 is a single-user, multi-tasking operating system, developed jointly by IBM and Microsoft. This provides a
unique feature of multitasking, where several programs can be run simultaneously.

OS/2 was the first operating system

that provided users with a Graphical User Interface (GUI). iv. Windows NT - Windows NT (New Technology) is the single
user 32-bit multi-tasking operating system for 386

S

and above, developed by Microsoft Inc.Windows NT was driven by a need to exploit the tremendous power of 32-bit
microprocessors and runs applications, which are developed for DOS and Windows.

b. Multi-

user Operating Systems: These operating systems are used for those computers (micro to mainframe) which have many
terminals (multi-user systems). The popular operating systems used for multi-user systems are UNIX, NETWARE, MVS,
0OS/400,

VMS

and

Linux. i. UNIX - UNIX

was initially developed by AT&T at Bell Laboratories in 1969.

UNIX is a highly successful operating system for muti-user systems. Actually, it is more popular among scientific and
engineering users rather than business users. In 1980, Microsoft developed its own version of UNIX for 286

s and higher PCs which is called

as

XENIX. UNIX System V Release 4 is the latest version of UNIX.

ii. NetWare - NetWare is a group of network operating system developed by Novell, Inc., that provides multi-user
capabilities.

iii.

MVS (Multiple Virtual Storage) - MVS is one of the most complex multi- user operating systems ever developed for IBM
mainframes. In MVS, each job (time-sharing user or batch program) is assigned its own virtual storage space. iv. 0S/400 -
OS/400 is the IBM's operating system for its AS/400 computer. v. VMS (Virtual Memory Storage) - VMS operating system
is used on DEC's VAX series of minicomputers. vi. Linux - Linux is a 32-bit UNIX-like operating system that has been
developed recently for microcomputers. It is the world's first free operating system developed and maintained by
thousands of people

world-wide.
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The applications of different single and multi-user operating systems

are summarised in Table 4.1. Table 4.1 Applications of some common operating systems. Operating Type Applications
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System MS DOS Single-user Mostly used for running/developing stand-alone applications/ programs on
microcomputers. PC DOS Single-user Mostly used for running/ developing stand-alone applications/ programs on
microcomputers. OS/2 Single-user Used for GUI applications and running several applications simulateously on
microcomputer. Windows NT Single-user Used for GUI applications and running several applications simulateously on
microcomputer. UNIX Multi-user Most widely used for multi-user applications on all computers. Net work Multi-user
Most widely used for LAN (Local Area Network) applications on microcomputer. MVS Multi-user Used widely for large
applications needing virtual storage space.

OS/400 Multi-user Used for large multi-

user applications on AS/400 computer. VMS Multi-user Used for large multi-user applications on VAX computer.
Operating System Techniques There are several techniques used in Multi-user operating systems for enabling many users
to concurrently share the single or multiple CPU (e.g. Multiprogramming and Multiprocessing). Some techniques are
used in single-user operating system to handle multiple tasks (Multitasking). We will now discuss these common
techniques used in different operating systems. i. Multiprogramming is a process by which single CPU works on two or
more programs simultaneously. Using this technique, the operating system keeps the CPU busy. Multiprogramming
allows the processor to handle either multiple batch jobs at a time (Batch Multiprogramming) or multiple interactive jobs
shared among multiple users (

Time Sharing Multiprogramming). Time-sharing

is a technique that allows a CPU to simultaneously support the activities of several users by allocating fixed time slots (in
milliseconds). Examples of operating systems that support multiprogramming are OS/2, UNIX and Macintosh

System 7. ii.

Multiprocessing refers to the use of two or more CPUs to perform a coordinated task simultaneously. For example, MVS,
VMS and Windows NT support multiprocessing.
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Multitasking refers to the ability of an operating system to execute two or more tasks concurrently. In multitasking
environment, the user opens new applications without closing the previous ones and the information can be easily
moved among a number of applications. For example,

Windows NT and OS/2 operating systems use this technique.

FunctionsofOperatingSystems

MATCHING BLOCK 110/291 SA Computer Application.pdf (D166063658)

An operating system performs, basically three types of functions: i. Essential Functions:

MATCHING BLOCK 111/291 SA Computer Application.pdf (D166063658)

Storage management and processor management are two essential functions of an operating system. Storage
management is concerned with allocation and reclamation of storage when a program is initiated and terminated.
Process management is concerned with scheduling of programs in a time-sharing system. ii. Monitoring Functions:
These functions are concerned with collection of resource utilisation and system performance information.

iii.
MATCHING BLOCK 112/291 SA Computer Application.pdf (D166063658)

Service Functions: These functions of operating system enhance facilities provided to users.

CONCEPTOFPROGRAMMIN G We have discussed that computer has

no intelligence of its own and each and every instruction should be given to it for performing any task. The set of
instructions given to computer to process the data or perform certain task is called a Program. Programming is the
technique for writing the programs. Programming is

required at all levels from manufacturing of the computer to its operation by the user. Programming, which is done at
systems level for developing

systems

software, is known as Systems Programming (Systems Development). Systems Programs are written in low level
languages (
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we will discuss about types of language later)

like Machine/Assembly Language and some high level languages like C,C++ etc. Programming, which is done at the user
level, for development of application software, is known as Applications Programming (Applications Development) or
simply Programming. Application Software are generally developed using high level languages, DBMSs or Front End
Tools (

We will also discuss about these later).

There are two approaches used in programming - a traditional approach, Procedure Oriented Programming and a latest
approach, Object Oriented

Programming.

You must be aware of the advantages and disadvantages of both approaches of programming.
ProcedureOrientedProgramming

Procedure oriented programming is the traditional way of programming, where an application problem is viewed as a
sequence of steps (algorithms). As per the algorithm, the problem is broken down into many modules (functions) such as
data entry, reporting,

67

Software Concepts querring

modules etc. as illustrated in Figure 4.2. There are two types of data, which are associated with these modules - one is
global and another is local data. Global data items are defined in main program, whereas local data is defined within
associated functions. Many of the functions share global data, as this kind of data is available to all functions. Procedure
oriented programming is the conventional approach of programming for developing application software. High level
languages like COBOL, Pascal, BASIC, Fortran, C etc. are based on procedure oriented approach, and hence are also
called procedural languages. Figure 4.2 Generalised structure of a procedure oriented program. Advantages of
Procedure Oriented Programming The main advantages of procedure oriented programming are—

i It

is easy to port programs as compilers for procedural languages are easily avaliable. ii. It is easier to learn procedure
oriented programming than new ways of programming. Disadvantages of Procedural Oriented Programming Although
procedural oriented programming is the conventional approach of programming, it has certain drawbacks. The main
disadvantages of this approach are - i. As most of the functions share global data, this data is freely available to all
functions. Although this freely available data is easily accessed by any function, it can create certain problems. When a
new function is written for analysing this data in different way it is possible that data may be changed accidentally or
deliberately. Therefore, there is no security of data in procedure oriented programes. ii. Another problem is that whenever
data structure is required to be changed, all the functions using that data must also be changed. So, procedure oriented
programs (especially for complex applications) are extremely difficult to modify and maintain.

iii.

Procedure oriented programming does not model the real world problem. (

We will discuss this concept in the next sub-section) Procedure Oriented Program FUNCTION 1 FUNCTION 2
FUNCTION 3
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Object Oriented Programming Object oriented programming is the latest approach of programming. It attempts to
eliminate most of the drawbacks of procedure oriented programming by incorporating new concepts. It is a new way of
organising programs, which is not dependent upon any particular language. In object oriented programming, a problem
is viewed not as a sequence of steps to be done, but as a collection of different units (called objects) that models the real
world things. The structure of an object oriented program is shown in Figure 4.3.

Figure 4.3 Generalised structure

of an Object Oriented program. The ‘Object oriented’ concept can be better understood by discussing about the
definitions of an object and its related terms. So, let us discuss the basic terminology used in

Object

Oriented Programming (OOP). Basic Terminology used in OOP Object — The fundamental idea behind OOP is to store
the data and functions operating on that data into a single unit, called an object. An object may represent a person, a
student, an employee, an account, an examination or any item that closely resembles the objects of real world. Class — A
class is a collection of similar objects. For example, if ‘Car’, ‘Bus’ etc. are different objects than "Vehicle' is a class.
Encapsulation — The wrapping of data and functions in an object or class is known as encapsulation. Data Hiding — Data
hiding is the important feature of objects, by which data is not accessible other functions outside the objects. Data
Abstraction — The act of representing essential features of the objects without giving details is known as data abstraction.
Classes use this concept and represent essential properties of the objects.

Obejct Orinted Program OBJECT 1 OBJECT 2 OBJECT 3 DATA FUNCTION OBJECT
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Inheritance — An object of one class (base class) can inherit the properties of another class (derived class) by a process,
called inheritance. For example 'Petrol Vehicle', is one class that inherits the properties of another class "Vehicle'.
Polymorphism — The ability of objects to exhibit different behaviours in different instances is known as polymorphism.
For example, an additional function of an object generates a sum if the data is in numeric form or it concatenates the
strings if the data is in character form. Advantages of Object Oriented Programming Object oriented programming offers
several benefits over the procedure oriented approach. The main advantages of using object oriented approach in
software development are described as follows: i. Reusability of the code is the major benefit of object oriented
programming. Redundant code can be eliminated through inheritance feature of OOP. The generation of windows,
menus, dialog boxes etc. are few examples of programming codes that can be reused. So, a lot of time of programmers
is saved during development of an application software. ii. In object oriented programming, as the emphasis is on data
rather than algorithms, a program can easily be broken down into objects, which model truly the real world objects. iii.
The programs and data are more secure due to data hiding feature of OOP. iv. New data types can be easily created
through data abstraction feature of OOP.

Applications

of OOP Object oriented programming is very useful in application areas like real-time, artificial intelligence, expert
systems, computer aided manufacturing/designing, office automation and decision support systems. Disadvantages of
Object Oriented Programming Although the object oriented approach is the latest and most widely accepted
programming approach, it has certain drawbacks as described below: i. Although object oriented software are easier to
upgrade and maintain, first time development process is more difficult than procedure oriented software. This drawback
can be solved by using latest programming tools.

ii. All

languages cannot easily implement object oriented approach. So, object oriented programming is limited to few
languages (object oriented languages).
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Systems Analyst Software development project is not managed by a single person, but it is a teamwork. Software project
is managed by a person called, project leader. The project leader is generally a system analyst, who analyses and designs
the complete software. Programs are developed by software professionals, called Programmers. System Programmers
develop

systems

software while application programmers are involved in development of application software. Systems analyst and
programmers play a vital role in development of an application or a systems software.

The

analyst plays the role of a specialist in computer-based applications. Programmers are responsible for coding, editing,
testing and debugging the programs. Systems analyst and programmers work together as a team.
TYPESOFCOMPUTERLANGUAGES

One man communicates with another in a language which another man can understand. Similarly, man communicates
with computer in a language which machine can understand. This language which consists of a set of commands,
understandable by computer directly or after translating, is known as Computer Programming Language. There are many
types of

computer

languages, which can be categorised into following four types — a. Low-level Languages (First & Second Generation
Languages) b. High-level Languages (Third Generation Languages) c. User-Friendly Languages (

Fourth Generation Languages) d. Object Oriented Languages (Fifth Generation Languages)
Low-levellLanguages

In early days of computers, only those languages were used for programming, which could be directly executed on
computer. Languages, which computer can understand directly and are machine dependent, are called Low-level
Languages. For example, Machine Language and Assembly Language are two important low-level languages. Machine
language is the oldest and most difficult of all the languages. It is also known as First Generation Language. In machine
language, all the instructions are given to computer in binary digits, and hence are directly understood by the computer.
On the other hand, Assembly Language is easier than machine language, and is known as Second Generation Language.
In Assembly Language, instructions are given using mnemonic operation codes (such as ADD, MUL etc.) instead of binary
digits. Low- level languages are

mainly used for development of systems software.

High-levellLanguages

Development of applications using low level languages requires a deep understanding of the hardware. In order to
facilitate the programmers to write programs without knowing



Ouriginal

by Turnitin

71

Software Concepts

the internal details of computer components, many languages were developed. These languages use common English
words and are translated into low-level languages before processing by the computer. These languages, which
computer cannot understand directly and are not machine dependent, are called High-level Languages (HLL). These
languages are also known as Third Generation Languages.

Some of the common high- level languages are - i. BASIC (Beginners All Purpose Symbolic Instruction Code) ii. COBOL
(Common Business Oriented Language) iii. FORTRAN (Formula Translator) iv. PASCAL (Name of a Scientist) v. C (it does
not stand for anything) These

languages were widely used for applications development, but most of them are now outdated due to popularisation of
4GLs. The uses of different 3GLs are summarised in Table 4.2.

Table 4.2 Uses of 3

GLs (Third Generation Languages). Language Uses

BASIC (Beginner's All Purpose Used for all purposes (Commercial, Scientific, Educational, Graphics Symbolic etc.) by
beginners. Instruction Code) COBOL (Common Business Mainly used for development of commercial applications
Oriented Language)

on all types

of

computers. FORTRAN (Formula Translator) Used for development of scientific (mathematical) applications. PASCAL
(Name of a Scientist) Used for both commercial and scientific applications. C (No full form) Very powerful language for
development of both system and application software.

User-friendly Languages Although high-level languages are simpler to codify than low-level languages, they still require a
lot of time to learn programming syntax. Hence,

these languages are beyond the reach of many computer users, who do not want expertise in programming. Therefore,
a new category of languages have been developed which are user-friendly, very easy to codify and simplest to learn.
These languages are called User-friendly Languages and popularly known as 4GLs (Fourth Generation Languages).
Some of the common 4GLs are dBASE, Foxbase, Foxpro, MS Access, Oracle, Sybase and Ingres. The uses of different
4GLs are summarised in Table 4.3.
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Table 4.3 Uses of 4GLs (Fourth Generation Languages). Language Uses dBASE Used for development of mainly single
user DOS based database appliactions. Foxbase Used for development of both single and multiuser DOS based
database applications. Foxpro Used for development of both DOS and Windows based database applications. Oracle
Used for development of relational database applications on any operating environment. Sybase Mainly used for
development of on-line applications such as Decision Support Systems and Transaction Processing. Ingres Used for
development of relational database applications of VAX/UNIX operating system. Object Oriented Languages

We have discussed that the object oriented programming is the latest approach in programming. The languages which
are based on object oriented programming (OOP) approach, are called as Object Oriented Languages. They may be
classified into Fifth Generation Languages. Object oriented languages are specially useful for development of GUI
(Graphical User Interface) applications. These languages also offer a unique feature of

Reusable Code. Some of the popular object oriented languages are Smalltalk, C++

and

Object COBOL, Object Pascal, Simula, Eiffel, Java & Visual J++. C++ and Visual J++ are widely used

now-a-days for

development of

window-based

applications. The uses of different object oriented languages are summarised in Table 4.4.



Ouriginal

by Turnitin

MATCHING BLOCK 114/291 w

Table 4.4 Uses of Object Oriented languages (Fifth Generation Languages). Language Uses Smalltalk Used for
development of mainly graphical applications. C++ Used for development of all types of object oriented applications
Object COBOL Used for development of object oriented applications on mainframe computer. Object PASCAL Used
for general object oriented applications. Simula Mainly used in a research environment. Eiffel Used for general

of
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object oriented applications. Visual J++ Very popular for development of Windows based applications. 73 Software
Concepts There are certain languages which support most of the features of object oriented programming except
inheritance. These languages are not pure object oriented languages and are known as Object Based Languages. For
example, Ada, an high level language designed for process control, is an object based language.

LANGUAGETRANSLATORS

MATCHING BLOCK 117/291 W

Regardless of the programming language used (except machine language), the symbolic instructions have to be
translated into a form, that can be executed by computer. The software, which converts the codes of other languages
into machine code, are collectively called Language Translators. Language Translators are categorised into three types
- a. Assemblers

b. Interpreters c.
CompilersAssemblers

100% MATCHING BLOCK 118/291 W

Assemblers translate the assembly language code (source program) into machine language code (object program).
After assembling, a linker program is used to convert the object program into an executable program. The Microsoft
assembler program (MASM) and Borland Turbo assembler program (TASM) are two popular assemblers. Assemblers are
used mainly in development of system software.

Interpreters

MATCHING BLOCK 119/291 W

Instructions of a high-level language are coded in many statements. At the time of their execution, they are converted
statement by statement

MATCHING BLOCK 120/291 W

into machine code, by using system software, called Interpreters. For example, programs written in BASIC language are
executed by using BASICA or GWBASIC interpreters. Programs written in some fourth generation languages, like dBASE
Il plus are also executed using dBASE interpreter. There are certain disadvantages of interpreters. As instructions are
translated and executed simulateously using interpreters, they are very slow for executing large programs. Hence,
interpreters are not suitable for most of applications development.

Compilers
As
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contrast to interpreters, compilers provide faster execution speed. Compilers do not translate and execute the
instructions at the same time. They translate the entire program (source code) into machine code (object code). Using
linker, the object code is converted into executable code. Compilers are widely used in translating codes of high level
languages (e.g. COBOL, FORTRAN, PASCAL, Turbo/ Quick BASIC, 74
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Turbo/ Microsoft C etc.) and fourth generation languages (dBASE |V, Foxpro etc.). As compared to interpreters or
assemblers,

compilers are preferred in development of application software.

SOFTWARETOOLS

To develop a large application, lots of effort, money and time are required for designing the systems and writting the
program code. The overall goal of computerising an application is to make it more efficient than manual system with
optimum utilisation of time, money and effort spent on its development. In order to save the valuable time spend by
systems designers and programmers in designing the complete system and writting codes, certain programs are
required, which are called software tools. The selection of software tools has become an important aspect of software
development. Software tools assist the programmers/ analyst in the design, coding, editing, compiling, linking and
debugging programs. They allow them to focus on the challenging aspects of a system. We are discussing below the
important categories of software tools that are normally used.

ApplicationGenerators

Application generators are software tools that help the programmer to quickly generate a complete or part program
according to the specifications given. The programmer does not write the code but using an application generator,
defines the menus, screen, report formats, data elements and processing logics. The program code is generated quickly
by the application generator. Now, the programmer can easily edit and execute the program. Many application
generators are available for different third and fourth generation languages like COBOL, dBASE, Foxpro etc.

For example, Pacbase is an application generator for programs written in COBOL language. dBASE and Foxpro have
built-in code generation capabilities for designing screen, menu and report formats. Genifer is a full scale code
generator, that provides a pattern called a template, from which the code is generated. After defining screens, menus
and reports, Genifer creates the data files, index files and programs. Advantages of Application Generators The major
advantages of using application generators are - ? Saving a lot of development time ? Useful as a learning tool for writing
programs ? Programs are easy to modify and maintain
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Disadvantages of Application Generators Application generators also have certain disadvantages - ? They cannot handle
systems having complex processing logic ? They add complexity, if template language differs from native language
Software Engineering and CASE Tools Development of an

application software is very complex to plan, design, develop and manage. Software engineering is the systematic
approach in design, development, operation and maintenance of such software. Its basic aim is to produce high quality
software at low cost. Computer

Aided Software Engineering (CASE) tool is a group of different software tools that are integerated and used in software
engineering. For example, Designer/2000 is Oracle's suite of CASE tools that address the different stages of the
application development. CASE tools simplify all stages of project planning, analysis and design of an application. CASE
tools include many important features like graphics library, data dictionary, design methodology, screen/ report
designing and systems documentation. CASE tools incorporate modelling techniques for representing the data and
processes.

SYSTEMSOFTWAREUTILITIES

System software utilities support the operation of the

computer. They provide many features including file management capabilities, data compression, diagnostic routines,
virus detection and removal, text editing, performance monitoring and spooling.
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There are many types of utilities for carrying different tasks. We must be aware that utilities are not operating systems, but
certain utilities are inbuilt in operating systems. We are describing below the important types of utilities that are
commonly used in computers.

FileManagementUtilities

These utilities provide

file management capabilities like copying, comparing, searching, listing and sorting the files. Although these features are
offered by many operating systems, utility programs provide better user-friendly environment along with some additional
features. Norton Utilities (

NU)

and PC TOOLS are the most commonly used file management utilities.

Data Compression Ultilities

These utilities compress or decompress files that are stored on floppy and hard disks. As compressed files take up very
less space

in

disks, data compression utilities are widely used during copying of data from hard disk to floppy disks. PKZIP/ PKUNZIP
programs are commonly used examples of data compression utilities.
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Diagnostic Utilities These

utilities can detect bugs (errors in hardware/ software) in computers. For instance, the problems of floppy and hard disks
can easily be detected by a popular utility program called Norton Disk Doctor (NDD).

QAPlus and Disk Manager (DM) are other examples of utilities that can detect and remove many bugs in storage devices,
software and other components of computers.

VirusDetectionandRemovalUtilities

These utilities are used to detect and eradicate the different types of viruses. Before discussing their importance, let us
first discuss, what is a Virus ? Virus is an unauthorised software that is used to invade and disrupt the normal working of
computer. Like biological viruses, computer virus spreads from one computer to another generally through floppy disks.
There

are

many problems caused by viruses like damage of data, loss of user interface, unexpected screen messages, system
crashes etc. The potential problems caused by viruses in today's organisational computer systems

is

the worst. There are many types of viruses and their numbers is increasing day by day. The users and managers must take
precautionary measures to control the spread of these viruses. There are many utilities, such as Nashscan, SmartDog, Dr.
Soloman’s Anti-Virus Toolkit etc. that can detect and remove most of the viruses and are popularly called as Virus
Scanners. These virus scanners must be upgraded from time to time for detection and removal of new viruses.
TextEditingUtilities

These

utilities are used to create, edit and print the non-document texts such as programs, data etc. Norton Editor (NE) is the
most common example of text editor. Most operating systems, including DOS, also has inbuilt text editor program.
PerformanceMonitoringUtilities

These utilities provide information about the efficiency of computer working. For instance, QAPlus, PC Tools and Norton
Utilities provide performance monitoring capabilities by providing information about speed, storage capacity and other
features of the system.

SpoolingUtilities

In multi-user/ networking environments, the input and output devices are generally slow. In such environment, the
processing of computer is also slowed down. To control the computer from being slowed down, the spooling programs
are used. SPOOLing (Simultaneous Peripheral Operations OnLine) program is used to buffer data for the
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printer and remote batch terminals. This program sends the output to the disk and printer does not interact with CPU
during printing. Spooling utilities are used mainly in computer systems with multi-user/ networking environment.
WINDOWS-AGRAPHICALUSERINTERFACE(GUI
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We have discussed the role of an operating system in managing the operations of a computer. Most microcomputers use
DOS as an operating system. Although DOS is essential to operate a computer, but the user interface with DOS is not
user-friendly. In order to operate the computer, one must learn DOS commands. The user is expected to memorise all
DOS commands and understand their correct syntax (rules for writing statements of a language). Therefore, only DOS
environment is not considered sufficient for running present day applications on PCs. Most of the present day
applications related to management and other fields need a graphics-based user interface that is easy to operate. Such a
graphics based user interface, that incorporates pull down menus and icons (small pictorial representations of files,
programs, storage devices etc.) is known as Graphical User Interface (GUI). For example, as we have discussed earlier, the
operating system of Mac PCs provide graphical user interface (GUI). In IBM-compatible PCs, GUI is provided by an
operating environment/

system - ‘Windows'.

Windows is the most popular system software, that provides graphical user interface. Windows provides an interface,
which is similar to

the Macnitosh

user interface. In such interface, each active application is displayed in

a window on the screen as shown in Figure 4.4.

The application window can be closed, opened, hided, displayed, moved, resized, minimised or maximised. The user can
run several applications simultaneously, each in its own window. Windows allow the user to share data among different
applications. Windows provides an interactive environment, where the user is engaged in continuous dialog with the
computer. In windows, although both keyboard and mouse are used as input device,

the mouse

is the primary tool for selecting and running window applications. The different versions of
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windows are Windows 1.x, Windows 2.x, Windows 3.0, Windows 3.1, Windows 3.11, Windows for Workgroups 3.11,
Windows 95, Windows 98 and Windows NT. Windows 1.

X, 2.x and 3.0 were the earlier attempts from Microsoft, Inc. for creating graphical user interface but were not very
successful. Windows 3.1 and higher versions provide powerful and multifeatured GUI capabilities. Windows NT may
appear

to you user

same as Windows 3.1, but it is based on entirely a different concept.

Therefore, we have already discussed about Windows NT in our discussions on ‘Types of Operating Systems’. Now, we
continue our discussion mainly on Windows 3.1, Windows 95 and Windows 98.

78 Basic Computer Skills Figure 4.4 A Window Screen showing many active applications. Win dows 3.1/ 3. 11 & W i
ndowsforWorkgroups3.11

Windows 3.1 is generally misunderstood as an operating system, but actually it is not an operating system. Windows 3.1 is
a graphics-based operating environment that replaces the DOS interface. In order to run Windows 3.1, DOS must be
installed on the computer.

Windows 3.1 has all the basic features of other GUIs.

It also provides non-preemptive multitasking features, which allow users to run several programs at

once. Non-preemtive multitasking means the programs must voluntarily give up control to the computer for getting
their turn. Windows 3.11 is the successor of Windows 3.1, with a trivial difference.

Windows for Workgroups 3.11 is a peer to peer network (a network in which any computer can be server) version of
Windows. It includes 32-bit file access system, which is not provided by Windows 3.11.

Windows95

Windows 95 is a much awaited replacement for Windows 3.1.

Itis a

new 32-

bit operating system from Microsoft, released in 1995. Windows 95 provides the following important features:
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Built-in Networking: Windows 95 has sophisticated 32-bit built-in network components, that

allows it to operate both as client in

a client-server network and peer-to-peer network operating system. In client-server approach, there is a central
computer acting as a file server, with which workstations called ‘clients’ are attached.
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In peer-to-peer networking, every computer connected with network can work as a file server and therefore can share
files and printers with other computers.

ii.

Multimedia Functions: Windows 95 provides all multimedia controls and functions. Multimedia is the way of
disseminating information in form of text, audio, graphics/ animated graphics and full-motion video.

iii.

Preemtive Multitasking: Windows 95 provides preemtive multitasking features, which are found in operating systems like
OS/2 and Windows NT. In preemtive multitasking, operating systems dictate the time slice for each program, resulting in
smoother control and fewer crashes. iv.

Memory Protection: Memory protection feature of Windows 95 ensures that one application do not crash other
applications in memory. v. ‘Plug and Play": Windows 95 automates the hardware configuration process,

by

knowing the kind of printer, mouse and other peripherals. This feature is known as 'Plug and Play’. vi. OLE (Object Linking
and Embedding): OLE is the key technology for Windows 95.

Object Linking and Embedding

is the Microsoft's standard for creating compound documents (compound document is a document made from different
programs) in windows.

OLE permits seamless integeration of applications in windows.

Windows98

Windows 98 is the latest upgrade of Microsoft Windows operating system. It makes our computer easier to use by
providing new and enhanced features. The major features of Windows 98 are— i. Faster than Windows 95: Windows 98 is
a faster operating system. Without adding new hardware, the computer runs faster in Windows 98 as compared to
Windows 95. The maintenance wizard of Windows 98 checks the hard disk for problems and frees its space so that the
programs run faster. ii. Web Integration: It provides improved web features by combining the power of the computer
with the interactive content of the Internet. iii. Improved Reliability: It improves computer reliability by introducing new
utilities, wizards and resources which help in running the computer smoothly and efficiently. The new web-based
resource site automates driver and system file updates, and provides up-to-date technical support.

The

system file checker of Windows 98 restores the critical files if they are changed. In Windows 98, scandisk runs
automatically if the computer is shut down improperly.
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iv. Multiple Display: In Windows 98, we can use several monitors simultaneously to run different programs on separate
monitors. v. Power Management: Windows 98 improves the startup time of the computer. In Windows 98, we can start
the computer in just a few seconds. Windows 98 restore all the programs in their last saved positions. vi. More
Entertaining: Windows 98 provides new features such as enhanced television, video playback and Web TV for Windows
that makes our computer more entertaining. Using Web TV for Windows, we can receive and view searchable television
program listings provided we have an Internet connection and a TV tuner card installed on our PC.
GENERALPURPOSEAPPLICATIONSOFTWARE

Whenever an organisation purchases computers, besides an operating system certain application software are also
required to be purchased. These

software are needed for general purposes like word processing, database management, spreadsheets etc. and are known
as General Purposes Application Software.

We are discussing below the importance of different general purposes application software along with their major
products. Word ProcessorPackages

Word processors are application software which

are used for word processing. Word processing is the most widely used technique for typing, editing, storing, formatting,
manipulating and printing documents with the assistance of computer and printer. It is the most efficient means of
generating documents electronically.

Advantages of Word Processing Word processing offers several advantages over typewriting. Using the word processing
technique, the user can - ? edit the text as and when required ? move or copy any part of the text from one location/ file
to another location/ file ? insert or delete the spaces/ text ? wrap words to the next line (Word Wrapping) and justify text
to the right margin (Justification) ? select different types of fonts and size of characters ? adjust the margins and page
lengths for the desired output ? find the required word/ group of words and replace with another word/ group of words
? check the spelling of any word of the document
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store (save) the document on disk and print single or multiple copies ? print letters with same text

and

different names and addresses (mail-merging) Besides the above main features, there are many more benefits of word
processing depending upon the word processor used.

Examples of Common

Word Processors There is a wide range of word processors available for both DOS and Windows environment. Word Star,
Softword, Akshar, MS Word, Word Perfect and Amipro are some of the common examples of word processors. Word Star
the most common and popular DOS-based word processor is developed by the MicroPro International Corporation, Inc.
U.S.A.. There are different versions of Word Star like 1.x, 2.x, 3.x, 4.0, 5.0, 6.0 and 7.0 but the releases 4.0 (also known as
Word Star Professional)

and 7.0 (the latest one) are the most popular among users. Softword and

Akshar are also DOS-based English and Hindi word processors respectively developed by an Indian Company, Softech.
Among the windows-based word processors, MS Word, Word Perfect and AmiPro are the leaders in the markets (

DOS based versions of these packages are also available).

MS Word, developed by Microsoft Inc. is a part of MS Office professional package. Word 6

for Windows 3.1

and Word 7 for Windows 95 are the most popular versions of Word. Word Perfect (latest version 6.0), developed by Word
Perfect Corporation, which provides almost same features as MS Word is also very popular among users. Ami Pro (latest
version 3.0)/ Word Pro, developed by Lotus Corporation, is another full-fledged, multi-featured word processor for
windows. The important word processors are listed in Table 4.5. Table 4.5 Common word Processors. Word Processor
Description Word Star Simplest DOS-based word processor Softword Similar to Word Star developed by an Indian
company Akshar Popular Hindi/English word processor developed by an Indian company Word Popular Windows-based
word processor Word Perfect

Most widely used Windows-based word processor

Amipro Full-fledged, multi-featured Windows-based word processor with DTP features

Database Management Packages Business processes are always associated with a huge amount of data. To store,
manipulate and process such data, some software packages are needed, which are
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Management System

is defined as a

software that organises and maintains the data in a database for providing the information.

Before discussing about these packages, let us see what is meant by

the terms - data, information,

file and database. Data and Information Data and information are the two basic components of any information system.
Data is defined as a set of basic facts and entities which itself has no meaning or value. For example, 5000, 4000, 4500,
4800, 8900.... is a data of employees salaries which itself has no meaning. On the other hand, information is defined as
that data which has some meaning or value. For example, the personal data of employees names and their basic salaries
represented as “Komal — 5000", “Rajesh — 4000", “Sarika — 4500", “Suchitra — 4800", "Pawan — 8900", etc. is an
information because it has some meaning. File

and Database

File is a group of related records in a database. For example, a group of personal records of all the employees of a
company is a file. However, database is a collection of related files that is created and managed by a database
management system.

The most important point to remember about database is that it contains data and not necessarily information. Some of
the examples of the database are as follows : i. The vouchers, bills receipt and other financial data of an organisation. ii.
The details of students and their marks obtained for preparing their result in a school. In the above examples, the data
can have some meaning or no meaning in itself until it is processed to get useful information.

Examples of Database Management Packages Many database management packages are available in the market.
Managers must be aware of the benefits and limitations of these packages before purchasing and using them. dBASE,
Foxbase, Foxpro, MS Access, Paradox, Oracle, Ingres, Sybase, Informix etc. are the major products of database
management systems. dBASE is the most popular and simplest to learn database management system which is
developed by Ashton-Tale, U.S.A.. dBASE Il was the first product developed for database applications and later on
Ashton-Tale developed new versions viz. dBASE Il plus, dBASE IV and dBASE V. dBASE Il plus and dBASE IV are
exclusively DOS based versions while dBASE V is windows-based. FOXBASE+ is a dBASE Il plus compatible DBMS, which
is originally developed by Fox Software and later on by Microsoft. It is faster and multi-user as compared with dBASE lI
plus which is slow and
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single-user.

Microsoft developed another dBASE IV compatible DBMS, called FoxPro which has now become very popular among
users. FoxPro 1.0, 2.0, 2.5, 2.6 and
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Visual FoxPro 3.0/5.0 are the different versions of FoxPro. FoxPro offers several advantages over both dBASE and
FoxBASE. The difference between dBASE, FOXBASE and FoxPro are given in Table 4.6. Table 4.6

Comparison among three popular DBMSs. Criteria

dBase Foxbase Foxpro Operating Environment DOS/Windows DOS DOS/Windows Users Single-user Multi-user Multi-
user Execution Speed Slow Medium Fast Disk Storage Less Average

More Features Less Average Many Program Generators Less

Less Many Compiler Not available Available Available MS Access, developed by Microsoft Inc., is also a part of MS Office
professional package. It is a relational database management system (RDBMS), which is windows based and is quite
similar to Visual FoxPro. Paradox, a part of Corel Office Pro software, is a network RDBMS and is known for its Querry By
Example (@QBE) method for asking questions. Oracle, Sybase, Ingres and Informix are the leaders among RDBMSs.

The list of

major DBMSs products are illustrated in Table 4.7. Table 4.7 Common DBMS packages. DBMS Pacckage Description
dBase Most popular DOS/Windows based database management system Foxbase Faster, multi-user dBase-compatible
DBMS Foxpro/ Visual Foxpro DOS/Windows-based DBMS with advanced features Access Windows-based DBMS similar
to Visual Foxpro Paradox Netword RDBMS with QBE (Query By Example) features Oracle Most popular RDBMS for
microcomputers Sybase

Distributed RDBMS that runs on most servers Ingres Popular RDBMS that runs on many operating systems Informix
Popular RDBMS server mainly for UNIX operating system.
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Spreadsheet

Packages Business applications require a lot of calculation work. In manual system, it is done on a sheet of paper with
rows and columns, which

is

called a 'spreadsheet’. Spreadsheet packages use the concept of an electronic spreadsheet. An electronic spreadsheet (
or worksheet)

is a very big sheet consisting of thousands of rows and columns, which

is

used to store information in the memory of a computer. Like databases, electronic spreadsheets have now become an
essential tool in developing a computerised management information system.

Income statements, annual reports, balance sheet, cost analysis and budgets are some of the applications where
worksheets are typically used.

Advantages of Electronic Spreadsheets The electronic worksheet offers several advantages over manual and other
computer application software. These are described as follows : ? The user can perform any type of calculations
involving mathematical, financial, statistical and other functions. ? All recalculations are performed automatically, if any
figure is changed. ? As worksheet is very big in size, so a large volume of data can be stored on a single worksheet. For
example, it is possible to store entire data of accounts of a big organisation on a single worksheet. ? The user can view/
print the data in any desired format. ? Most of the word processing features like spell checking, find/ replace words can
also be performed on a worksheet. ? The data of worksheet can be viewed in many types of graphs/ charts. ? The
worksheet can be saved, retrieved, combined to another worksheet and transferred to files of different database and
word processing packages. Besides the above main features, there are many more benefits of spreadsheets depending
upon the spreadsheet package used.

Examples of Common

Spreadsheet Packages There are many products of spreadsheet packages— some of them are exclusively windows based
like MS Excel and others both as DOS and Windows based like Lotus 1-2-3. Lotus 1-2-3, developed by Lotus
Development Corporation, is the most popular spreadsheet package among DOS users. The different versions of Lotus
1-2-3 arerelease 1.x, 2.x & 3.x (DOS based) and 4 & 5 (both DOS & Windows based). Lotus 1-2-3 is also available as a part
of Lotus Smartsuite office automation package in the market. MS Excel, a part of MS Office, is the most popular Windows
based spreadsheet package. The

latest and
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popular versions of Excel are Excel 5.0 (for Windows 3.1) and Excel 7.0 (for Windows 95). Quattro Pro (latest version 5.0),
developed by Borland International is another spreadsheet package that provides advanced graphics and presentation
features. Javelin Plus (from Information Resources, Inc.), Multiplan (Microsoft Corp.),
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Supercalc (Computer Associates International, Inc.) and PlanPerfect (Word Perfect Corp.) are some other examples of
spreadsheet packages.

The list of major spreadsheet packages are given in Table 4.8. Table 4.8 Common Spreadsheet Packages. Spreadsheet
Package Description

Lotus 1-2-3 Most popular DOS/Windows based spreadsheet package Excel Most popular Windows based spreadsheet
package Quattro Pro Spreadsheet package with advanced presentation features

Javeline Plus Spreadsheet package that uses names to identify calls Multiplan Spreadsheet package from Microsoft Corp.
Supercalc Spreadsheet package from Computer Associates PlanPerfect Spreadsheet package from Word Perfect Corp.
Office Automation Packages (Office Suites)

Word processors, Spreadsheets and Database Management packages are also available as integerated

packages generally called Office Automation Packages/ Software Tools

or

Office Suites. MS Office and Lotus Smartsuite are two most popular examples of office automation packages. Microsoft
Office (MS Office) Professional is a package that contains five powerful general purpose application packages. It includes
Word, Excel, Powerpoint, Access and Mail. We

have already discussed about Word, Excel and Access

in previous sub- section.

Powerpoint is used to create professional presentations in the form of slides. The user can write text, draw figures and
organisation charts on these slides. Powerpoint is the most popular and commonly used desktop presentation program
for Macintosh and PCs. Powerpoint 4.0 and Powerpoint 7.0 are the currently used versions

for Windows 3.1 and Windows 95 respectively. MS Office 4.3 and MS Office 97 are two currently used versions for
Windows 3.1 and Windows 95 respectively.

Lotus Smartsuite

is another popular office automation

package that contains five powerful general purpose application packages. It includes Word

Pro, 1-2-3, Freelance Graphics, Approach and Organizer.

We have already discussed about Word Pro, and 1-2-3 in previous sub-section. Lotus SmartSuite 7.0 and Lotus
SmartSuite 97 are Windows and Web Enabled versions of SmartSuite respectively.

Corel Office, an office suite, contains Word Perfect, Quattro Pro, Paradox, Corel Draw, Netscape Navigator,
Presentations, Corel Flow, Sidekick and other

general pupose

application packages. SideKick is the first popup program (TSR - Terminate and Stay Resident’ in memory) used for
editing programs and non-document files.
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Although general purpose application software are exclusively used by all users for general appications, but there are
certain software which are meant for some special applications and organisations. Besides general purpose application
software, some

organisations

also need software for desktop publishing, graphics, multimedia, animations, financial accounting, sales and marketing,
inventory, export documentation etc.. These software are collectively known as Special Purpose Application Software.
We are discussing below the different types of special purpose application software. DesktopPublishingSoftw
ar e Desktop

Publishing (DTP) software are used to produce a high-quality document for commercial printing. Using DTP software,
text and graphics are combined into a single document that is printed generally on a laser printer. Although these
software are mainly useful for publishers but they are also used in general offices and educational institutes for the best
presentation of management documents, project reports and thesis works. DTP software are used in combinations with
word processors, graphics and CAD (Computer Aided Design) software. First, the document is written by using a word
processor and the graphics/ diagrams are made by using graphics/ CAD software. Then, all documents and graphics are
merged into the DTP files for advanced page formattings. DTP software are widely used by publishers and other
organisations. These software require a special kind
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of hardware system which include a high speed PC (prefearlly 486 or higher),

laser printer and scanner/ digitizer. Examples of DTP Software Many desktop publishing software are available in the
market with a wide variety of features. PageMaker, Ventura and CorelDRAW are the most common examples of DTP
software. PageMaker (latest version 6.5), originally developed from Aldus Corp. and now from Adobe, is the most
favourite among Indian users. Although PageMaker was originally introduced for Macnitosh but currenly it is available for
both Mac and PC (mainly for Windows). Ventura Publisher (

latest version 4.),

developed by Ventura Software, Inc. (a Xerox company), provides full-scale pagination features for very large documents.
It is available both for Mac and PCs (under DOS, Windows & OS/2). CorelDRAW (latest version 8.0), developed by Corel
Systems Corp., is the popular windows-based DTP and Graphics Software for PCs. It is designed to work with high
quality graphics images and provides advanced autotracing features for building a vector- based image. As it does not
provide word processing/ DTP page layout features, it is used in combination with word processors and other DTP
software like PageMaker. Graphics, Multimedia and Animation Software For last few years, Graphics, Multimedia and
Animation Software are becoming very popular for high quality presentation of business and other applications.
CorelDRAW, Adobe Photoshop, AutoCAD Map and Harvard Graphics are some of the commonly
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used graphic software. We have already discussed about CorelDRAW in the previous sub-section. Adobe Photshop is an
image editing software with multiple layers, interactive GUI and powerful object-based editing tools. AutoCAD Map is a
software for mapping and graphic applications. Harward Graphics, developed by Software Publishing Corp., is a business
presentation software. It allows the user to create professional looking presentations in just few minutes. Multimedia, a
latest computer technology, displays information using a combination of full-motion video, text, graphics, animations
and sound. A wide range of multimedia and animation software are available in the market. Macromedia Director, 3D
Studio Max, AnimatorPro and Animator Studio are some of the commonly used multimedia/ animation software.
Macromedia Director is a multimdeia authoring software for creating tutorials and CBT (Computer Based Training)
software. 3D Studio Max software allows the user to create 3D modelling and animations on a PC. AnimatorPro is an 8-
bit, 256 colour, 2D Paint and animation software with in-built C based programming, 3D Studio and customised GUI.
Animator Studio is a digital sound studio designer for animation with true colour features.
BusinessApplicationSoftware

Every business consists of many functions which are organised into different departments like Finance, Marketing,
Invetory, Production, Research and Development (R & D) and Human Resources Development (HRD). For computerising
these departments, special kind of application software are needed, which are collectively called as Business Application
Software. These software are available either general requirements of the users (Standard Software) or can be developed
as per the requirement of a specific organisation/ user (Customised Software). Accord, EX and and Tally are some of the
examples of popular standard financial accounting software packages among Indian users. Accord (

latest version 4.1),

developed by EDP Corporation, is the comprehensive accounting software for preparing MIS and other reports. EX (latest
version 3.0), developed by Tata Consultancy Services, provides business accounting capabilities along with inventory and
invoicing features. Tally (latest version 5.0), developed by Peuronics Pvt. Ltd., is the accounting and book keeping
software along with capabilities of invoicing/ inventory accounting.
LATESTTRENDSININFORMATIONTECHNOLOGY Since the advent of first commercially available
computer (UNIVAC 1) in 1952, there is a rapid development in the field of information technology. The IT industry
continues to grow at record speeds. Today, PCs are being used much more than their original purposes of data
processing. We have already discussed the role of computers in various fields in the first chapter. We are, now, discussing
below the latest trends in information technology, which are networking, client/server computing, data communications
and telecommunications.
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Networking Network is a group of computers and peripherals, connected by a communications channel. It is capable of
sharing files and other resources such as printers, drives etc. among many users. It ranges from local area networks to
wide area networks.

Local Area Network (LAN) connects several computers within a confined geographical area with permanently installed
cables and dial-

up-lines.

Peer-to-peer network is a local area network in which all the resources of each PC is available to other PCs on the
network.
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A typical LAN consists of a server, workstations, a network operating system (such as Windows NT) and a communication
link (such as Modem). Server is any LAN computer that holds data/ programs and makes access to files, printing and
other services available to users of the network. Typically, a server has a more advanced CPU with more memory and
storage capacity than a workstation. Workstation is a user's machine (other than server) that can also function as a stand
alone computer.

As contrast to LAN, Wide Area Network (WAN) connects users across large distances, often crossing the geographical
boundaries of cities or states. Thus, WANs are much bigger than LANs. A WAN may consist of several LANs. The individual
LANs inside the WANSs are generally referred as

sub-networks.

Besides LANs and WANSs, there are certain networks which are bigger than LANs but smaller than WANs. These networks
extend beyond the confines of a LAN but not spreadover in wide area. These networks, which are usually confined to a
single metropolitan city are known as Metropolitan Area Networks (MANSs).

Networking offers several benefits to the organisations. In networking, the users can share information such as
databases, memos, messages etc. and expensive resources such as laser printers, scanners etc. among others. Client/Ser
ver Computing Client/ Server Computing is a new kind of computing that divides a computer application into three basic
components - a client, a network and a server. In client/server computing, the processing is distributed between clients
and server on a network. The client and server are both computers with different processing powers to share the
computing workload in a network. Typically, the server is an advanced PC (with more memory and storage capacity),
minicomputer or mainframe computer while client is a user’'s PC (workstation). Client/ Server computing is sometimes
misunderstood as networking, but it is not a networking. In other words, simple networking does not mean that itis a
client/server computing. To understand this concept, let us first see, what is a dumb computing in networking. If, in a
network, either a client or server plays no or little role in sharing of data processing, then such computing is termed as
dumb computing. In dumb computing, when most or all of the processing is done by server, then the client is said to be
‘Dumb Client’. This type of processing is also called 'Host Processing’ because the host computer processes all data. If
most or all of the processing is done by client in a network, then the server is said to be 'Dumb Server’. The networks
either with dumb server or dumb

89 Software Concepts client are not considered suitable for multi-user applications involving more users due to too
much slow processing. In client/server computing, neither the server nor the client is dumb, but both share the
workload. In client/ server computing, the server must share the data processing workload with client besides sharing
files, printers and other resources. Client/Ser ver Database Applications : Client/ server computing is mainly needed in
database applications, especially in development of management information system. In client/ server database
applications, the database runs on the server, which is called the Back End and the application program that accesses
database, runs on the client, which is called Front End. The front end program requests services of the back end program
by querring in the form of SQL (Structured Querry Language) statements. The back end processes the SQL statements
and send the results to the front end program. The client, thus, is responsible for the graphical user interface (GUI) while
the server provides database access. Oracle, Sybase, Informix and Microsoft SQL servers are the commonly used back
end software. The programs that run on the client computers are usually developed using front end tools. The
commonly used front end tools are Powersoft's PowerBuilder, Microsoft's Visual Basic and Borland's Delhi. Besides front
and back end tools, client/server computing require software that operates between client and server. These software
are sometimes termed as Middleware. Windows NT, a popular network operating system is an example of middleware.
Advantages and Disadvantages of Client/Ser ver C om p u ti n g Before deciding on whether an organisation should go
for client/server computing or not, the managers must understand the benefits and pitfalls of client/server computing.
Client/server computing offers following benefits in most of the cases (not always) : ? Cost savings as compared to
mainframe systems. ? Flexible in all the inevitable types of hardware/ software changes. ? Easy to scale the system to
accomodate changes in a workgroup. ? Best utilisation of disk storge and memory in both server and client computers. ?
GUI interface improve the user effectiveness. Client/server computing also have some disadvantages. The anticipated
cost savings of a client/server systems is not always true during real-world situations. Actually, client/ server systems are
rarely less expensive than mainframe systems. The organisation must have the technical expertise to switch to new
system. The cost of retraining staff for development, administration and using the system, outweigh the benefits of the
new system. Another disadvantage of client/ server computing is that its reliability is inherently less than that of a
homogenous centrally controlled system.



Ouriginal

by Turnitin

90 Basic Computer Skills After discussing the benefits and pitfalls of client/server computing, we may conclude that the
correct chioce of application for a client/server computing is the key factor in realising its benefits. Althogh client/server
computing is important for the organisation, but it is not recommended for every application. For advanced study, you
are advised to refer the special books on this topic. Data Communications Large organisations are generally spread over
several office locations. In order to computerise such geopgraphically separated offices, various data communication
facilities are required. The transfer of data and information from one computer to another over a communication link is
known as data communication. Data communication has become essential for an organisation due to several reasons.
The major reason for needing data communication is that it is the fastest and most cost- saving medium for sending data
and messages to various geographically separated offices. There are several types of communication mediums through
which data can be transmitted from one place to another. Some of the common data transmission media are Wire Pairs,
Coaxical Cables, Microwave Transmission, and Communication Satellite. Wire pairs are used in local telephone
communication for transmitting digital data for short distances. Coaxical cables are groups of specially wrapped
insulated wires which transmit data at very high rates. Microwave transmission is the popular medium which is used to
transmit data through the electromagnetic waves. A communication satellite is a microwave relay station placed
precisely at 36,000 KM above the earth. It is the most widely used medium for sending data across a wide area on the
earth. We are not discussing various data communication technologies in details. For further study, the reader is advised
to refer special book on this topic. Telecommunications

Telecommunication refers to the electronic transmission of all forms of information, including digital data, voice, sound
and video from one location to another over some form of transmission media. This transmission media may be a
telephone line or microwave signal. The importance of telecommunications in businesses and personal purposes is
increasing very rapidly with new developments and technologies. ISDN (Integerated Services Digital Network), e-mail,
Internet, Intranet, Video Conferencing, Paging and Cellular technologies have become very popular during last few years.
We are discussing

below in brief some of the widely used telecommunication technologies: E-mail Electronic mail (e-mail) is a very

widely used technology for sending messages or documents from one location to another by using computers. E-mail
services are either available within intra-office network (e.g. local area network) or through an outside vendor. Within an
organisation, the employees use a PC for sending their messages from one electronic mailbox to another. By using e-
mail services from a vendor, the
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e-mail subscriber enters the message into the computer and addresses to the recipient’'s computer by quoting the e-
mail code. The message is then transmitted through the modem to the recipient’'s mailbox where the recipient can
download it.

Internet/

Intranet Internet and Intranet are the most recent telecommunication technologies which have brought a technological
revolution not only in all offices but also in homes. Internet is the world's largest network of million computers all over
the world connected through telephone lines. Intranet, on the other hand, is a network of computers within the closed
perimeters of the office. Teleconferencing Systems Teleconferencing systems are the latest office automation
technologies for conducting meetings of widely separated people through a communication channel. These systems
enable people to communicate audio, video or image information in a conversation taking place between two or more
locations. The teleconferencing systems are of three types - Audio Teleconferencing, Video Conferencing and Computer
Conferencing. Audio teleconferencing is simply a conference phone calls system. With such type of conferencing,
participants can only hear the voice and cannot see the participants.

With videoconferencing systems, the participants not only hear the voice but also see each other. The communication
takes place either in one-way or multi-way modes. In

one-way

mode, which is also known as point-to-point videoconferencing, one of the locations sends the information and others
receive it. In multi-way mode, which is also known as multi-point videoconferencing, two or more locations can send or
receive the information simultaneously. Some types of teleconferencing systems use

computers

for conducting meetings, which are known as Computer Conferencing Systems. In these

systems,

the participants use either e-mail or Electronic Bulletin Boards for sending and receiving information. The messages are
entered into the computers using E-mail facility and an electronic conversation takes place among participants. The
messages can also be posted on a

computer system, called Electronic Bulletin Board, that maintains the list of messages. EMERGINGINFORMATIO
NTECHNOLOGIES
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The IT industry is growing very rapidly and many new technologies are coming day by day. There are certain
technologies which are still under research and development process. Artifical Intelligence and Virtual Reality are major
emerging tecnologies. Artificial Intelligence A computer has no intelligence in itself. It performs tasks by getting
instructions from human beings. Scientists are trying to impart certain abilities to the computer, which can enable them
to perform tasks intelligently, just like human-being. Artificial
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Intelligence (Al) is a capability in computer to carry out the tasks that require intelligence if carried out by human beings.
The term “Artifical Intelligence’, which was coined in 1956 by John McCarthy at Dartmouth Collge, connotes a futurstic
world. Artifical Intelligence is still under research & development program all over the world. Though we are not
discussing this vast field of emerging technology in details, we are presenting below a brief outline of main areas of Al.
Applications of Artificial Intelligence : There are five main application areas of Al research, which are - a. Expert Systems
b. Robotics c. Natural Language Processing d. Computer Vision e. Neural Network. a. Expert System: Expert systems are
programs that are like human experts which possess extensive background knowledge in their specialised field. They are
needed because human expert manpower is scan and expensive. Today, expert systems are available for most of the
business applications like finance, marketing, manufacturing etc. besides technical & medical fields. For example,
PlanMan, Financial Advisor and Plan Power and some expert systems for financial planning areas. MYCIN was the first
expert system project for medical applications. After MYCIN project, new systems like EMYCIN (empty MYCIN) were
developed, which were without knowledge base. The expert systems without knowledge base are called expert system
shell. Guru and VP Expert are other examples of expert system shell. b. Robotics: Robotics is the major field of artificial
intelligence. It is concerned with design, manufacturing and implementation of computer controlled devices, called
Robots. Robots are widely used in many industries like car manufacturing, coal mining, chemical

industries etc..

c. Natural Language Processing (NLP): NLP is that field of artificial intelligence that allows computers to communicate
with users in natural languages like English, French etc.. HAL is the popular natural language interface for Lotus 1-2-3.
Guru is another example of NLP software with capabilities of database management, word processing, spreadsheets and
graphics. d. Computer Vision: This field of artificial intelligence enables computers to recognise shapes and patterns
through a technique called Pattern Recognition.

e.

Neural Networks: Neural networks are knowledge base computer systems that are designed to learn by observations and
repetition just like human beings.

93 Software Concepts Virtual Reality Virtual reality is a concept that projects users into a three dimensional space
generated by computer. Users wear a helmet-like device that completely covers both eyes and ears to create an artifical
computer-simulated reality.

Users can move and manipulate illusory objects in their view. They can select and organise information with hand and
body movements. Several companies are developing business applications for this emerging technology. For instance, a
major electronics firm in Japan is developing an application for a "Virtual Showroom'.
LIMITATIONSOFCOMPUTERS

Though the benefits and applications of computers are numerous, computers still have certain limitations.

They

are not versatile like human beings. They can perform limited functions. Input, output and processing the data are the
basic functions performed by a computer. They perform tasks according to the instructions given by human beings. They
do not have human like intelligence. Although scientists are trying to provide human knowldege and intelligence to the
computers through emerging technology of artificial intelligence, but still they are machines. They cannot possess all the
knowledge and intelligence of a human being, so, computers cannot replace human beings at all.

SUM M ARY Software are the programs required to operate a computer. They are broadly classified into System and
Application software. System software include mainly operating systems, operating environments, DBMSs (Data Base
Management Systems), language translators (Assemblers, Interpreters and Compilers), applications generators, CASE
tools and various software utilities. An operating system (e.g. UNIX, DOS etc.) is the most essential system software
without which we cannot use the computer. Windows is the most popular operating environment that provides a
Graphical User Interface (GUI). Application software are further classified into General Purpose (Word Processors,
Spreadsheets, Database Management Software etc.) and Special Purpose (Accounting, Inventory, Desk Top Publshing
software etc.) application software. Programming is a technique for giving instructions to the computer by using a
computer language. Procedure oriented is the traditional while Object oriented is the latest appraoch used for
programming. Systems

Analyst and Programmers play a vital role in development of
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software. There are mainly four types of programming languages - i. Low-level; ii. High -level; iii. User-friendly and iv,
Object oriented langauages. Low-level lanaguages include Machine Language (1st generation language) and Assembly
Langauage (2nd generation langauage). BASIC, COBOL, FORTRAN, PASCAL and C (3rd generation lanaguages) are the
common high level langauages. User-friendly languages include mainly dBASE, Foxbase, Foxpro, MS Access, Oracle,
Sybase and Ingres (4th generation lanaguages). Smalltalk, Visual C++, Visual J++ and Object Pascal are some of the

94 Basic Computer Skills popular object oriented languages. Application generators generate the program code
according to the specifications given by the programmer.

CASE tools simplify all stages of project planning and design of an application.

System software utilities support the operation of computer by providing many features like file management, data
compression, diagnostic routines, virus detection and removal, text editing, performance monitoring and spooling.
Networking, Client/Server computing, data communication and telecommunications are the latest trends in information
technology. Artificial Intelligence and Virtual Reality are the emerging information technologies. Although computers
provide numerous benefits to the man, they cannot replace human beings atall. EXE R C | S E Fill in the Blanks: a.
Software are broadly classified into systemand ___________ software. b. The term 'booting’ come's from the word

. €. The traditional approach used in programmingiscalled __________ Oriented Programming. d. COBOL
__________ level language. e. Object Oriented Languages may be classifiedinto __________ Generation
Languages. f. Artificial Intelligenceand __________ are major emerging technologies. Unsolved Questions 1.
Differentiate between system and application software. Give 4 examples of each. 2.

What is an operating system? Describe its basic functions. 3. What is booting? Explain it with suitable illustration. 4.
Classify the following operating systems into Single-user (S) or Multi-user (M): i. MS DOS ii. OS/2 iii. UNIX iv. Windows NT
V.

OS/400 vi. PC DOS vii. Linux viii. MVS 5. Explain with examples the difference between multiprogramming,
multiprocessing and multitasking. 6. Which is the traditional approach of programming? What are its major
disadvantages? 7. What is OOP? Describe its advantages over procedure oriented programming. Why is it not as widely
used as the latter.

95 Software Concepts 8. Discuss the role of programmer and systems analyst in development of a software. 9. Describe
with examples five generations of lanaguages. Which generation of language is most suitable for development of GUI
applications and Why? 10.

What is the difference between an interpreter and compiler? Give 2 examples of each. 11. What is an assembler? Give
examples

of 2 assemblers. 12.

What are software tools. Describe the major categories of software tools with examples. 13. What are application
generators? Describe their advanatges and disadvantages. 14. What are CASE tools? Describe their importance in
development of a software. 15. What are system software utilities? Describe the role of commonly used utilities with
suitable examples. 16.

Only DOS environment is not considered sufficient for running present day applications on

PC. Why? Which operating environment is most widely used on PCs and Why? 17. Describe the differences among
Windows 3.1, Windows 95 and Windows 98. 18.

Discuss the importance of word processors in generating documents. Give some examples of DOS-based and
Windows-based

word processing packages. 19. Discuss the major features of commonly used Database Management packages. 20. What
is an electronic spreadsheet? Describe its major advantages. Name some commonly used spreadsheet packages. 21.
What are Office Suites? Why are they so popular among computer users? Discuss with examples. 22. What is DTP?
Describe the importance of various DTP software currently available in the market. 23. What is multimedia? Name any 4
multimedia software which are popular among users. 24. Discuss the

role of various business application software in computerising the different departments of

a company. 25. What is Networking? Differentiate between LAN, WAN and MAN. 26. What do you mean by Client/server
computing? How does it differ from networking? Describe various advantages and disadvantages of client/server
computing. 27. What is data communication? Why is it so important for an organisation? 28. What is
Telecommunication? Describe the role of latest telecommunication technologies.

96 Basic Computer Skills 29. What is Internet? How does it differ from Intranet? 30. What do you mean by the term
"Artificial Intelligence™? Discuss about the major application areas of Al research. 31. What is virtual reality? 32. ~Although
computer provides enumerous benefits to the man, it can't replace human beings at all'. Discuss. 33. Give the full form of
the following abbreviations: i. DOS ii. HLL iii. BASIC iv. CASE v. GUI vi. RDBMS vii. OLE viii. FORTRAN ix. VMS x. MVS 34.
Classify the following languages into 3GLs, 4GLs or 5GLs: i. PASCAL ii. Oracle iii. C iv. Simula v. FORTRAN vi. Java vii.
Smalltalk viii. Eiffel ix. Sybase x. Foxpro
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97 Software Concepts CASEST U DY Customised Inventory Control Software: STOCKSYS STOCKSYS (version 2.0) is
the customised inventory control software developed by National Computer Lab (Regd.) for Reebok India Company for
maintaining the inventory of apparels. This software was developed in dBASE Il plus/Clipper under DOS environment by
the systems analyst, Mr. Ashok Arora in July,1995 as per the specifications given by Mr. Johney John, Executive Director—
Apparel of Rebook India Company. The inventory system is completely menu-driven and user friendly. STOCKSYS
provides a user-friendly data-entry, modifications, query and report printing modules. In all modules, the on-line help is
available by pressing various function keys. For manufacturing the apparels, the company purchases raw materials from
various suppliers and issued them to the vendors for their processing (like embroidery, printing etc.). A purchase order is
made at the time of giving orders to various suppliers. Items are received at the warehouse/factory either from the
suppliers or vendors against P.O. (Purchase Order) No. or Issue No. respectively. The items may also be rejected to
suppliers either from warehouse or factory against the receipt number. The items are grouped into various categories,
colours and sizes. The main menu of the STOCKSYS provides different options for adding, changing/deleting and viewing
the data besides printing the reports. By selecting “Add’ option, the user can add various details about the colour codes,
category codes, item codes, items ordered, items received, items issued and items rejected. The user can also modify or
delete any data later on by selecting 'Change/Delete’ option. The user can query about any data enterred by selecting
the "View' option. STOCKSYS provides a customised report printing module for printing the purchase order, purchase
book and various analysis reports. The user can print a range of purchase orders by specifying the starting and ending
P.O. Nos. along with their number of copies. Similarly, the purchase book can be printed by specifying the starting and
ending received dates. The analysis reports of STOCKSYS includes the Stock Status Report, Stock Summary Report, ltems
Rejected Report and Purchase Analysis Report. The stock status report provides the information about opening balance,
received quantity, issued quantity, rejected quantity and balance quantity of each and every item by
category/item/colour-code wise. Stock summary report does not give detailed description about the current stock
positions but provides only the summary. The items rejected report provides the description of items rejected to various
suppliers/ vendors along with the reasons. The purchase analysis reports provide description about the purchases made
from various suppliers both by item and supplier wise. Qu e stions 1. Discuss the importance of an inventory control
software for a manufacturing organisation. 2. How does a customised application software differs from a standard
application software? Explain with suitable examples. 3. Discuss the characteristics of a user-friendy software.
Introduction to DOS U N I T 5 In the last unit, we discussed that system software controls the working of hardware and is
essential for running the application programs. An operating system is that important system software which helps in
running the computer system. It is an integrated set of specialized programs. The hardware cannot work without the
operating system. Infact, an operating system provides an interface between the hardware and the user. It acts as a
translator that conveys information between you and your computer system. An operating system performs all the
functions of storage management and I/O (Input/ Output) device management. The user saved the effort and time of
knowing hardware just because of the presence of an operating system. DEFINITIONANDIMPORTANCEOF
DOS
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DOS is the most commonly used operating system. The full form of DOS is Disk Operating System. It is a single user
operating system which means that only one application can be made to run at one time. DOS provides a ‘Platform’ or

an
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LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Definition and Importance of DOS ? Loading DOS ? Rebooting the Computer ? Files and Directories in DOS ?
Referencing Files ? File Naming Conventions ? DOS Commands ? Wildcards ? Some More DOS Commands ? Internal
and External Commands ? Batch Files
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Environment' which lets the application program to interact with CPU and I/O devices. Many application software
require DOS for running. The common among these are word processors like Wordstar, Professional write;
spreadsheet programs like Lotus 123, VP Planner Plus; accounting software like Tally, EX, etc. Each software package
has a specific command to get itself running on DOS. For example, in order to run the spreadsheet program, Lotus 123,
you will have to enter 123 at the DOS prompt. DOS will run Lotus 123 for you. Once any application software shuts
down, the control again has to come back to DOS and the DOS prompt can be seen again on the screen. Now, DOS is
ready to accept more commands from you. MS DOS (Microsoft Disk Operating System), a product of Microsoft
Corporation of USA., is the most popular operating system for PCs. Another operating system available in the market is
the PC DOS, a product of IBM, which is almost similar to MS DOS. Whether you use MS DOS or PC DOS, the basic
commands of DOS remain the same.

LOADINGD os To be able to use a computer system, the operating system (DOS) must always be present in its
memory. So, as and when a computer system is switched on, the very first thing that is placed in the computer's memory
(i.,e. RAM) is DOS. Thus, loading DOS in computer's memory is called Booting the system.
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The booting happens automatically when the computer is switched on, provided DOS is available on it. DOS can be
present on both hard disk as well as the floppy disk. So, when the system is turned on, a search for DOS is done on
floppy drive first. If it is not present on the floppy drive, the DOS is searched for on the hard disk. Thus, for booting to
happen, the DOS must be present either on the floppy or on the hard disk. So, if DOS is not present on the hard disk,
insert the floppy carrying DOS software in the A drive before switching on the system.

How will you find out whether DOS has been loaded in the memory or not? You can very easily assure yourself when the
following query is seen on the monitor: Current date is Mon 11-02-98 Enter new date (mm-dd-yy):_ DOS wants you to
enter a date after the colon (:) at the position where a flashing cursor is seen. Enter the date in mm-dd-yy (month-date-
year) format. An error message may appear on the screen if a format other than the one specified is entered. However, it
is not at all essential to enter a new date. In such a case, the current date is assumed to be the new date. Once the new
date is entered, hit the &gt;Enter&lt; Key. After this, enter the new time where a flashing cursor is seen in the format of
hours: minutes: seconds. The seconds entry is entirely optional. Hit the &gt;Enter&lt; key once time is entered. You can
also avoid entering time as you did with date. After pressing &gt;Enter&lt; key,
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the following screen can be seen: Current date is Mon 11-02-98 Enter new date (mm-dd-yy): 11-12-98

Current time is 0:01:50:12 Enter new time:11:53:14 A:\&lt;_
100 Basic Computer Skills where underscore character '_ ", indicates the cursor (blinking mark) on
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the screen. However, if booting has been done from the hard disk, then the following Prompt will come: C:\&lt;_
C:\&lt; or A:\&Llt; is the DOS Prompt. Looking at DOS Prompt, you can easily make out the currently active drive. If you
want to switch yourself over to another drive, then simply type its drive letter after the prompt and hit the &gt;Enter&lt;
key as shown below: C:\&lt;A: &gt;Enter&lt; A:\&lt;_ Now again if you want to go back to the C drive, then type in C:
and hit the &gt;Enter&lt; key.
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The following screen makes it more clear. A:\&lt;C: &gt;Enter&lt; C\6lt, _REBOOTINGTHECOMPUTER
Sometimes, it may happen that your system crashes down because of any reason. In such a situation, hit &gt; Alt + Shift
+ Del &lt; Keys together. This will restart your computer. This process is called Warm Boot or Reset. This will again get
things going. But it is advisible to use it as a last alternative when all other efforts of resuming work fail. At times, Warm
Boot also fails to restart the computer. This means the instructions that are given by the keyboard are no longer valid and
are not interpreted by the system. In this case, switch off the power supply and wait for a few minutes.Then turn on the
power supply and start working. Sometimes, due to unknown reasons the system is unable to boot from the hard disk, in
such a situation, you are required to boot the system from the bootable floppy (floppy that contains DOS). FILESAND
DIRECTORIESIN

DOS File is a collection of related information. Any kind of text, data or program that is entered is stored in a file. Now, it
is very essential to organize your files in an ordered manner. This makes file search easier. Otherwise, it can really be a
difficult and time consuming job to search for a particular file out of the whole lot of files stored on the disk. An example
of library can make the explanation of the concept more clear. As you must have already observed, the books in a library
are put in big cabinets. Each cabinet is divided into many shelves and sub-shelves. Each shelve or sub-shelve contains
books on a particular subject. So, the required book on a particular subject can be found out very easily without wasting
much time and effort. On similar grounds, all the files that are related to each other are clubbed at one place. This is
known as a Directory Structure or simply a Directory. A directory structure resembles an inverted tree. The main directory
becomes the Root directory. The directories and files become the branches of this directory tree. Any number of files
and directories can be added to it, thus, making the tree grow big downwards. Let us take an example.

101
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Suppose we wish to store two kinds of files on our disk: ACCOUNT and EXPENSE. Further, we wish to keep two more
kinds of files (say CASHSALE and CREDSALE) under ACCOUNT sub-directory. DOS can very much help you in organizing
your files through directory structure which is shown in Figure 5.1.

Figure 5.1 Directory Structure

Itis clear from Figure 5.1 that 1. On the top of the directory structure, there is a Root directory. This directory is always
present and is shown by \(backslash) for referencing. Any file or directory that is created is always under the Root
directory. 2. EXPENSE is the sub-directory of the Root directory. 3. ACCOUNT is the parent directory of the directories
CASHSALE and CREDSALE. It can also be said that the CASHSALE and CREDSALE are the sub-directories of the
ACCOUNT directory. Thus, a directory under a directory is called a sub- directory. It can be clearly seen that the files
relating to a particular subject can be put under a directory. For example, all the files relating to expenses can be put
under EXPENSE sub-directory whereas all the files relating to cash sales can be stored under the sub- directory
CASHSALE.

REFERENCINGFILES

It's time to learn as to how to locate a file. The directory structure shown in Figure 5.2 has two sub—directories under the
Root directory. The sub-directory EXPENSE has two files under it.

ROOT DIRECTORY EXPENSE DIRECTORY ACCOUNT DIRECTORY CASHSALE DIRECTORY CREDSALE DIRECTORY

102 Basic Computer Skills ROOT ACCOUNT EXPENSE EAST.TXT WEST.TXT Figure 5.2 Referencing Files

DOS allows you to go from one directory to another by following a certain path. In the beginning, the user is always
resident in the Root directory. While travelling from one directory to another certain rules have to be followed. A user
cannot go directly from ACCOUNT sub-directory to EXPENSE sub-directory. To go from one sub-directory to another,
you have to first go to its parent directory or the Root directory. Thus, for going from ACCOUNT sub-directory to
EXPENSE

sub—directory, you first have to go to Root directory. Similarly for going from the file EAST.TXT to WEST.TXT, you have to
go to the EXPENSE sub-directory first. Thus, in other words, while moving from one directory to another, you have to go
to its parent directory first. Now, in order to reach out to the file WEST.TXT. the following path has to be followed:
C:\&lt;Expense\West.txt 1 34 5 2 Here, 1. is the drive name where the file is resident in; 2. is the path which DOS takes to
reach for a file; 3. is the directory under the Root; 4. is the primary name of the file that is to be accessed; and 5 . is the
extension name of the same file. The \ (backslash) has to be used for tracing out the path. The first backslash takes you to
the Root directory. The subsequent backslashes separate the directories, sub- directories and the filename that are given
in the whole path.

FILENAMINGCONVENTIONS

There are certain rules that have to be followed while giving names to your files. A filename has two parts:

103
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Primary Name 2. Extension (Secondary Name) A dot (.) separates a primary name from an extension. Let us see the two
parts of the file named DRAGON.TXT. DRAGON.TXT Primary Extension Name A primary name cannot have more than
eight characters and similarly an extension can contain only upto three characters. A filename having only the primary
name and no extension is absolutely valid because it is absolutely optional to give an extension to a filename. An
extension is generally given by the language or software used

by the file. For example, if you are entering BASIC and PASCAL programs, their filenames would have extension BAS and
PAS respectively. A filename can contain the following characters: 1. An Alphabet (A-Z) or (a-z) 2.
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A number (0-9) 3. Special characters such as S, #, &, @, |, %, (,), ~, {, }. ", A etc. except *, ?, fullstop (.) and space (). Itis a
good practice to give meaningful names to your files. However, no two files can have exactly the same name on the
disk. Thus, a name given to a file on a disk has to be unique. A look at a few valid and invalid filenames: VALID INVALID
MYHUNT MY BOOK.DOC DRAGON.TXT B.R.ARORA UPHILL.UP S?JAIN.BAS VIJAYA EXCELBOOKS EMPLOYEE.EMP
ANURAG*.* 157.IN VICKY.MEHTA The rules for naming a directory are the same as that of naming files.

DOSCOMMANDS
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DOS offers a variety of commands to perform various functions. With the help of DOS commands, you can display the
list of files and directories that are present on the disk, create new files and directories, remove unwanted files and
directories and much more. DOS commands can be entered either in uppercase or lowercase letters. The format of a
DOS command is called syntax. All DOS commands begin with command name. When DOS carries out the
instructions given by you, it is called the execution of DOS command. Let us discuss some of the DOS commands in
detail. 104

Basic Computer Skills (The commands which have to be typed
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are written as bold letters throughout this chapter) Directory Commands of DOS The directory commands help you to
create new directories and remove existing ones. They also allow you to travel from one directory to another. You can
also view the listing of files and directories that are present on the disk. Displaying a List of Files on the Disk — DIR
Command This particular DOS command helps you in displaying a list of files or directories present on

a
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disk. Thus, to see the contents of your hard disk, issue the following command: C:\&lt;DIR &gt;Enter&lt;

A sample output as shown in Figure 5.3 can be seen on the VDU: 1 2 3 4 5 Figure 5.3 Displaying the contents of hard disk
In Figure 5.3, each line has five columns which are summarised in Table 5.1. Table 5.1 Contents of the column shown in
the Directory Columns Contents 1 Primary name (eg. COMMAND) 2 Extension (eg. COM) 3 Size of each file in bytes 4
Date when the file was either created or modified last 5 Time when the file was either created or modified last. C:\&lt;DIR

Computer Fundamentals and PC Software (Block 1 ...
o,
95% MATCHING BLOCK 134/291 SA (D1489 17)

Volume in drive C has no label Volume Serial Number is 1421-15AB

MATCHING BLOCK 138/291 SA Fundamental of PC Software BLOCK 1.pdf (D164969260)

Volume in drive C has no label Volume Serial Number is 1421-15AB
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Volume in drive C has no label Volume Serial Number is 1421-15AB Directory of C:\

COMMAND COM 23641 02-01-98 12:12a DISKCOPY COM 4165 05-01-98 4:29a CHKDSK COM 9725 05-03-98 11:30a
TREE COM 2473 07-03-98 12:30p ACCOUNT &gt;DIR&t; 10-02-98 12:10a EXPENSE &gt;DIR&(t; 05-05-98 4:30a 4
file(s) 40,004 bytes 2 dir(s) 231000 bytes free

105 Introduction to DOS
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If you wish to view the contents of the floppy drive, then you
can follow any of the two approaches given below: Approach 1
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First switch yourself to the floppy drive and then issue the DIR command.

The currently active drive becomes A. C:\&lt;A: &gt;Enter&lt; A:\&lt;DIR &gt;Enter&lt; Approach 2 Alternatively, you may
issue the following command: C:\&lt;DIR A: &gt;Enter&lt; But in this case, the currently active drive remains C only but
the contents of the floppy disk are shown on the monitor. Figure 5.3 shows two sub-directories ACCOUNT and
EXPENSE. &gt;DIR&lt; signifies a directory. Now,
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if you wish to view the contents of the sub-directory EXPENSE, issue the following command: C:\&lt;DIR \EXPENSE
&gt Enter&lt;

This command shows you
the contents of the sub-directory EXPENSE which is resident under the Root directory.
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Let us assume that there is one more sub-directory by the name BUSINESS existing under EXPENSE. To view the
contents of this sub-directory, issue the following command: C:\&lt;DIR \EXPENSE\BUSINESS &gt;Enter&lt;

This command shows the contents of the sub-directory BUSINESS which is under EXPENSE.
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If you have a large number of files on the disk, then on issuing DIR command, the screen scrolls up and only a few
filenames are shown. In such a case, issue the following command: C:\&lt;DIR/P &gt;Enter&lt; This command will show
the contents of the disk pagewise.

Once the screen is full of file- names, the message 'Press any key to continue’ appears at the bottom of the screen and
the scrolling will stop. Hit any key on the keyboard. The next screen showing the remaining filenames is displayed. The

output of this command is exactly the same as that of DIR command. But
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if you are interested only in seeing the filenames, issue the following command: C:\&lt;DIR/W &gt;Enter&lt; This
command shows the names of files and directories widthwise. So, in one line only five names of files and directories
are shown. The other details like the size of file, the 106
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date and time of each file creation are not shown. The directories are shown in square ([ ]) brackets. Making a Directory
— MD Command In the earlier part of this chapter, we discussed that all the related files should be clubbed at one
place, called a directory or sub-directory. So, to club all the related files under one head, new directories and sub-
directories have to be created. Let us create a new sub-directory by the name INCOME under the Root directory. The
following command can achieve this: C:\&lt; MD INCOME &gt;Enter&lt; where MD stands for Make Directory Further,
let us create another sub-directory by the name HOSPITAL under the sub- directory INCOME. C:\&lt;MD
INCOME\HOSPITAL &gt;Enter&lt; Removing a Directory — RD Command With times, certain directories grow old and
are no more needed. It is better to delete such directories because they can save

you

L =
MATCHING BLOCK 143/291

many precious bytes on the disk. So, let us delete the sub-directory HOSPITAL with the following command: C:\&lt;RD
INCOME\HOSPITAL &gt;Enter&lt; where RD stands for Remove Directory A directory or a sub-directory has to be
essentially empty before removing it. For example, in order to remove the sub-directory HOSPITAL, there should not
be any directories and files under it. So, you must first delete all the files and remove all the sub-directories present
under the sub-directory HOSPITAL before removing it. We will discuss the method for deleting files

later. Changing Directories —
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CD Command Let us again refer to the Figure 5.1. Suppose you are under the EXPENSE sub-directory and you want to
access the files or directories in the ACCOUNT sub-directory. This would involve the changing of directory from
EXPENSE to ACCOUNT. This will make the ACCOUNT directory active. The task of changing directories can be
accomplished with the help of CD command. Look at the following example: C:\&lt;CD ACCOUNT &gt;Enter&lt;
where CD stands for Change Directory The above command will take you to the sub-directory ACCOUNT as shown by
following prompt: CAACCOUNT&Lt;_ 107
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If you want to go to the sub-directory CASHSALE straight from the sub-directory EXPENSE, issue the following
command: C:\&lt;CD ACCOUNT\CASHSALE &gt;Enter&lt; After the above command, the following prompt will come:
C:\ACCOUNT\CASHSALE&Lt;_ The command for going to the root directory from the above prompt is:
C:\ACCOUNT\CASHSALEG&(t;CD\ &gt;Enter&lt; But, the command for going to the parent or previous directory
(whether it is root or sub-directory) is: C:AACCOUNT\CASHSALE&t;CD.. &gt;Enter&lt; If you are in the sub-directory
CASHSALE, the above command will take you to ACCOUNT sub-directory as shown below: C:\ACCOUNT&!t; _

The command for displaying the name of the currently active directory is: C:\&lt;CD &gt;Enter&lt;
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FILE COMMANDS OF DOS DOS offers a number of commands for performing various operations on your

files. The commonly used commands for copying, deleting and renaming the files are explained below: Cop ying Files —
The COPY Comm and
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At times, you may have to work on some other machine. So, this involves copying files from one disk to another.
Copying of files can happen from hard disk to floppy or vice- versa. Files can also be copied onto the same disk with a
different name. The COPY command helps us to accomplish all these tasks. The syntax of the copy command is:
COPY &gt;Source drive&lt;: (File spec 1) &gt;Target drive&lt;: (File spec 2) where, Source drive refers to the drive from
where the file has to be copied. It can be A, B or C. "File Spec 1' refers to the path from where the file that has to be
copied. Target drive’ refers to the drive where the file is going to be copied. ‘File Spec 2' refers to the destination where
the file is going to be copied. 108 Basic Computer Skills Copying a File to another Drive under the Same Name A file
can have the same name if it is stored on different disks. Thus, to copy a file by the name SCENE from hard disk to
floppy disk, issue the following command: C:\&lt; COPY C:SCENE A:SCENE &gt;Enter&lt; After the

execution of the above command the file SCENE stored at hard disk will be copied to the floppy disk. When the above
command is executed, DOS displays the message "1 File(s) copied' on the screen. However, if the file has to be
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copied from the active drive, then specifying the source drive can be very easily avoided. On similar grounds, if the
filename remains unchanged then there is no need

to
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specify it after the target drive. Thus, the above command can also be given in the following way: C:\&lt; COPY SCENE
A: &gt;Enter&lt; Copying a File to another Disk under a Different Name The name of the file can be changed very easily
while copying.

It can be extremely useful when you want to make changes to a particular file without losing the original file. In such a
case, you can make a copy of the file with a different name. This makes distinguishing between the two files easier.
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The following command copies the file SCENE from the hard disk onto floppy disk by the name SERENE. C:\&lt; COPY
SCENE A:SERENE &gt;Enter&lt;

Thus, we now have two copies of this particular file. The contents of both the files are exactly same. They differ only in
terms of name.

Copying a File with a New Name on the Same Disk The file can be copied with a different name on the same disk.
Proceeding with the above example, let us save the file SCENE with a new name, SERENE and copy it onto the same disk.
C:\&lt; COPY SCENE SERENE &gt;Enter&lt; Once this command is executed, we have the same file under two different
names, stored on the same disk. Copying Files from one Directory to Another Suppose you have placed all your files
under the root directory. Now, at

a

later point of time, you wish to club all the related files at one place. This can be done

very

easily. Create a directory and copy the required files from the root directory to this newly created directory. DOS allows
you to copy files from one directory to another.

109
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to DOS Let us assume that you have a file by the name NORTH.TXT in the root directory and you wish to copy this file in
the newly created AREA sub-directory. The following command will do this: C:\&lt; COPY NORTH.TXT \AREA
&gt;Enter&lt; Similarly, you can copy files from any directory to any other directory. DOS only needs the specification of
full path from you. Let us copy a file OLD.TXT which exists under the sub-directory DATA to the sub-directory INFO
which is resident in the floppy disk. C:\&lt; COPY DATA\OLD.TXT A:\INFO &gt;Enter&lt; Deleting Files—-DEL Command
With time, certain files grow old which are no longer required. So, it is desirable to delete such files because unwanted
files occupy precious space on the disk. Suppose there is a file on the hard disk by the name IMT.PRG which is no longer
required. The following command deletes this file: C:\&lt;DEL

IMT.PRG &gt;Enter&lt; Once the above command is executed, DOS does not display any message on the screen.
However, if the file IMT.PRG exists on the floppy disk then, you may issue the following command to delete it: C:\&lt;DEL
A:IMT.PRG &gt;Enter&lt; However, it is advised that

first you go to the A: prompt and then delete the file as shown below: C:\&lt;A: &gt;Enter&lt; A:\&lt;DEL

IMT.PRG &gt;Enter&lt; The above method will help you to avoid accidental deletion of file IMT.PRG from the hard disk.
While deleting any file of a sub-directory, its full path can also be given as illustrated below: Let us assume that the
IMT.PRG file exists under a sub-directory MANAGE on the hard disk. Issue one of the following commands: C:\&lt;DEL
CAMANAGE\IMT.PRG &gt;Enter&lt; OR C:\&lt;DEL MANAGE\IMT.PRG &gt;Enter&lt; You can also delete the IMT.PRG file
by first changing to that sub-directory and then issuing the DEL command as shown below: C:\&lt; CD\MANAGE
&at;Enter&lt; C:A\AMANAGEGS(t; DEL IMT.PRG &gt;Enter&lt;
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Renaming Files — REN Command DOS allows you to give new names to your files.

Sometimes, you may find that the old names given to the files are no more appropriate. In such a case you can rename
your files with the help of REN command.

Assume that there is a file by the name OLD.TXT and now you wish to give a new name NEW.TXT to it. Carry out the
following command to get your work done. C:\&lt;REN OLD.TXT NEW.TXT &gt;Enter&lt;

Here, only the name of the file has changed. The contents of the file are same. Again, you can specify the full path to
rename your files.

C:\&lt;REN DATA\OLD.TXT NEW.TXT &gt;Enter&lt; The file OLD.TXT which resides under the sub-directory Data now has
a new name NEW.TXT.

WILDCARDS

Often you may need to do a similar kind of job on a number of files. If these files have something in common, then we
can save the effort of performing repetitive job. So, these files can be referred collectively by using the wildcard facility
provided by DOS. The use of wildcards in a DOS command gives greater flexibility when using similar type of filenames.
DOS offers two wildcards — ? and *. Each ? can be replaced by exactly one character or none, if it is given at the end of
the filename. As and when the ? wildcard is specified in the middle of a filename, it has to necessarily match one
character. The * wildcard can match eight or less characters in the primary name and three or less characters in the
extension part. Let us take an example to make the concept of wildcards clear. Suppose the following files are present on
your disk: OLD.TXT INCOME.PRO

OVER.PRG ANNUAL.DOC NEW.DOC ZEE.COM OLD.DOC PAPER.COM

SWEETY PAGE.IN GO.EXE OLD1 DRAGON.EXE KOMAL EXPENSE.PRG. OLD20.BAS

The following commands illustrate the concept of wildcards: i. If you wish to see all the files that start with the letter O
and any extension, then give
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the following command: C:\&lt;DIR O *.* ggt;Enter&lt; The above command will list the

following files:

111 Introduction to DOS

OLD.TXT OLD1 OVER.PRG OLD20 OLD.DOC ii. Now, let us copy all the files with any number of characters in the primary
name and the extension EXE with the following command. C:\&lt; COPY * EXE A: &gt;Enter&lt; The above command will
copy the files GO.EXE and DRAGON.EXE onto the floppy disk. iii. To delete all the files beginning with OL, having two
more characters in the primary name and any extension, issue the following command. C:\&lt;DEL OL??.* &gt;Enter&lt;
With this command, the files OLD.TXT, OLD.DOC and

OLD1
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are going to be deleted because these are the only files present on the disk which match the given wildcard pattern.
However, the above command will not delete the files OVER.PRG and OLD20 because the former does not start with OL
and the latter has a primary name

of 5 characters.

iv. Similarly, to copy all files starting with P and an extension comprising of two characters ending with N issue the
following command: C:\&lt;DEL P*.?N &gt;Enter&lt; This will delete the file PAGE.IN because this is the only file matching
the given wildcard pattern. v. For copying all the files having primary name OLD and any extension from floppy to
EXPENSE sub-directory of hard disk, issue the following command: A:\&lt; COPY OLD.* C:\EXPENSE &gt;Enter&lt; The
above command will copy only two files — OLD.DOC and OLD.TXT. vi. To copy all the files with any primary name and no
extension from EXPENSE sub- directory of
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hard disk to floppy, issue the following command: C:\&lt; COPY \EXPENSE\*. A: &gt;Enter&lt; The

above command will copy the files SWEETY, OLD1 and KOMAL. vii. To delete all the files of floppy, issue the following
command: A:\&lt;DEL ** &gt;Enter&lt; After
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giving the above command, the following message will come on the screen: Are you Sure (Y/N)?_ Press "Y' if you really
want to delete all files otherwise press any key. Never try the above command on root directory of hard disk, otherwise
your most important DOS file COMMAND.COM will also be deleted and thereafter you will not be able to boot the 112

Basic Computer Skills system from the hard disk. Therefore, the use of wildcards with DEL command has to be made
with great caution. Some More DOS Commands You have already been introduced with
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the directory and file commands of DOS. Now, let us make ourselves familiar with other commonly used commands.
Displaying and/or Changing the

Currrent date—The DATE command In the earlier part of the lesson, we have seen the queries to enter or change date
and time displayed on screen at the time of booting. You can also enter new date with the help of DATE command as
shown below:
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C:\&lt;DATE &gt;Enter&lt; After issuing the above command the following screen appears: C:\&lt;DATE Current date is
Thu 11-12-98 Enter new date (mm-dd-yy):_ So, key in the new date in 'month-date-year' format. However if you do
not want to change this date simply hit the &gt;Enter&lt; key. The current date will be taken as new date.

A new date can also be given by the following command: C:\&lt;DATE 06-26-98 The above command will not show the
prompt ‘Enter new date’ on the screen.
Displaying
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and/or Changing the Current Time — The Time Command The TIME command is used to display and change the
current time. C:\&lt; TIME &gt;Enter&lt; On issuing this command, the following screen appears: C:\&lt; TIME
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Current time is 11:05:10:01 Enter new time:_ Enter the new time in hours: minutes: seconds format. Hit the
&at;Enter&lt; key if you do not want to change the time. The new time can also be specified along with TIME
command. C:\&lt;

TIME 11:40 &gt;Enter&lt; So, the prompt 'Enter New Time' will not appear on the screen with above command.
113 Introduction to DOS
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Clearing Screen — The CLS Command In order to clear the cluttered and clumsy screen, issue the CLS command. This
will remove the contents shown on your screen thus making it look neater and cleaner. The CLS command is given in
the following manner. C:\&lt;CLS &gt;Enter&lt; Creation
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l |
=

a New File — The COPY CON Command Text Files can be created

with the help of
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COPY CON command. Look at the following example: C:\&lt; COPY CON HELLO.TXT &gt;Enter&lt; This command tells
DOS to copy the information from the keyboard or console and put it in the file HELLO.TXT. On issuing the command
the following screen appears: C:\&lt; COPY CON HELLO.TXT _ You will find a blinking cursor in the second line. Enter
the text and terminate each line by pressing &gt;Enter&lt; key as illustrated below: My first DOS file. The name given to
this file is Hello. Txt. &gt;Enter&lt; It is very easy to create files in DOS. &gt;Enter&lt; Once all the required text is entered,
hit the &gt;Ctrl+Z&lt; keys together to mark the end of text. &gt;Ctrl+Z&lt; keys tell DOS that no more text is going to
be entered now. Again hit the &gt;Enter&lt; key.

Now, the following screen will be displayed: AZ 1 files(s) copied C:\&lt;_
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Displaying Contents of Files — The TYPE Command The contents of any file can be viewed very easily by giving the
TYPE command followed by the filename. Let us see the contents of file HELLO.TXT that we have just created by
issuing the following command. C:\&lt; TYPE HELLO.TXT &gt;Enter&lt;

It will produce the following screen:
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My first DOS file. The name given to this file is Hello.Txt. It is very easy to create files in DOS.

C:\&lt;_

114 Basic Computer Skills However, if the file is very big, then it scrolls upward and only the last page of the file is seen on
the screen. The DOS prompt is again shown. You can see the contents of the file pagewise by prexssing &gt; Ctrl+S&lt;
keys together. Hit any key to see the next page.
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You can also send the output of a file to the printer. The following command starts the printing job, provided the
printer is on. C:\&lt; TYPE HELLO.TXT &lt;PRN &gt;Enter&lt;

In case the printer is not ready, the following message will come: Write fault error, writing device PRN Abort, Retry,
Ignore, Fail? Set the printer ready and press R’ to retry otherwise press 'A’' to cancel the command. Dis p lay inga Me s
sageontheScreen-TheECHO Command
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At times you may require to display a text on the screen while executing a set of commands. The ECHO command
helps you to display a meaningful message on the screen. This command is issued as illustrated below: C:\&lt; ECHO
Please insert floppy in drive A: &gt;Enter&lt; The ECHO command is a special DOS command used exclusively in batch
files (files containing a set of DOS commands)

which are discussed in later part of the chapter.
100% MATCHING BLOCK 166/291 w

There is one more form of ECHO command i.e. ECHO OFF as shown below: C:\&lt; ECHO OFF &gt;Enter&lt; The
above command tells DOS not to display other commands in the batch file.

Itis also used in batch files. DisplayingtheCurrentlyloggedSub-directory—-The PROMPT Comm
and
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Users always prefer to see the prompt for currently logged sub-directory. The PROMPT command tells DOS to include
the sub-directory, greater than (&lt;) sign, date, time or any text as a part of the prompt. The various forms of PROMPT
command are discussed below: i. To display the path designation (e.g. \ACCOUNT\EXPENSE) and the greater than sign
as a DOS prompt, issue the following command: C:\&lt; PROMPT SpSg &gt Enter&lt; After giving the above command,
if you are logged to EXPENSE sub-directory of ACCOUNT sub-directory in the root directory, then the following
prompt will come on the screen: C:\ACCOUNT\EXPENSE&t;_ 115 Introduction to

DOS ii. To display a text “Welcome to IMT'
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along with path designation and greater than prompt, issue the following command: C:\&lt;PROMPT Welcome to IMT
SpSg &gt Enter&lt; The above command will display the following prompt: Welcome to IMT C:\&lt;_ iii. To display

date and time along with the C:\&lt;,
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issue the following command: C:\&lt; PROMPT $d St SpSg &gt;Enter&lt; The above command will display the following
prompt: SUN 11-15-1998 13:21:23.36 C:\&lt;_ iv. To display just greater than sign without path designation, you can
give the following command: C:\&lt;PROMPT &gt;Enter&lt; The command will display the following prompt: C&lt;_
Specifying a Sub-directory PATH — The PATH

Command
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By this time, you must be familiar with the directory structure of DOS. Suppose your program (say PRINCE.COM file)
lies

in
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the GAME sub-directory of the root directory and you want to execute it from any other sub-directory (say
WINDOWS). To execute PRINCE.COM file, first you will have to make GAME as the currently active sub- directory and
then issue the following command: C:\GAMEG&It;PRINCE &gt;Enter&lt; DOS provides a shortcut way to locate and run
the above program from any other sub— directory by specifying the path as illustrated below: C:\WINDOWS&lt; PATH
C:\GAME &gt;Enter&lt; The above command tells DOS that GAME sub-directory is in the current search path of DOS.
DOS will first search the required program file in the currently logged drive and then GAME sub-directory. Thus, the
PRINCE.COM file can be executed directly from WINDOWS or any sub-directory as shown below:
CAWINDOWSHLt;PRINCE &gt;Enter&lt; The PATH command is generally used in batch files

as discussed in later part of this chapter, INTERNALANDEXTERNALCOMMANDS
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All DOS commands can be classified into two categories: Internal Commands and External Commands. 116

Basic Computer SkillsInternalCommands

100% MATCHING BLOCK 173/291 W

The commands which are a part of the main files of DOS (i.e. COMMAND.COM and two hidden files) are known as
Internal Commands. They are loaded in the RAM as soon as the computer is switched on. The important internal
commands are DIR, COPY, DEL, REN, MD, CD, RD, TYPE, COPY CON, DATE, TIME, CLS, ECHO, PROMPT and PATH. We
have already discussed all these commands quite in detail. These commands are very frequently used.

ExternalCommands
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External commands are those commands which are stored on disks as separate program files. These files have the
same primary name as the command name. The extension of these files is either COM or EXE. So, at the time of
execution of these commands, the corresponding program file should be present in the DOS sub-directory of the
harddisk and DOS sub-directory should also be in the path search. The commonly used external commands are—
FORMAT, DISKCOPY, CHKDSK, XCOPY and LABEL. Let us learn about these commands.

Making the Disk Usable-The

FORMAT

Command Before discussing the format command in detail, let us first see what is meant by the term 'Formatting’.
Generally when you purchase a diskette from the market, it is unformatted. It can be compared with a notebook which
has blank pages without any ruler lines. You would prefer to put lines, write page numbers and categorise the pages into
equal parts so that an index can be made and the required topic can be searched very easily. Similarly, DOS organises the
disk into concentric circles which are called tracks. Tracks are further divided into triangular regions. Each such region is
called a sector. The organisation of disk into tracks and sectors is called Formatting. The Figure 5.4 makes the formatting
concept more clear.

Figure 5.4 Process of Formatting

FORMAT command is used for formatting a hard disk or floppy disk. As FORMAT is an external command, a file by the
name FORMAT.COM should be present on your disk. In order to format the floppy disk, issue the following command:
Formating done by DOS Unformatted Disk Formatted Disk Sector Track
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C:\&lt; FORMAT A: &gt;Enter&lt; Once the above command is executed, the following screen appears:

C:\&lt;FORMAT A:

Insert new diskette in drive A: and strike ENTER when ready

At this point of time DOS wants you to

insert a floppy disk in drive A and hit the &gt;Enter&lt; key. When the formatting of the disk is done, the following
message appears on the screen. Enter Volume Label (upto 11 characters):_ Here, you can give a name to the disk for its
easy identificaton. A label

of

upto 11 characters can be given to the disk after it is formatted. If you don't want that your disk should carry any label,
simply press &gt;Enter&lt; key

without typing anything.

Now, the following message will come: Format Another (Y/N)?_ Now, if you want to format another disk, then hit 'Y" (for
Yes) and insert that disk in the drive.

However, if you do not want to format another disk,

type in 'N' (for No) or press any key to end the format program. New disks should always be formatted for using them.
But old disks can also be formatted. Formatting will make the disk blank by erasing all its data. You may require to format
an old disk if it has bad sectors and is needed again for usage. However, the FORMAT command should be used with
extreme caution. Any disk whether hard disk or floppy disk will lose all data stored on it once the formatting operation is
done. Therefore, you should not try the FORMAT command for formatting the hard disk. If you format the hard disk, all
the contents stored on it are going to be removed permanently and new tracks and sectors will be created. FORMAT
command also provides a method for making your disk bootable. The following command is used for this purpose:
C:\&lt;FORMAT A:/S &gt;Enter&lt; With the help of above command, all the operating system files (COMMAND.COM and
two hidden files) are copied from the hard disk to the floppy disk. This floppy can now be used to load DOS in the
computer's memory if you are unable to boot the system from the hard disk. The COPY command cannot serve the
above purpose because it can not copy the two hidden files of DOS in the boot sector. Checking a Disk — The CHKDSK
Command

If a disk is not used properly, then certain sectors of the disk can get corrupted or damaged.

The command CHKDSK helps to check the status of the disk. After checking the disk, CHKDSK displays several items of
information. However to get executed, this command needs the program file CHKDSK.COM. Let's check the status of the
disk in drive A through the

in following command. C:\&lt;CHKDSK A: &gt;Enter&lt;
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On successfully checking the disk, the following status is shown in Figure 5.5. Figure 5.5 If no drive letter is specified with
CHKDSK command, then the currently active drive is checked for. Giving volume Label to disk — The LABEL Command
Although you have seen that a volume label to the disk is given at the time of formatting the disk. DOS also provides
LABEL command to change, delete or give new label

to the disk.

This command needs a program file LABEL.COM. Let us give a label to the floppy disk by the following command:
C:\&lt;LABEL A: &gt;Enter&lt; Once the above command is executed the following screen appears: Volume in drive A has
no label Volume label (11 characters, ENTER for none) _ So hit the &gt;Enter&lt; key if you want to delete the volume
label without typing in anything. You can also provide volume label directly with the following command. C:\&lt;LABEL
A:MANOJ &gt;Enterbilt;

A new label MANOJ is given to the floppy disk. Copying the

Contents of one Floppy Disk to another — The DISKCOPY Command The DISKCOPY command helps you to copy all the
contents of one disk onto the other in such a way that both disks become identical. It copies the contents of the floppy
disk present in source drive onto the disk present in the destination drive. If you have a single drive on your computer,
then the same drive can act as source as well as the destination drive. The command to copy the contents of one floppy
onto the other is given below: C:\&lt;DISKCOPY A: A: &gt;Enter&lt; When you issue the above command a screen like the
one shown below appears:

Volume SHEFALI created 12-11-1998 12:03a 1,457,664 bytes total disk space 2,560 bytes in 1 directories 747,520 bytes in
74 user files 707,584 bytes available on disk 512 bytes in each allocation unit 2,847 total allocation units on disk 1,382
available allocation units on disk 655,360 total bytes memory 562,048 bytes free
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At this point, insert the diskette whose contents are to be copied and then hit any key. Another message appears on the
screen as shown below: Insert TARGET diskette in drive A Press any key to continue So, after this message appears,
insert the diskette into which the files are to be copied. Thereafter, press any key to continue the process. Once the
process of copying is completed, the following screen appears: Copy Complete Copy Another (Y/N)?_ Press the "Y' (for
Yes) key if you want to copy the contents of some other diskette. DOS will again prompt you to enter the source
diskette. However, if you want to stop the DISKCOPY process, press ‘N’ (for No). DISKCOPY command first formats the
target diskette if it is unformatted and then copies files onto it. So, if any contents exist on the target diskette, they are
all going to be removed. The DISKCOPY command

only works with floppy disk and not with hard disks and both floppies should also be of same capacity (ie. 1.44 MB or 1.2
MB). The
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DISKCOPY command needs the program file DISKCOPY.COM for execution. Copying Files and Directories — THE
XCOPY
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XCOPY Command The XCOPY command is used to copy the files present in sub-directories. The command 'COPY *.*'
copies the files of the currently working directory and DISKCOPY command copies the entire contents from one
floppy to another. So, they are not helpful in copying files selectively. The XCOPY command offers three special
advantages: a. It prompts you to specify the files that you want to copy. b. It can also copy directories and other lower
level directories. c. It can be used to copy files from the hard disk to the floppy disk. Now, let us explore the XCOPY
command. If you wish that DOS should ask for your confirmation for copying a file, then use the /P option along with
the XCOPY command. Consider the following example: C:\&lt; XCOPY C:ACCOUNT A:ACCOUNT /P &ggt;Enter&lt; If
you want to copy the directories and lower level directories, then use the /S option alongwith the XCOPY command.
Look at the following example: C:\&lt; XCOPY C: ACCOUNT A:ACCOUNT /S &gt;Enter&lt; This command will copy the
directory and all the sub-directories onto the A disk. However, if the /S option is not specified, then the XCOPY
command works within the single directory. You can also use /P and /S option simultaneously with the XCOPY
command as shown below: 120
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C:\&lt;XCOPY C:ACCOUNT A:ACCOUNT /P/S &gt;Enter&lt; The whole path can be specified with the XCOPY
command. This command again needs the program file XCOPY.EXE in order to get executed.

BATCHFILES
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Very often, you keep keying in the same sequence of commands to do a repetitive job. For example, everyday, when
you start your work on the computer, you first see the listing of files present on the hard disk. Then, you copy all the
files with extension EXE and TXT from the floppy disk to hard disk. Thus, for achieveing your task, you have to issue the
following commands everyday. C:\&lt;DIR/P &gt;Enter&lt; C:\&lt; COPY A: *.EXE C: &gt;Enter&lt; C:\&lt; COPY A: *TXT
C: &gt;Enter&lt; DOS can really simplify your task. All the sequence of commands can be put in a file which is called a
batch file. This file offers a great advantage. Any number of commands given in a batch file can be executed by just
giving a single command at the DOS prompt. DOS executes all these commands one by one.

It appears as if all these commands were written individually and executed from the DOS prompt.
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All the batch files can have any primary name but the extension given to these kinds of files is BAT. The method of
creating a batch file is exactly similar to that of creating any other file on DOS. Let us see it through an example.
C:\&lt;COPY CON PREETILBAT &gt;Enter&lt; DIR/P &gt;Enter&lt; COPY A: *.EXE C: &gt;Enter&lt; COPY A: *TXT C:
&gt;Enter&lt; &gt,CTRL+Z&lt; &gt Enter&lt; In the above example, a batch file by the name PREETIL.BAT has been
created.

The contents of the file can be seen using the TYPE command. However,
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if you want to execute this file, simply type in the name of the file at the DOS prompt as shown below:
C:\&lt;PREETI.BAT ggt;Enter&lt; or C:\&lt;PREETI &gt;Enter&lt; The commands given in this batch file are going to be
executed one by one in the sequence specified. The AUTOEXEC.BAT F | L E The AUTOEXEC.BAT is an autoexecutable
batch file. It is a special kind of a batch file. This file is executed as soon as the operating system is loaded in the
computer's memory. The AUTOEXEC.BAT file is needed when you want it to be executed automatically each time the
system is switched on. Now, as soon as the computer is switched on, DOS searches for the AUTOEXEC.BAT file in the
root directory of the bootable disk. If the system finds this file, then all the commands given in it are executed 121
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one by one instantly without even asking for date and time. The AUTOEXEC.BAT file is created like any other batch file.
Look at the following example: A:\&lt; COPY CON AUTOEXEC.BAT &gt;Enter&lt; ECHO OFF &gt;Enter&lt; CLS

&gt Enterlt; ECHO My first Autoexec.bat file successfully executed &gt;Enter&lt; PROMPT SPSG &gt Enter&lt; PATH
C:ADOS;C:\WINDOWS &gt;Enter&lt; &gt;CTRL+Z&lt; &gt;Enter&lt; Enter the above commands on the root directory of
bootable floppy disk. Reset your system. You will notice the above created batch file being executed automatically.

SUMMARY DOS is the most commonly used single user operating system. It offers a platform on which different
application programs can be run. DOS basically acts as a translator and helps you to communicate with the hardware
and vice-versa. DOS offers a very powerful way of organising your files through the directory structure. The directory
structure makes the search of a particular file easy. Each file has two parts — the primary name and extension, which are
separated by dot. The primary name can have a maximum of eight characters whereas the extension cannot have more
than three characters. Before working on the computer system, DOS must be loaded in the computer's memory. When a
computer is switched on, DOS is first searched for on the floppy disk.
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If it is not present on the floppy disk, then DOS is searched for on the hard disk

and loaded in the memory. Once DOS is loaded in the computer's memory, a DOS prompt appears on the screen. DOS
offers a large number of directory and file commands. The two wildcards offered by DOS are — ? and *. The ? wildcard
can replace exactly one character or none.

The * wildcard can replace eight characters or less in the primary name and three or less characters in the extension.

A combination of ? and * wildcards can be safely used. DOS also offers the concept of batch processing. DOS
commands can be classified as internal and external. Internal commands are the commands which are an inherent copy
of DOS itself eg. DIR, COPY, DEL etc. External commands are the commands which need special program files for their
execution. A batch file contains a series of commands. All these commands are executed in the same sequence as
specified in the batch file. All the batch files have an extension BAT. These files are executed simply by typing in the name
of the batch file at the DOS prompt. The AUTOEXEC.BAT file gets executed as soon as the computer system is switched
on. Some DOS Commands and their Purposes DIR To see file listing continuously (i.e. without pagewise) DIR/P To see file
listing pagewise DIR/W To see file listing widthwise MD To make a sub-directroy
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122 Basic Computer Skills RD To remove a sub-directory CD\ To go to the root directory from any directory CD.. To
change to the parent or previous sub-directory CD\Directory name To change to a particular directory that is under the
root CD To see the name of the currently active directory COPY To copy file(s) REN To give a new name to a file DEL To
delete file(s) DATE To show or change the current date TIME To show or change the current time CLS To clear the screen
COPYCON To create a new text file TYPE To see the contents of a file ECHO To display a message on the screen PATH
To specify the DOS search path PROMPT To change the DOS prompt FORMAT To create tracks and sectors onto the disk
CHKDSK To check the status of the disk LABEL To give a label to a disk DISKCOPY To copy the contents of one floppy
disk onto the other XCOPY To copy the files and directories that are at lower levels EXE R C IS E Fill in the Blanks: a. The
fullformof DOSis __________ operating system. b. Text files can be created withthehelpof __________ command. c.
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commands can be classified into two categories: Internal and External

command. d.
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__________ command is used to copy the files present in sub-directories. 123

Introduction to DOS Unsolved Questions 1. What is an operating system? Why is DOS important for a computer system?
2. What is meant by the term Booting? Explain the whole booting process. 3. Explain the directory structure of DOS with
examples. 4. What is the difference between a file and a directory? 5. Explain the naming conventions used by DOS. 6.
What are wildcards? Explain by giving appropriate examples. 7. Differentiate between the internal and external
commands of DOS by giving suitable examples. 8. What is a batch file? What is the difference between a simple batch file
and an AUTOEXEC.BAT file? 9. Differentiate between the COPY, XCOPY and DISKCOPY commands with suitable
examples. 10. Write down the steps to create a batch file. Create a batch file with name MOHIT.BAT to do the following
steps: a To copy all the files from the floppy disk to hard disk. b To give a listing of all the files present on hard disk. ¢ To
delete all the files present on the floppy disk. 11. Which of the following are valid file names: a. % # S. ABC b. Letters.doc
c. COMPREHEND.A d. LYRICS.PATH e. 999.53 12. Write the commands— a. To create a directory LETTERS on the hard
disk. b. To create another directory by the name ZONE on the floppy disk. c. To go to the root directory. d. To display the
name of the currently active directory. e. To show the listing of files under the root directory (both pagewise as well as
widthwise).

124 Basic Computer Skills f. To remove all the files with any primary name and extension CAT. g. To create a directory
PLANNER and copy all the files from the root directory to this directory. h. To show all the files having an extension EXE?
i. To create a text file by the name MYFILE. j. To rename the file MYFILE as WONDER. k. To copy the file Wonder from the
root directory to the directory PLANNER. 13. Explain the importance of following commands with suitable examples: a.
CHKDSK b. DISKCOPY c. LABEL d. FORMAT e. XCOPY

Computer Viruses: Attacks, Prevention and Cure U N I T 6 In previous unit, we discussed the basic concepts of computer
and various commands of DOS. By this time, you must be familiar with how to operate a computer. While operating a
computer, you must have noticed that at times computers behave in an unexpected and strange manner. The files are
either get lost or corrupted. The computer displays unexpected information and strange messages. It is not able to boot
itself or gets hanged in between. Most of these problems may be due to viruses. What are viruses? How much can they
damage your data or software? How can you prevent your system from viruse attack? A lot of such queries come to the
mind of every computer user. In this unit, we will discuss about viruses in detail so that you get to know some important
concepts about viruses.

MATCHING BLOCK 186/291 w

LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Definition of a Virus ? Virus Characteristics ? What is Sinister about Viruses? ? Virus History ? How Viruses are Spread ?
Different Kinds of Viruses ? Damage Done by Viruses ? Virus Prevention ? Network and Viruses ? Network Protection ?
Anti-virus in the Future
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126 Basic Computer Skils DEFINITION O FAV IR U S Biologically, virus is defined as a link between living and non-
living organisms. Outside the body of host it behaves like a non-living organism but inside the body of the host it utilizes
the resources/machinery of the host and multiplies and behaves like a living entity. Generally viruses are pathogenic in
nature and they cause various diseases in plants and animals. But as far as computer related activities are concerned A
virus is a program that infects a computer, copies itself onto other programs in the system and may create a lot of
problems in the computer. In retrospect, it is unfortunate that the word 'Virus’ was used — it makes the problem sound a
lot worse than it is. A virus does nothing more than replicate in order to be a virus. Often, 95% of viruses do something
insignificant like beeping the keyboard or displaying an absurd message. However, if a program does something nasty
which you were not expecting it to do, it simply does not make it a virus unless it replicates. Such a program can also be
a ‘Trojan’. (Trojan is discussed in the subsequent part of the lesson) VIRUSCHARACTERISTICSA virus has one
or more of the following main characteristics: Fast Infection A fast infector spreads rapidly within a computer by infecting
everything that is accessed. A fast infector is not as bad as it sounds. It is just as easy to clean a computer with 1000
infected files as one with 10 provided you have an anti-virus program that does a good cleaning job. However, most
anti-virus products check memory for viruses. This is because of the possibility of a fast infector in memory. If there is a
fast infector in memory and all the files are opened up, you end up with every file infected on the computer. This doesn't
matter as long as you follow up by cleaning all those infected files with a good cleaner. SlowInfectionThe
objective of some viruses is to spread slowly. Since it is slow, it may take you a long time to detect and kill it. There are
various ways through which a slow infector works. The classic slow infector works by only infecting those files that you
intend to change. This means that if you are running a change detector as an anti-virus measure, the change detector
will trigger each time there is an infection. But since you had intended that the file should change anyway, you will tell
the change detector to accept the change. 'Starship’ is an example of using slow infection. Slow infection can also take
place in the following sequence: ? Virus only infects files as you copy them from your hard disk.

127 Computer Viruses: Attacks, Prevention and Cure ? So long as the file on the hard disk does not change, the change
detector is satisfied. ? When you copy an infected file to a floppy disk, the copy also gets infected. ? When you take this
infected floppy to another computer protected by the change detector, the change detector warns you of the existence
of the new file. ? You then reassure the change detector that you already know about the new file. ? The change
detector is satisfied and another system gets infected. S t e a [ t h Some viruses reside in the boot sector. When any
program tries to read the boot sector, the virus presents the information of that boot sector from where it is written. So,
you get unexpected information during booting of your system. This characteristic of virus is known as Stealth. It is much
more common to see stealth in boot sector viruses than in file viruses because it is much easier for the virus author to
implement stealth in a boot sector virus. Poly m o r p his m The commonest kind of ant-ivirus program that people
use is the virus-scanner, which looks for a repertoire of viruses. Therefore, for the virus authors, this is the kind of product
that they would like to defeat. A polymorphic virus is one where, if you take two instances of the virus, there are no
common bytes between them. So, you cannot write down a byte-sequence that can detect this virus. You have to do
something is a lot more complex and difficult WHATISSINISTERABOUTVIRUSES? Although, a virus causes
no significant harm to your system except copying itself. You have genuine reasons for getting upset if you find that your
system has encountered a virus attack. Why? This is because you may come across situations like: ? If you run Windows
95 and you get a partition sector virus, then even if the virus does nothing, you'll lose 32 bit disk access. So, your
computer will run slower than it should. ? If you do not get rid of the virus, there is a strong likelihood that eventually you
will pass it on to a supplier or customer. This is enough to upset him. ? Many viruses that actually spread in the wild are
memory-resident. Therefore, there is a possibility of incompatibilities between the virus and other programs you run. For
example, a virus named ~Jerusalem' tries to use one of the resources that Novell NetWare uses. So, you cannot run both
Novell NetWare and Jerusalem on the same system.
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128 Basic Computer Skills ? Even though the virus has been analysed and documented, you might remain nervous that
the virus does more than that has been documented. In almost every case you would want to get rid of the virus.
Removing viruses from several floppies takes your valuable time. Each PC will take several minutes and each floppy will
take several seconds. It would be nice if you only had to worry about those PCs and floppy disks that are infected.
However, you do not know which ones of these are infected until you have done a virus-hunt on all floppies. Therefore,
you have to check all floppy disks, hard disks and other storage media to verify that all your softwares and data are
absolutely virus free. VIRU SH IS T O RY The history of computer virus can be traced back to the year 1986 when two
programmers from Pakistan, Basit and Amjad, were upset over the fact that they could not land up with a good job. They
realised that the boot sector of a floppy disk contained executable code and this code is run whenever they start the
computer with a disk in drive A:. They thought that they could replace this code with their own program so that the
program would become memory-resident. This program could copy itself on each floppy disk used on the same drive.
They called it a Virus. But it only infected 360 KB floppy disks. To be able to understand how different types of viruses
evolved, following is the brief description of each one of them: 1. ‘(c) Brain": In 1987, the students of the University of
Delaware realised that their computers had a virus when they started seeing the volume label ‘(c) Brain" on floppy disks.
That is all it did — copy itself and put a volume label on disks. This virus did no harm to data or softwares except just
putting a volume label on the floppy disk. 2. Charlie: In 1987, Franz Swoboda became aware that a virus was being spread
in a program called Charlie. He called it the Charlie virus. 3. Jerusalem: In Tel Aviv, Israel, another programmer was
testing his first virus called Suriv-01 (virus spelled backwards). It was a memory-resident virus which could infect any
COM file. His second virus was called Suriv-02 which could infect EXE files. His third attempt was called Suriv-03 which
could attack both COM and EXE files. His fourth effort escaped into the world and became known as the Jerusalem
virus. Every Friday 13th, instead of infecting files that are run, it deletes them. As this date is not common, the virus
remains pretty inconspicuous most of the time. It avoids infecting COMMAND.COM because in those days many people
believed that this was the file to watch. 4. Ping Pong: In Italy, at the University of Turin, a programmer wrote another boot
sector virus. It put a bouncing ball on the screen if the disk was accessed exactly after half an hour. It became famous by
the name Ping Pong. It is also known as Italian virus as well as Bouncing Ball. But this virus had a major limitation that it
could infect only 8088 or 8086 computers. This is because it uses an instruction

129 Computer Viruses: Attacks, Prevention and Cure that does not work on more advanced chips. Hence, this virus has
almost died out. 5. Datacrime: In March of 1989, a new virus was written in Holland. A Dutchman found a virus all over
his hard disk. When the virus was disassembled, it was found that on any day after October 12th, it would trigger a low-
level format of cylinder zero of the hard disk, which, on most hard disks would wipe out the File Allocation Table and
leave the user effectively without any data. As it was another non-memory resident virus, it was very unlikely to spread. 6.
Aids Information Disk: In 1989, about 20,000 copies of Aids Information Disk were mailed to users taken from mailing
lists. The disk came with installation instructions and a request for $189. When it was installed, it created hidden
directories and hidden files and edited the AUTOEXEC.BAT file so that one of these hidden files was run on each boot-
up. This counted up to 90 and when it reached that number of boots, the Trojan would trigger up. The Trojan encrypted
all the filenames of the infected hard disk and gave them the hidden attribute. It looked as if there was only one file on
the hard disk which was an invoice for $189 to be sent to Box 7, Panama. 7. Dark Avenger: The Dark Avenger viruses
introduced two new ideas. The first idea is the ‘fast infector’. If this virus is in memory, then simply opening a file for
reading, triggers the virus infection. Soon, the entire hard disk gets infected. The second idea is that of subtle damage.
Dark Avenger—1800 occasionally overwrites a sector on the hard disk. If this is not noticed for a period of time, the
corrupted files are backed up and when the backup is restored, the data is of no use. Dark Avenger targets backups, not
just data. 8. Whale: In the second half of 1990, a virus called Whale appeared. Whale was a very large and complex virus.
Generally, it crashed the computer when you tried to run it. It was an exercise in complexity and confusion. It arrived in
the virus researcher’s hands like a crossword puzzle to be solved. 9. Vaporware: It was also in 1991 that Dark Avenger
announced the first virus 'vaporware’. He threatened a virus that had 4,000,000,000 different forms. In January 1992, this
virus appeared but it was not a virus. January 1992 saw the Self- Mutating Engine (MtE) from Dark Avenger. 10. Starship:
Another virus that came out at about that time was Starship. Starship is a fully polymorphic virus with a few neat anti-
debugging tricks and it also aims to defeat checksummers with a very simple trick. 11. Michelangelo: Probably the
greatest event of 1992 was the Michelangelo scare. One of the American anti-virus vendors forecast that five million
computers would go down on March the 6th. Many PC users went into a purchasing frenzy as the media whipped up the
hype. On March the 6th, only 5,000 to 10,000 computers went down and naturally the US vendors who had been hyping
the problem put this down to their timely and accurate warning. It will probably never be known
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130 Basic Computer Skills how many people had Michelangelo but certainly in the days leading up to March 6th, many
computers were checked for viruses. 12. GIRAFE: In early1993, a new virus writing group appeared in Holland called
Trident. The main Trident author, Masud Khafir, wrote a polymorphic engine called the Trident Polymorphic Engine (TPE).
He released a virus that was called GIRAFE. This was followed by updated versions of TPE. The TPE virus is much more
difficult to detect. 13. NATAS: (Satan spelled backwards) is the most successful American virus ever released. It appeared
on bulletin boards in early 1994 and is rampant worldwide particularly in Mexico. It is extremely polymorphic and also
multipartite which means that in addition to infecting files, it also infects boot sectors of floppy disks and partition sectors
of hard disks. A user who fails to clear up all three infections finds that they keep coming back. This factor and the fact
that second rate products fail to detect all instances make the virus spread more quickly. It was written in
Czechoslovakia. This virus ranks as the most difficult for anti-virus vendors to handle. 14. ONE HALF: It infects the
partition sector of the hard disks in addition to files. It has another nasty habit. Every time the user boots from the
infected hard disk, the virus encrypts cylinders of the hard disk, starting one cylinder from the end and working
backwards. It keeps a record of the last lowest cylinder that it encrypted in the infected partition sector. When it has
encrypted half of them, it displays the message ‘is one half, which gives it the name 'ONE HALF' virus. If the user cleans
up the partition sector without first copying the files to an external device, the data on the encrypted cylinders are lost.
15. Macro Virus: August 1995 saw a significant new development, the first macro virus. It infects Word for Windows
documents (*.DOC) and the NORMAL.DOT template. When an infected document is opened under Word for Windows
for the first time, the virus gets control as an AutoOpen macro and infects the NORMAL.DOT template or any other
template. A Word for Windows message box with the text 1, appears on the screen. After this, every document saved
using the File\SaveAs' command is infected with the virus. The glut has continued in the year 1997 and 1998 and there
are more than 16,000 viruses and variants. Some of the interesting viruses are: Oprah Winfrey virus : 200 MB hard disk
will shrink to 80 MB and then slowly expands back to 200 MB. Right to life : Won't allow you to delete a file. Adam and
Eve : Takes a couple of Bytes out of your apple. Michael Jackson : Hard to identify because it constantly changes its
appearance.

131 Computer Viruses: Attacks, Prevention and Cure Airline Virus : You are in Dallas, your data is in Singapore. Elvis : Your
Computer gets fat, slow and lazy and then self— destructs. Star Track : Invades your system in places where no virus has
gone before. Health Care : Treats your system for a day, finds nothing wrong and sends you Bill for Rs. 8500/-. HO W V |
RUSESARESPREAD?Itseems to be a common belief that viruses are spread by games, shareware, Internet file
downloads or Bulletin Board Systems (BBSs). The truth is more intricate. A physical disk has to be involved in case of a
boot sector virus with or without any software on it. You cannot get a boot sector virus by using a BBS. The most likely
routes by which a virus gets into an organisation are engineers, parents, or colleagues: ? Hardware engineers use disks
on a large number of computers. This increases the chance of picking up an infected disk and spreading a virus. ? The
young children quite possibly swap software at school. The disks that they bring home might well be infected and if the
parent is taking disks to and from work, a virus could easily be taken to work. ? A boot sector virus could be on a data
disk obtained from a colleague. ? The commonest way for a macro virus to enter a company is as an attachment to e-
mail. Other ways of getting a virus include: ? Shrink-wrapped software — Some of the large companies have accidentally
shipped a virus in shrink-wrapped software. ? Purchased hardware — Most hardware comes with disks containing utilities
or drivers. ? Sales persons running Demonstrations — They could unwittingly install the virus they picked up, from the last
place they ran their demonstration ? Pirated Software — Commercial softwares are usually scanned for any viruses. On an
average pirated softwares can definitely containa virus. DIFFERENTKINDSOFVIRUSES To be able to analyse
and remove viruses from the computer system it is first important to know about different kinds of viruses. The various
kinds of viruses are—
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132 Basic Computer Skills 1. Macro viruses 2. Devolving viruses 3. Boot sector viruses 4. TSR file viruses 5. Non TSR file
viruses 6. Companion viruses 7. Overwriting viruses 8. Multipartite viruses We are now discussing about these viruses in
detail. Macro Viruses Macro viruses are the first viruses to infect data files rather than executable files. Macro viruses
infect files in the form of macro or OLE objects and are easier to write than ‘traditional’ file viruses because they were/are
mostly written in assembly codes. Today, many applications have macro languages and so, the problem is a growing
one. Macro viruses spread by people sending infected document files to each other, either on floppy disk or via the
internal LAN (often attached to e-mail) or via an external e-mail system such as Internet. Many applications provide the
functionality to create macros. A macro is a series of commands to perform some application-specific task. Macros are
designed to make life easier like automating a few everyday tasks. Macros can be saved as a series of keystrokes. The
application records what keys you press. They can also be written in special macro languages which are usually based on
real programming languages like C and BASIC. Modern applications combine both approaches. When the macro
language allows files to be modified, it becomes possible to create macros which copy themselves from one file to
another. Such self-replicating macros are called macro viruses. Most macro viruses are written for Microsoft's Word for
Windows and Excel for Windows. However, there are also macro viruses for Lotus AmiPro (e.g. APM/Greenstripe). D e v o
lvingVirusesSome viruses are badly written and ‘lose’ their own macros. The original virus may consist of the set
{AutoOpen, FileSave, and FileSaveAs}. If it replicates via AutoOpen, the complete macro set will be preserved. However, if
the user invokes File/SaveAs', the virus will fail to copy the FileSave macro. The resulting virus set {AutoOpen, FileSaveAs}
is known as a Devolved Macro and original virus is devolving.

133 Computer Viruses: Attacks, Prevention and Cure Bo ot Se c tor Viru s e s One of the most common kind of viruses
are boot sector viruses, for example, Form and Stoned. These viruses infect the floppy disks in either of the following
parts: ? Master Boot Record (MBR) ? Partition sector of the DOS Boot Record (DBR) ? DOS boot sector of hard disks. The
following example shows how a boot sector virus spreads. You have got a floppy disk with data on it, perhaps some page
maker file. This is part of a project that you are doing jointly with a classmate. What your classmate does not know is that
their computer is infected with a boot sector virus and so is the disk that has been sent to you. You put the disk in drive A:
and start using these files. So far, the virus has not done anything. But when you finish for the day, you switch off the
computer and go home. The next day, you come in and switch on. The floppy disk is still in drive A. So the computer tries
to boot up from there. It loads the first sector into memory and executes it. If it cannot find DOS on the disk, the
message that appears on the screen is: ‘Not a system disk, please press any key to continue’. So, you do as instructed.
However this disk is infected with a boot sector virus. So, what was executed was not just the program by Microsoft but
the virus as well. The virus installs itself on the hard disk, replacing the MBR and copying the original MBR to a location a
little further down the disk. When you start up from the hard disk, the MBR runs but this is the virus. The virus goes
memory—resident capturing the disk read/write interrupt 13h. It then loads the original MBR and the boot—up process
continues as normal. However, since the disk read/write interrupt is captured, every time you make any write or read
access to drive A:, the virus decides to write anyway. The floppy disk is examined and infects every disk put in drive A:.
Sooner or later one of these will be sent to another person and the cycle continues. The detail of various boot sector
viruses is different but the principle is the same. They are carried by the boot sectors of infected disks. A boot sector virus
cannot spread across a network. Thus, the only way to get infected is to try to boot from an infected disk even if the boot
fails. Boot sector viruses infect PCs. They do not care what operating system is running or what security software is
installed. The boot sector virus installs itself when the operating system or security program is not running. However,
with some non-DOS operating systems, although the PC is infected, the virus cannot copy itself on to subsequent disks
and cannot spread. It can, however, still do damage as was discovered by one surprised UNIX user when Michelangelo
went off on March 6th. To most people, the fact that viruses can infect in this way comes as a big surprise which partly
accounts for boot sector viruses being so common. Boot sector viruses work under DOS and Windows 3.x. Some work
under Windows 95 also but they do not work under Windows NT or OS/2 (including Warp).
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134 Basic Computer Skills TSR File Viruses A less popular kind of virus is the Terminate-and-Stay-Resident (TSR) file virus.
As the name suggests, this virus usually infects COM and EXE files. Although, over 99% of executable programs have the
extension COM or EXE. For a TSR virus to spread, someone has to run an infected program. The virus goes memory-
resident, typically looking at each program run thereafter and infects it if it is not already infected. Some viruses are called
fast infectors and they infect only if you open the file. For example, a backup might open every file on the drive. Dark
Avenger was the first fast infector. In case of the Green Caterpillar, the infection trigger is anything that determines what
files are present, for example, DIR. Non -TSRFile Virusesltis much easier to write a non-TSR virus. But it is quite
rare for such a virus to be encountered in the wild. There are less than 1% reported outbreaks of a non—TSR virus.
Running an infected program runs the virus which at that time looks for another file to infect and then infects it. Vienna is
the most common non-TSR virus. Vienna was the first file virus in the wild and is still reported occasionally. There are a
lot of viruses based on Vienna. CompanionVirusesThere are two types of companion viruses which are
discussed below: a. COM & EXE Companion If you have a COM file and an EXE file with the same filename, DOS runs the
COM file in preference to the EXE file. Companion viruses use this fact. Each EXE file that you have, acquires a
companion COM file with the same name. So, when you try to run your EXE program, the COM program is actually run
which is a virus. When the virus has finished doing what it wants do, it runs the EXE program. So, everything seems to
work normally. There have been a few successful companion viruses. The main advantage to the virus author is that
some change-detection software might not realise that a virus is spreading because the EXE file does not change. b. Path
Companion This sort of virus puts a program in a directory that is earlier in the DOS PATH. When you run a program that
is not in your current subdirectory, DOS searches for the program in various subdirectories as specified by the PATH
command in your AUTOEXEC.BAT file. Path companions are harder to write than ordinary companions. So, there are not
many of them.

135 Computer Viruses: Attacks, Prevention and Cure Overwriting Viruses An overwriting virus simply overwrites each file
it infects with itself. Once overwritten, the program does not function. It will become so glaringly apparent that
something is wrong, that either you will get rid of it or copy it again. This is the main reason that overwriting viruses
were/are never successful in spreading. Multipartite Viruses Some viruses infect multiple objects. When you run an EXE
infected with a multipartite virus, Tequila, it installs itself on the MBR. When you boot up the computer, Tequila runs from
the MBR and goes memory-resident. While Tequila is memory-resident, it infects EXE files. Other viruses like Anticad
infect COM, EXE and MBRs interchangeably. Some viruses infect COM, EXE, MBRs and device drivers. Multipartite viruses
are the third most common kind of viruses. There are some viruses that infect OBJ files. The Starship virus infects by
creating a new DOS Boot Record (DBR) leaving the code on the MBR intact. It changes the pointer in the MBR so that the
Starship DBR is executed before the original DBR. The Dir Byway virus infects file systems by changing the File Allocation
Table (FAT) and directories so that files on the hard disk are all cross—linked to the virus. DAMAGEDONEBYVIRU
S E S We can categorise the damage done by viruses into six groups according to the severity of the damage. Some
authors claim the possibility of a virus that actually does good but no one has yet demonstrated such a virus. We define
damage done by virus as the virus doing something different from what it should not do. The damage does not inlcude
the damage done during a mistaken attempt to get rid of the virus. For example, it is remarkable that a lot of people will
format the hard disk in an effort to repair the Stoned virus. All this will lose your data. The virus is untouched as it resides
in the MBR which is not touched by Format. The damage also does not include damage done by obscure
incompatibilities between the virus and the system. For example, if a computer that was originally set up under earlier
DOS version (but now you are running a later DOS version) is infected by Stoned, then a large number of files will be
corrupted because the design of the virus had not anticipated this situation. The major damages done by viruses are
discussed below: 1. Trivial Damage: This is the most insignificant damage done by a virus, for example Form. It will simply
make the speaker beep on the 18th of every month every time you press a key. All you need to do is to get rid of the
virus. This will usually take a few seconds or minutes per computer. 2. Minor Damage: A good example of minor damage
is the Jerusalem virus which deletes any program that you try to run after the virus has gone memory-resident on Friday
the 13th. At worst, you will have to reinstall some programs but repairing the damage is unlikely to take more than 30
minutes per computer.
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136 Basic Computer Skills 3. Moderate Damage: The most famous virus for moderate damage is Michelangelo. Moderate
damage is done when a virus formats the hard disk, scrambles the File Allocation Table (FAT) or overwrites the hard disk.
The damage is moderate only because you know that it has happened. You can reinstall DOS and reload yesterday's
backup. So, you will lose on average half a day’'s work, plus maybe an hour doing the reinstallation and restoration. 4.
Major Damage: Every 16th time a Dark Avenger infected file is run, it overwrites a random sector on the hard disk with
‘Eddie lives... somewhere’. Major damage is done when such a virus infects your backups as well as your hard disk. This
might go on for several weeks. When you find ‘Eddie lives’ at several places in several files, you discover Dark Avenger.
You might have to go back a few weeks before you can find clean data files. However, when you have restored a 6-week
old backup, you will find that you do not actually have any way to redo the work you have lost because you do not have
your original documents. 5. Severe Damage: When a virus (e.g. Dark Avenger) makes gradual, progressive changes so
much so that backups are also corrupted but the changes are not obvious. So, you end up simply not knowing whether
your data is correct or changed. 6. Unlimited Damage: Some viruses make an effort to get to the system manager
password and pass it to a third party. Cheeba virus creates a new user with maximum privilege, with a fixed user name
and password. The third party person who can log in to the system can do anything and in turn can then do unlimited
damage. VIRUSPREVENTIO N The question now arises how to prevent viruses from invading our computer
systems. A number of solutions have been proposed in the past. A few of these are Legislation, Awareness of Users, Use
of Anti-virus software, Use of Virtual device drivers, Use of Scanners and Checksummers. We are discussing a few of
these measures in detail. Legislation You should use only legal softwares in order to prevent your system from viruses.
The government must punish people who write virus programs. This will reduce the number of viruses written by various
authors. However, it cannot make an impact on the thousands of viruses that already exist and it only slows down slightly
the creation of new viruses. Awareness of Users Users do not regard computer problems as their own. They regard them
as the domain of the MIS department. Users are too busy doing their jobs. They do not pay the required attention looking
out for viruses in their computers. Users can be given precise procedures to check all incoming software and how to
acquire software. Procedures tell users how to obey the rules. The procedure for checking disks should be written down
in detail.
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a virus once in many years. Thus, after say six months of applying such procedures, they learn that when you go through
the procedures, you do not find any viruses. So the procedures fall into disuse. Procedures can be backed up with some
rules. A good set of rules might be as follows: ? Any incoming floppy disk must be virus-checked. ? If your anti-virus
software finds a virus, tell your PC Support department. ? If the rules are broken, users should be ‘punished’. Use of Anti-
virus Software Anti-virus software is the solution to many problems created by viruses. There are many kinds and brands
of anti-virus softwares available in market today. You should use a scanner on any incoming software. In practice, it
always does not happen. Users do not always consider the need of virus checking in many files. So, either you enforce
scanning or you try and create a situation where everything is virus checked automatically. Users do not always do as
you are told, but computers do. So, the best idea is you tell the computer to virus-check everything each time when it is
loaded. This means that your programs will be checked more often than necessary but that is irrelevant as compared to
the damage caused by virus attacks. Use of Virtual device drivers On a Windows 3.x or Windows 95 machine, you can
install an anti-virus Virtual device driver (VxD). A VxD is a 32—bit device driver which checks everything that arrives on the
computer, whether it is a floppy disk, running program or the accessed file. You no longer have to rely on the user
knowing what to do. The user interface is simple. The user has to do nothing. He just has to use his computer in the
normal manner. If the VxD alerts, then it has found a virus and an alert is displayed on the user’s screen. A network
message can be sent to the supervisor. On a Windows NT machine, you can install a File System Driver (FSD) which will
provide similar coverage. So, anyone having a problem with the concept of virus should install a VxD (or FSD) on their
computer and tell the network to update it regularly. This will strangle the virus to death. VxD will check all incoming files
no matter where they come from, for example, via the Internet, the parallel port or the floppy drive. Use of Scanners A
scanner is a program that knows how to find a particular repertoire of viruses. Scanners are updated quarterly or
monthly. For many users, quarterly upgrades are sufficient. But every now and then, a new virus can come out and
spread very fast, for example, Tequila or SMEG. In that case, you could be unable to detect this new virus for several
weeks depending on where you are in the update cycle. So you should subscribe to monthly upgrades to avoid this
situation.
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138 Basic Computer Skills VirusGuard (DOS) and WinGuard (Windows 3.x. Windows 95 and Windows NT) are on-access
scanners and work continuously. As soon as any disk is accessed, it is checked for boot sector viruses and as soon as any
file is used, it is checked for file viruses. Both programs may be optionally configured to check files as they are written
onto the hard disk. VirusGuard occupies approximately 9Kb of conventional DOS memory. VirusGuard is a DOS TSR
program. It does not have the full facilities of FindVirus. Specifically, it is not able to find macro viruses and a small
percentage of extremely polymorphic viruses. VirusGuard will find polymorphic viruses in memory only if an infected
program has been run. WinGuard, which is a Windows-specific program, uses zero conventional memory. Any additional
time-overhead involved in checking the disk or file is unlikely to be noticeable in most cases. WinGuard does not have
the constraints of a DOS TSR program. It has the same detection capability as FindVirus. ChecksummersA
checksummer is a change detector. Executable files should not change except for a good reason like updation of the
software. A checksummer aims to detect changes. The advantage of checksummers is that they do not detect a
repertoire of viruses. So, they do not need updating. The downside of checksummers is that they are more of a hassle
than scanners. Files change on your computer more often than you might have thought for good and valid reasons.
Moreover, they also do not detect all viruses. For example, checksummers do not detect slow viruses. They do not
detect all boot sector viruses (if the hard disk code is left unchanged) and they have problems with stealth viruses also. N
ETWORKSANDVIRUSE S Network whether it is a local area network or wide area network provides interesting
opportunities for viruses to spread to several computers or terminals. There is a common perception that once a virus
gets onto a network, it flashes round the whole network very quickly. The truth, of course, is more complex. Boot sector
viruses cannot travel across networks if several computers on a network are infected. This is because the boot sector
virus spreads via floppy disks in the usual way. An example of how a file virus spreads across a network is as follows: ?
User 1 gets his computer infected. The virus goes TSR, memory-resident. ? User 1 runs other programs on his hard disk
which also get infected. ? User 1 runs some programs on the network. They get infected. A network emulates a DOS
device. So, reading and writing to files on the server is done in exactly the same way as locally. The virus does not have to
behave any differently to infect files on the server.

139 Computer Viruses: Attacks, Prevention and Cure ? User 2 logs on to the server and runs an infected file. The virus is
now TSR in User 2's computer. ? User 2 runs several other programs on his local hard disk and on the server as well. Each
file becomes infected. ? User 3, User 4 and User 5 log on and run infected files. And so on. Macro viruses are especially
good at spreading on networks because people commonly share data across networks and e-mail documents to each
other. They may even share common templates NETWORKPROTECTIO N You should apply the following
procedures to protect your network from the attack of virus: ? You can make the directories in the hard disk of server as
read-only. However, some packages cannot be run from read-only sub-directories because they want to write to some
temporary or other setup files in the same directory. ? You can make programs execute-only. This means that although
the directory is read/write, the executables cannot be written, or even read. They can only be run. Some programs will
not run if they are execute only, because they have overlays that are added on to the end of the EXE file. So if the EXE file
cannot be read, the overlays cannot be loaded. ? You can make individual files read-only using the DOS attribute, and
then deny the user the 'modify attribute privilege' in that directory. Using a combination of these techniques, you should
be able to make a large percentage of the files on the server uninfectable. This stops viruses infecting most of the
executables on the server. However, the user has read/write access to the data (needed to do the job), and so the virus
also has read/write access to the data. So you cannot make the data files as read only. The only solution is to keep
viruses off the workstation. Things that are not Viruses Certain problems in the system may be misunderstood by you as
caused by viruses. However, those may not be viruses. The following are not viruses but something else: 1. Bugs 2. False
alarms 3. Jokes 4. Hoaxes 5. Trojans
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140 Basic Computer Skills 6. Corrupted programs 7. Intended viruses 8. Droppers Let us discuss about these things in
details. Bugs Bug is a persistent error in the software. All sufficiently complex softwares generally have bugs because
programmers may make mistakes during development of these softwares. As programmers are human beings, they have
pride and hence do not like to admit that they make mistakes, so they call them ‘bugs’. False Alarms A false alarm is
when you think you have a virus, but you are mistaken. The following things definitely indicate that the alarm (a warning
message on system) is false: ? Sometimes, you have some hardware or software fault, and after running some
diagnostics, you eliminate the possibility of hardware or software problems, conclude that it is therefore a virus, and
proceed on that assumption. ? More often, a false alarm is the result of running anti-virus software. Anti-virus software, in
common with other software, is not infallible. The two main mistakes that an anti-virus program can make are to fail to
find a virus that is there or to claim that a virus is present when there is not. That is called a false alarm. When an anti-
virus program gives a false alarm, it looks pretty much like the real thing. However, there are certain things that might
indicate that the alarm is false : ? Only one file is giving the alarm (or perhaps two files, but they are copies of the same
file). ? Only one product gives the alarm - other products say the system is clean. ? You get the alarm after running
multiple products, but not when cold-booting and running any one product. ? The virus that is detected is not listed as in
the wild ? The product says it cannot clean the virus. ? The product says the virus is in memory, but when you boot with
a clean disk, the product doesn't find a virus. Actually there is no fix rule that can be applied for knowing whether the
alarm is false or not. You cannot say it is a false alarm if one of the above is true. The only way to really check a false
alarm is to send the suspected files to the product vendor giving the alarm, and ask them to verify if it is a virus. You
might try deleting the offending file and re-installing the software that is causing the false alarm, but sometimes even
when you have finished doing that you might still get the false alarm.

141 Computer Viruses: Attacks, Prevention and Cure J o k e s A joke is something that is funny. However, what one
person finds funny is not the same as what another person finds funny — it depends on your sense of humor. A program
that pretends to format your hard disk, and then reveals that it has not — is that funny? It depends on your sense of
humor. Some virus authors love to play practical jokes. Jokes are not viruses. H o a x e s There are a number of common
hoaxes, which are widely believed. The most common of these are Good Times, Ghost, Free Money, Eyes, AOL4FREE,
Join the crew etc.. The Good Times hoax has been around for couple of years. It is usually in the form of a warning not
to read any e-mail with Good Times in the title. People pass along the warning because they are trying to be helpful, not
realising the damage that this does. Every now and then, there's a fresh spurt of Good Times warnings. Ghost is another
hoax, which has received excessive publicity online after being falsely accused of containing malicious code. Although
hoaxes are not viruses, the programs themselves could be infected in the future. The main way to deal with hoaxes is not
to pass on warnings unless they have come from a serious source. Tro ja n s A Trojan is a program that does something
more than you were expecting. This leads to a problem in detecting Trojans. The problem is to compare what the
program does with your expectations. You cannot determine a user's expectations of a program. Therefore, some
judgements have to be made. The Aids Information Disk is generally considered to be a Trojan. Approximately 20,000
copies of this were mailed to users in 1989, purporting to be a program that teaches you about AIDS. In fact, it was a
Trojan — after you re-boot your computer 90 times, it encrypts and hides all the filenames on your hard disk, and
demands that you pay for your license to use it. Although the documentation that came with it told you that something
bad was likely to happen, it is generally considered to be a Trojan. A recently appeared Trojan variation targets Internet
Service Providers (ISPs) and their users.There is a large family of Trojan programs, designed to steal the passwords of ISP
user accounts. The number of password stealing Trojans is growing quickly. Most do not cause damage to your data, but
send your confidential data or password to the author of the Trojan. Many of these Trojans are distributed as innocent
programs. Typically, they claim to be able to provide better access, or new services (for example, 'new magnificent
viewer’), games or images (for example, ‘run it - it's fun”) and so on. Some Trojans are embedded in DOC or RTF files and
when the user double-clicks on the file the Trojan is executed



Ouriginal

by Turnitin

142 Basic Computer Skills The best way to avoid Trojans is that you should not use programs from untrusted or unknown
sources. However, because of the Internet and the ease with which programs can be posted and distributed around the
world in minutes, these programs are rapidly becoming a severe menace. If a Trojan is detected, the file should be
deleted. Corrupted Programs Some files are simply corrupted perhaps by a hardware problem, and hang the computer
when run. For some reason, these sometimes end up in virus collections, unless the collection is carefully maintained. If
you look at the collections that can be found on most underground virus exchange sites, you'll find 20% or 30% garbage
files.IntendedVirusesSome virus authors are less capable than they would like to be, and write what is clearly
intended to be a virus, but for some reason there is such a major bug that the virus does not work at all. However, they
release these in the fond belief that no one will ever test them or perhaps they did not test them themselves. One typical
mistake is to get confused about decimal versus hexadecimal, and so their source code presumably says ‘int 21" for the
DOS function interrupt, but it should have said ‘int 21h' (which is 33 in decimal). D ro p p e r s A dropper is a program
which is not a virus but when it is run, it installs a virus into memory or onto the disk or a file. Droppers have been written
sometimes as a convenient carrier for a virus, and sometimes as an act of sabotage. The Future of Viruses It is very
difficult to predict about the future of viruses. In fact it is unwise to try and be too specific about what is likely to happen.
There will be more viruses — that is an easy prediction. How many more is difficult to predict. There were over 8,000
viruses by the middle of 1996 and 15,000 by the end of 1997. Nevertheless, it is impossible to make a broad assessment
of future virus developments. With over 15,000 known viruses in existence and over 300 new ones surfacing every three
months it is really an uphill task for a group of serious anti-virus researchers. Anti-virus in the Future The fundamental
truth about viruses is that they are people’'s problem. The people, who are potential victims of this phenomenon, should
acquire knowledge about viruses, which are a real threat to their computer systems. What is likely to happen in the
future? Well, the databases that scanners use will get larger. Each new virus needs to be detected, identified and
removed. Loading the databases will take longer, and some programs will have memory shortage problems. As Windows
95 and Windows NT

143 Computer Viruses: Attacks, Prevention and Cure become popular, users will be increasingly reluctant to run scanners
under DOS. But to run Windows, you have already run software on the hard disk, and if one of the things you have run is
infected by a virus, you have a virus in memory. If there is a virus in memory, you cannot trust what the computer is
saying - it could be a stealth virus. In other words. Windows will make anti-virus software less secure. The R&D effort to
keep scanners up-to-date will continue to increase. The virus problem will be with us for many years to come. SUM M A
RY Avirus is a program that copies itself onto other programs. Some viruses spread rapidly while others slowly within the
computer system. When viruses attack your computers, you get worked up because you would not only spend a lot of
time in removing the viruses but your important data may also be lost. The history of virus can be traced to the year 1986
when first virus was developed by two Pakistanis. After that many viruses viz. “(c)Brain’, Charlie, Jerusalem, Ping Pong,
Data Crime, Dark Avenger etc. have been evolved. The most likely routes by which a virus gets into an organisation are
hardware engineers, parents, children, friends and email. Viruses also spread by pirated and demonstration software.
There are many kinds of viruses viz. Macro viruses, Devolving viruses, Boot Sector viruses, TSR viruses, Non-TSR viruses,
Companion viruses, Overwriting viruses and Multipartite viruses. Viruses cause many damages to your systems or files,
which can be classified into Trivial, Minor, Moderate, Major, Severe and Unlimited damages, depending upon the severity
of the damage. Viruses can be prevented by Legislations, Awareness of users in understanding their duties, Use of Anti-
virus softwares/ Virtual Device Drivers/ Scanners and by installing Checksummers on your systems. Network provides the
best opportunities for viruses in spreading to several computers quickly. So, you should take special precautions to
protect your network against virus attacks. This battle between good (You) and evil (Virus) will go on. As always goodness
will stay for long, the life of evil is short. EXE R C IS E Fill in the Blanks: a. 'Starship’ is an exampleof __________
infection.b. _____ is known as Italion virus as well as BouncingBall. c. __________ viruses are the first to infect
data files rather than executive files.d. A __________ is @ program which is not a virus but when it is run it installs a virus
into memory or into a disk or a file.

144 Basic Computer Skills Unsolved Questions 1. What is a computer virus? How does it differ from a biological virus. 2.
Describe the main characteristics of a virus. 3. Although a virus may cause no harm to your system except copying itself,
people get so worked up when they have one. Why? 4. Who invented the first virus? Describe the history of viruses in
brief. 5. Write a short note on evolution of the following viruses: a. " (c) Brain' b. Jerusalem c. Ping Pong d. Data Crime e.
Dark Avenger e. Michelangelo 6. How do viruses spread? Discuss about the most likely routes by which a virus gets into
an organisation. 7. What are the different kinds of viruses? Explain with examples. 8. Write a short note on Boot Sector
viruses. Give some examples of these viruses. 9. How does a TSR file virus differ from a NonTSR file virus. 10. What are the
two types of Companion viruses? Discuss briefly. 11. Discuss about the severity of the damage caused by various viruses
with examples. 12. How can you prevent your system from virus attack? 13. What are Checksummers? How do they
differ from scanners? 14. How can you prevent your network from viruses? 15. Certain things are misunderstood by users
as viruses. What are these and why are they not viruses? 16. What do you think about the future of viruses? Discuss.
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Microsoft Word 2000 UNIT7STARTIN GO FMS-W O R D Microsoft word is a Windows based word processing
application. It can be started on a computer, where it is already installed as follows: ? Click on the start button on the
Taskbar ? Then Click on the Program option in start menu. ? After that click on the Microsoft Word option identified by
icon. This command will launch the Microsoft word 2000 on your computer, which will have typical look as shown
below: Figure 7.1

MATCHING BLOCK 187/291 W

LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Starting of MS-Word ? Start Working with Word Document ? Opening of an Existing Document ? Formatting the Text ?

Spell Checking

146 Basic Computer Skills The Microsoft Word window starts with a new document opened. Components of the MS-
Word Window Components of the Microsoft Word window are: 1. Title or Caption Bar 2. Menu Bar 3. Tool Bars 4. Ruler 5.
Cursor 6. Status Bar 7. Scroll Bars 8. Document Navigator 9. Help Assistant Figure 7.2 Function of the

85% MATCHING BLOCK 188/291 SA Computer Application.pdf (D166063658)

various components of Microsoft word window: 1. Title Bar: Title bar shows the name of the document and situated in
the top of the window application. 978 154 32 9 147 Microsoft Word 2000 2. Menu Bar: Menu bar contains the
various commands under the various topics to perform some special tasks. Menu bar is located

below the title bar 3. Toolbar(s): A Toolbar is a group of graphical shortcut buttons for executing Menu
options/commands in easier and faster way. Generally they appear below the menu bar but can be placed anywhere, as
we shall see later. 4. Ruler: The window is supplied with a horizontal and a vertical Ruler displayed along the left and the
top of the document. Rulers can be used to set

63% MATCHING BLOCK 189/291 SA Computer Application.pdf (D166063658)

margins and indents in easier way and they also provide measurement for the page formatting. 5. Cursor: Cursor is

MS-Word
pointer, which tells where on the document the action (that you choose) will appear or affect. The cursor can be moved

and placed anywhere on the document with the help of a pointing device like mouse. 6.
Status Bar: This

90% MATCHING BLOCK 190/291 SA Computer Application.pdf (D166063658)

bar displays the position of the cursor; status of some important keys of keyboard; the messages for the toolbar button
when a mouse points to it, messages for menu option, when a menu option is selected or pointed out by a user

and/or many other relevant information. It is located at the bottom of the window. 7. Scroll Bars: Scroll bars are sliders
that can be moved using mouse. As the scroll bar is moved, the window pans through the document, exposing different
regions of the document.

100% MATCHING BLOCK 191/291 SA Computer Application.pdf (D166063658)

There are two types of scroll bars: i. Horizontal Scrollbar ii. Vertical Scrollbar

Horizontal Scrollbar is placed at the bottom while vertical scroll bar at the right side of the document. 8.

100% MATCHING BLOCK 192/291 SA Computer Application.pdf (D166063658)

View Buttons: View buttons are shortcuts of various views in the View Menu,

placed adjacent to the horizontal scroll bar. These buttons select different ways the document can be viewed,
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as we shall see later. 9.

MATCHING BLOCK 193/291 SA Computer Application.pdf (D166063658)
Document Navigator: Document Navigator allows navigating the document in different types of objects and is

activated when clicked on the ball type button on the vertical scroll bar. 10. Office Assistant: Office assistant provides
you the online help and real-time tips while working

with MS-Word. STARTWORKINGWITHWORDDOCUMENT

MATCHING BLOCK 194/291 SA Computer Application.pdf (D166063658)

When you open the Word a blank document appears. You can start typing on it directly. But for performing various
other activities, you need to learn about the different menus in the menu bar and the options available under these
menu bars.

You can select different menus with the mouse and you can select it through the hotkeys also. Hotkeys are displayed
underlined. Just press the underlined combination of keys (usually, Alt,

148 Basic Computer Skills unless specified otherwise) to get the action performed. For example if you wish to select the
File menu you have to press the Alt+f keys to open the menu or Alt+v to select the View menu. Before going on menus
let's see how to move within the document using various keys. Movement of the Cursor Using Keyboard Movement of
the cursor Keys

MATCHING BLOCK 195/291 SA Computer Application.pdf (D166063658)

Left or Right one character ? Or ? Left or Right one word Ctrl+ ? or Ctrl+? Up or Down one line ? Or ? Up or Down one
paragraph Ctrl+ ? or Ctrl + ? Start or end of a line Home or End Up or Down one screen Page up or Page Down Top or
bottom of the current screen Ctrl+Page Up or Ctrl+Page Down Start or end of the document Ctrl+Home or Ctrl+End
File-Related Operations

File (or document) related operations can be performed through FILE menu. Different file-operations are: ? Opening a
new file ? Opening an existing file ? Saving an opened file ? Closing an opened file ? Examining the print preview of an
opened file ? Printing an opened file ? Setting the page setup of the file ? Saving different copies of a file ? Exiting from
word Figure 7.3

149 Microsoft Word 2000 Opening
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a New File 1. Click on the File menu. Click on the New option or press Ctrl+N through the keyboard

or click at the icon at the standard toolbar. 2.

MATCHING BLOCK 197/291 SA Computer Application.pdf (D166063658)

Select the Blank document from the General Tab from the dialog box and then press OK button.

Figure 74 Note that there are many types of pre-designed documents are available in the dialog window above. i. Blank
Document: Start with a blank document when you want to create a traditional printed document. ii. Web Page: Use a
Web Document when you want to display the document's contents on an intranet or the Internet in a Web browser. A
Web page opens in Web layout view. Web pages are saved in HTML format i.e. a file with .html extension. iii. E-mail
Messages: If you use Outlook 2000 or Outlook Express, use an e-mail message when you want to compose and send a
message or a document to others directly from Word. An e-mail message includes an e-mail envelope toolbar so that
you can fill in the recipient names and subject of the message, set message properties, and then send the message. iv.
Templates: Use a template when you want to reuse boilerplate text, custom toolbars, macros, shortcut keys, styles, and
auto text entries.
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Save a Document For saving a document: 1. Click on the File-&lt;save option. 150

Basic Computer Skills OR Press Ctrl+S OR Click on the Save tool icon at the
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standard toolbar If you are saving the file for the first time, the Save as window will appear on the

screen. Figure 7.5 2.
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Choose the appropriate folder from Save in combo box. 3. Write the proper file name in the File name text box. 4. Then
press the Save button.

Note that if you close an opened document without saving its latest content, MS- Word duly prompts you with option
for saving and not saving the document. You can select the appropriate action from these options as well.
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Save and Save as options do the same work of saving a document. However, the difference between both option is
that the Save as command

allows the user to save a file by a different name and format. The Save option will save the document by the same name
and format as it was saved for very first time. Without even showing the dialogbox to save the document.
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Opening of an Existing Document To open an existing document: 1. Select the Open option from the File menu. OR
press Ctrl+O OR Click on the Open tool icon at the standard toolbar. Then the Open dialog box will appear

as shown in Figure 7.6.
151 Microsoft Word 2000 Figure 7.6 1.
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Select the appropriate folder from look-in combo box. 2. Select the required file from the file window. OR Write the
required file's name in the file name window. 3. Click on open button on the right hand side OR Press Enter Closing of
Document To close an already opened

document,
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just choose the close option from file menu but keep it in your mind that the

only current window or document will be closed since the

91% MATCHING BLOCK 205/291 SA Computer Application.pdf (D166063658)

Microsoft Word works in MDI (Multi Document Interface) environment unlike notepad which works in SDI (Single
Document Interface).
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Save as Web Page Save as Web page option will save the word document in the Web page format i.e. in the html format
with the extension .htm. Then you can view it in the web browser. Version A document can be saved in different versions
with the Version option in the File menu. Following are the steps for saving different versions of Word document:

152 Basic Computer Skills 1. Click on the Version option of the File menu, then the following Versions window will
appear. Figure 7.7 2. Click on the Save Now... button then the following window will appear. Figure 7.8 3. Write the
comments of the version for example Ist version or lind Version. 4. Then, press Ok. Do some changes in the document
and repeat steps from 1 to 4. These steps will save your document in different versions. To see the difference between
the versions do the following:

153 Microsoft Word 2000 1. Again choose the version option from File menu. Now this time the window will look like:
Figure 7.9 Here you can see the two different versions of the same document. The last version i.e. the lInd version is your
current version. To compare: 2. Click on Ist version 3. Click on Open How you can see the two windows of two versions
and you can compare the text in the two documents. Web Page Preview Web page preview will invoke your default web
browser, for example Internet Explorer. In the web browser the document will be shown in the Web page format.

MATCHING BLOCK 206/291 SA Computer Application.pdf (D166063658)

Page Setup From the Page setup option one can setup the page layout (margins etc.). To use the Page setup option
you have to perform the following steps: 1. Click on the Page setup option from the file menu then

the page setup window will appear (Figure 7.10).
154 Basic Computer Skills Figure 7.10 2.
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Adjust the different margins or apply different options from the margin tab. i. In top margin, enter the distance you
want between the top of the page and the start line on the page. ii. In Bottom margin, enter the distance you want
between the bottom of the page and start last line on the page. iii. In Left option, enter the distance you want between
the left edge of the page and the left edge of unindented lines. iv. In Right option, enter the distance you want between
the right edge of the page and the right end of a line with no right indent. v. In Gutter option, enter the amount of extra
space you want to add to the margin for binding. Word adds the extra space to the left margin of all pages, if you clear
the Mirror margins check box, or to the inside margin of all pages if you select the Mirror margins check box. vi. In
Header option, under From edge frame, enter the distance you want from the top edge of the paper to the top edge of
the header. If the Header setting is larger than the Top setting, Word prints the body text below the header. vii In Footer
option, under From edge frame, enter the distance you want from the bottom edge of the paper to the bottom edge
of the footer. If the Footer setting is larger than the Bottom setting, Word stops printing the body text above the footer.
viii. Check Mirror margin checkbox to adjust left and right margins so that when you print on both sides of the page,
the inside margins of facing pages are the same width and the outside margins have the same width. ix. Check the 2
pages per sheet checkbox to print the second page of a document 155
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enter the distance you want between the top of the page and the start line on the page. ii. In Bottom margin, enter the

distance you want between the bottom of the page and start last line on the page. iii. In Left option, enter the distance
you want between the left edge of the page and the left edge of unindented lines.
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Right option, enter the distance you want between the right edge of the page and the right end of a line with no right
indent.
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Gutter option, enter the amount of extra space you want to add to the margin for binding. Word adds the extra space
to the left margin of all pages, if you clear the Mirror margins check box, or to the inside margin of all pages if you
select the Mirror margins check box.
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enter the distance you want from the top edge of the paper to the top edge of the header. If the Header setting is
larger than the Top setting, Word prints the body text below the header. vii In Footer option, under From edge frame,
enter the distance you want from the bottom edge of the paper to the bottom edge of the footer. If the Footer setting
is larger than the Bottom setting, Word stops printing the body text above the footer.
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left and right margins so that when you print on both sides of the page, the inside margins of facing pages are the
same width and the outside margins have the same width.

Microsoft Word 2000
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on the first page. This check box is used when the printed page is folded in half with the two pages
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on the first page. This check box is used when the printed page is folded in half with

accomodated in one sheet. The outer margins and
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the inner margins (gutter) of the page will have the same width. x. In the Apply to list box, click the portion of the
document you want to apply the current settings to in the Page Setup dialog box. And the options of this list box are
whole document, this point forward etc.,
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click the portion of the document you want to apply the current settings to in the Page Setup dialog box.

which can be selected as per the situation.
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From the Paper size tab you can set the length or width of the page. When you click on the Paper size tab the
following window will appear.

Figure 7.11
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In the above window you can adjust the following: i. From Paper size list box you can select the predefined Paper sizes.
ii.
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Width and Height text boxes, the custom Paper size can be defined by adjusting the Height and width of the paper,

if you do not want to select as standard or predifined paper size.
MATCHING BLOCK 220/291 SA Computer Application.pdf (D166063658)
iii. Select the orientation of the paper as Landscape or Portrait from orientation frame.

Portrait orientation is length-wise i.e., vertical while Landscape orientation is width-wise or horizontal on the page. From
the Paper source tab, you can select the source of paper from where you are going to insert the paper in the printer.
Click on the Paper source tab, the following window will appear.

156 Basic Computer Skills Figure 7.12 In the above window you can adjust the source of the first page and other pages.
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Print Option For taking the printout, you have to select the print option of the file menu. After selecting the print option

from file menu, the window given below will appear: Figure 7.13 You can set various options before taking printout. i.
From the Name combo box you can select the printer if

there are more than one printers installed on your system.
157 Microsoft Word 2000
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ii. You can select the range of pages i.e. all pages or current page or number of pages you require from Page range
frame. iii From the Print option you can choose which part of

the
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document you want to print i.e. the whole document or comments or anything else. iii. From print option the pages
can be selected to printi.e. all pages or all even pages or all odd pages. iv. You can choose number of copies from
Number of copies option under Copies frame. v. From Pages per sheet option under Zoom frame, you can select the
number of pages in the document that you want to print on single sheet of paper. vi. From Scale to paper size option,

you can select the paper size on which you want to print the document. For example, you can specify that a B4-size
document

will be printed
100% MATCHING BLOCK 224/291 SA Computer Application.pdf (D166063658)

on A4-size paper by decreasing the size of the font and the graphics. This feature is similar to the reduce/enlarge
feature on a photocopy machine.

Vi
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The collate check box can print the copies of the document in proper binding order.
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Send to Option From Send to option you can send the document to various other recipients (application or otherwise)
on various places through various technologies like email, fax etc. Properties Option From the Properties option in the
file menu you can set the various properties of the document. When you click on the properties option you will see the
window given in Figure 7.14. From this window you can set or see the various properties of the document. You can set
the author name, company name, title of the document and various other properties. And from other tabs you can see
the various properties of the document like. i. From General tab you can see the type of document, the file size, the path
of the file where it is saved, date of creation of the document, date of last modification etc.

158 Basic Computer Skills Figure 7.14 ii. From Statistics tab you can see the various statistics of the document like no. of
words, no. of characters, no. of lines etc. After the properties option there is a list of last modified or created files. The
number of files is 4 by default but it can also be set by you as per your requirement FORMATTINGTHETEXT
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Once the text of a document has been typed, it is required to be formatted.

Formatting affects the appearance of the document rather than its textual/graphical contents.

98% MATCHING BLOCK 227/291 SA Computer Application.pdf (D166063658)

MS-Word provides format menu to give a meaningful format your document so that a user can read and understand
the document in an easy

and attractive manner. Following options are available in the format menu.
159 Microsoft Word 2000 Figure 7.15 Fo rmat tin g o f Fo nt
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Format of font i.e. the font type, font size, font style, font color, character spacing etc. can be changed through the
option Font of Format menu.

In this section we will discuss about: 1. Changing font, font size and font color. 2. Applying Boldface, italic and underline.
3. Adjusting space between characters. 4. Applying text effects. 5. Choosing a different default font. 6. Copying and
removing font formatting. Changing the Font Font means the design/looks of characters. As each and every human
being has unique writing style, they use different fonts. You can change the font of the text using two methods: 1.
Changing font using the font list. 2. Changing font using the font dialog box.

160 Basic Computer Skills Changing Font using the Font List This is a quicker way of changing a font as compared of
using the font dialog box. To change the font using the font list: 1. Select the text. It can be a page, a paragraph, a line, a
word or a character. 2. Drop down the Font list box in the Format toolbar. It will show you all the fonts available in the
computer. Scroll down the list to find out more fonts. 3. Click on the desired font. Figure 7.16 Word places the fonts you
use frequently above the double line in the Font list box. Changing Font Using Font Dialog Box Changing
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the font-using Font dialog box gives you the opportunity to see the result within the dialog box before applying it

to
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the text. Other benefit of using the font dialog box is that you can apply several effects within at the same

time affecting various characteristics of the font. To do so: 1.
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Select the desired text to change the font. 2. Select the Font option from Format menu. 161 Microsoft Word 2000
Figure 7.17 3. Scroll through the Font list and select the font that you want. 4. Select the color; underline style and

other
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effects of your choice. 5. Select the font style according to the text. 6. Click on Ok button.

You can use formatting toolbar for all these operations to make your task much easier and faster. You can change the
following from this toolbar. ? Font Size ? Font Type ? Bold, Italic, Underline ? Make bulleted list ? Indentation of paragraph
(left, center, right, or justified) ? Border ? Text Color ? Back Color

162 Basic Computer Skills Figure 7.18 Besides, you can also use key combinations for some of the formatting actions.
Bold: Ctrl+B Left aligned: Ctrl+L Underline: Ctrl+U Center aligned: Ctrl+E Italic: Ctrl+| Right aligned: Ctrl4+R Increase font
size: Ctrl+Shift+&lt; Justified: Ctrl4+J Decrease font size: Ctrl+Shift+&gt; Paragraph Formatting Formatting of paragraph
includes the following: 1. Indentation of paragraph 2. Alignment of paragraph 3. Changing Line spacing 4. Tabs 5. Bullets
and numbering To do the above you need to choose the Paragraph option under the Format menu. When you click on
the Paragraph option you will be able to see the following dialog box: Figure 7.19

163 Microsoft Word 2000 IndentationofParagraphlndentisthe space left blank within the page margin. You
can indent your paragraph from the left and right margins. You can also create first-line indent, which indents only the
first line of a paragraph, or a hanging indent, which indents all the lines in a paragraph except the first one. Indentation
can be set in various ways: Indentation through Paragraph dialog box Indentation through Paragraph dialog box is
probably the best method for you. You have to follow the following steps: 1. Click in the paragraph which you want to
indent. 2. Select Paragraph option under Format menu. This will bring up the above dialog box. 3. Click the Indent and
spacing tab. 4. Under Indentation, type the measurement that you want to indent the paragraph in the Left or Right text
boxes. 5. Click OK button. Figure 7.20 Indentation through Increase Indent and Decrease Indent button If you want to set
left indent at a half-inch increment on the ruler, you can do it through the increase indent and decrease indent buttons
on the formatting toolbar. Right Indent Increase Indent Decrease Indent Left Indent First Line Indent Hanging Indent First
Line Indent Left Indent Hanging Indent Right Indent

164 Basic Computer Skills 1. Click in the paragraph you want to indent. 2. Click the Increase indent button to increase
indent and Decrease Indent button to decrease the indent. Set an Indent with Indent Marker Follow these steps to set an
indent by dragging the indent markers. 1. Click in the paragraph that you want to indent. 2. Point to the indent marker
that you want to use. 3. Drag the indent marker to the right spot on the ruler, and release the mouse button.
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Alignment of Paragraph Alignment refers to the way the right and left edges of a paragraph line up along the right and
left margins of your document. Word gives you four alignment choices-left, centered, right and justified

as shown in figure 7.21. Figure 7.21 By default word takes left alignment. To change the alignment of the paragraph
MATCHING BLOCK 234/291 SA Computer Application.pdf (D166063658)

you have to perform the following steps: 1. Click on the paragraph in which you want to change the

alignment. 2. Bring up the Paragraph dialog box as stated above. 3. Choose the alignment from alignment drop down list
box. 4. Press the Ok button. You can do the alignment with the alignment button in format toolbar.

165 Microsoft Word 2000 Changing Line Spacing Figure 7.22 Line space is the space between two lines in a paragraph.
By default it is single-spaced. To change the line space, perform the following steps: 1. Click the paragraph in which you
want to change line spacing. 2. Bring up the Paragraph dialog box. 3. In the line spacing list box select the space you
want in between the lines or write the number in the text box if you want to choose the last three options under the Line
spacing list box. 4. Click the Ok button. Tabs Tab is a position you set for placing and aligning text on a page. Microsoft
Word has four kinds of tab stops, as shown below. Left text extends to the right from the tab stop. Center text is centered
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at the tab stop. Right text extends to the left from the tab stop

until the tab's space is filled, and then the text extends to the right. Decimal number before the decimal point extends to
the left, and number after the decimal point extends to the right. Bar tabs generates a bar.

166 Basic Computer Skills Figure 7.23 To Set the Tabs 1. On the Format menu, Click Tabs option. Figure 7.24 2. In the Tab
stop position box, type the position for a new tab, or select an existing tab stop. 3. Under Alignment section, select the
alignment for text typed at the tab stop. 4. Under Leader, click the leader option you want, and then click set. Bullets and
Numbering Word's bulleted and numbered list features add the bullets or numbers in your document, and they create
hanging indents so that when text in an item wraps to the next line, it

167 Microsoft Word 2000 doesn't wrap underneath the number of bullet. Word enables you to create single level lists as
well as multilevel lists. Single Level Lists Single level lists are shown below in the Figure 7.25. Figure 7.25 Follow these
steps to create a single-level bulleted or numbered list: 1. Click where you want to start a list. 2. Click the Bullets and
Numbering button in the Formatting toolbar 3. Type the first item in the list and press Enter. Word automatically inserts a
bullet or number on the next line for you. 4. After the last item press Enter twice to turn off the bullets or numbers.
Instead of turning on the bulleted or numbered list feature and then typing the list, you can also type the list first, select it,
and then click the Bullets and Numbering toolbar button. Changing the Appearance of Bullets and Number Changing the
Appearance of Bullets To change the appearance of the Bulleted list you have to follow these steps. 1. Click where you
want the bulleted list to start. 2. Click on the Bullets and Numbering option in Format menu to display the Bullets and
Numbering dialog box. Bulleted Numbered

168 Basic Computer Skills Figure 7.26 3. If you don't want to use a bullet given in the dialog box, click any of the seven
gallery positions (Other than None), and click the Customize button to display the Customize Bulleted list dialog box.
Figure 7.27 4. Click the Bullets button to display the Symbol Dialog box. Select the desired symbol or choose the others
from the font list.

169 Microsoft Word 2000 Figure 7.28 5. Click the OK button. Change the appearance of Numbering in Number list 1.
Click where you want the numbered list to start. 2. Choose Bullets and Numbering option from the Format Menu. Figure
7.29 3. If you don't see the Numbering that you want to use, click any of the gallery positions other than None and click
Ok button, or click the customize button to display the Customize Numbered List dialog box.

170 Basic Computer Skills Figure 7.30 4. If you want to revise the format of the numbers, type the change in the Number
Format text box. Choose the Number style from Number Style list box etc. when you finish click OK button. Creating
Multilevel List Outline numbered list A list can be created by using the Bullets and Numbering command (Format menu)
to apply a hierarchical structure to any list or document, including a legal or technical document. A document can have
up to nine levels, and Microsoft Word does not apply built-in heading styles to the items in the list. Figure 7.31

171 Microsoft Word 2000 Create an Outline Numbered List Outline numbered lists can have up to nine levels. 1. On the
Format menu, click Bullets and Numbering, and then click the Outline Numbered tab. 2. Click a list format that does not
contain the text "Heading 1%, and then click OK. 3. Type the list, pressing ENTER after each item. 4. To move an outline
numbered item to the appropriate numbering level, do one of the following as in Figure 7.32 below: Figure 7.32 To
demote the item to a lower numbering level, click anywhere in the item and click Increase Indent. To promote the item
to a higher numbering level, click anywhere in the item, and click Decrease Indent. Borders and Shading When you draw
an object, it automatically appears with a border around it - a thin line that defines its shape. You can also add borders to
text, paragraphs, pictures, and important art. You can change or format a border in the same way you change or format a
line. Follow these steps to add borders and shading to your text:

172 Basic Computer Skills Figure 7.33 1. Click on the paragraph or text around which you want border. 2. Click the
Borders and Shading option of Format menu. You will find the following dialog box. Figure 7.34

173 Microsoft Word 2000 3. Select Setting, style, color and width of the border. 4. For shading click the Shading tab.
Figure 7.35 5. Choose the desired shade from the fill box and select style. 6. Press the OK button. You can also do it with
the help of format toolbar
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Working with Columns You can use columns to create documents such as newsletters or book pages. The column
option controls the width and number of columns. Narrower column widths make your text easier to red. Often,
creating columns enables you to fit more text on a single page. Columns work particularly well where you have several
shorter topics making up a larger document, as a newspaper.
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Figure 7.36
174 Basic Computer Skills
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To Create a Column: 1. Select the text which you want to convert in column . 2. Click on the column button in the
Standard toolbar. 3. A drop-down list appears with four columns across it. Click on the first column in the drop-down
list and drag across to highlight desired number of columns.

Figure 7.37 4. Leave the mouse button. Adjust Column width and Add a Vertical Line between Columns 1. Click anywhere
in the column-text. 2. Choose Column option from Format menu to display the column dialog box. Figure 7.38 3. Select
the preset that you want for the column. 4. If you have specific requirements for column widths, fill it into the Width and
spacing and fill the Number of columns box.

175 Microsoft Word 2000 5. Check the Line between check box to insert a line between two columns. 6. Press Ok
Button. Background and Themes Background and Themes are used to create a web page in Word. To apply themes
follow these steps: 1. Click on the Theme option under Format menu. Figure 7.39 2. Select the desired theme 3. Press Ok
Button Working with Style

A style is a set of formatting characteristics that you can apply to text in

your document to quickly change its appearance. When you apply a style, you can apply a whole group of formats in
one simple task. For example, you may want to format the title of a report to make it stand out. Instead of taking three
separate steps to format your title as 16 pt, Arial, and center-aligned, you can achieve the same result in one step by
applying the Title style. When you start Microsoft Word, the new blank document is based on the Normal template, and
text that you type uses the Normal style. This means that when you start typing, Word uses the font, font size, line
spacing, text alignment, and other formats

176 Basic Computer Skills currently defined for the Normal style. The Normal style is the base style for the Normal
template, i.e. it's a building block for other styles in the template. There are a number of other styles besides Normal
available in the Normal template. A few basic ones are shown in the Style list on the Formatting toolbar. You can preview
and select others in the Style dialog box (Format menu, Style command). Figure 740 Advantage of Using Styles 1. Styles
can dramatically reduce the time it takes to format a document often by 90% or more. 2. Styles can also help you make
sure all your documents look consistent, with very little effort on your part. 3. If you export your word document to a
desktop publishing program, most programs can use Word styles to help automate their work. 4. If you need to change
the way your styled document looks, you need to change only a few styles, not hundreds of manual formats. 5. It's much
easier to take advantage of Word's powerful automation and organization features if you use styles. For example, word
can automatically build and update a table of contents based on the styles in your document. Without styles, you would
have to manually apply a field to every single item you want to include in your table of contents.

177 Microsoft Word 2000 Ty pe s o f Sty Ll e Style can be set in two types: 1. Character based style 2. Paragraph based
style Character Based Style A character style affects selected text within a paragraph, such as the font and font Style size
of text, and bold and italic formats. Characters within a paragraph can have their own style even if a paragraph style is
applied to the paragraph as a whole. If you want to give certain types of words or phrases same kind of formatting, and
the formatting isn't in an existing style, you can create a new character style. Paragraph Based Style A paragraph style
controls all aspects of a paragraph's appearance, such as text alignment, tab stops, line spacing, and borders, and can
include character formatting. If you want a paragraph to have a particular combination of attributes that aren't in an
existing style (for example, a bold, italic, center-aligned heading in the Arial Narrow font), you can create a new
paragraph style. Apply a Different Style 1. Do one of the following: ? To apply a paragraph style, click the paragraph or
select the group of paragraphs you want to change. ? To apply a character style, click the word or select the words you
want to change. 2. In the Format menu, click Style. 3. In the Styles box, click the style you want to apply, and then click
Apply. If the style you want is not listed, select another group of styles in the List box. A paragraph mark appears to the
left of each paragraph style. A bold, underlined letter "a" appears to the left of character styles. Create a New Character
Style 1. On the Format menu, click Style.

178 Basic Computer Skills Figure 741 2. Click New, the following dialog box will appear: 3. In the Name box, type a name
for the style. 4. In the Style type box, click Character. 5. Select the other options you want, and then click Format to set
attributes for the style. Figure 7.42 6. Click Ok button.
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179 Microsoft Word 2000 Create a New P aragrap h Style The quickest way to create a new paragraph style is to format a
paragraph, select it, and then base the new style on the formatting and other properties applied to the selected text. 1.
Select the text that contains the formatting you want to use for your new style. 2. On the Formatting toolbar, click inside
the Style box. 3. Type over the existing style name to create the name for the new style. 4. Press ENTER. Mo di fy a Styl e
1. On the Format menu, click Style. 2. In the Style box, select the style you want to modify, and then click Modify. 3. Click
Format, and then click the attribute - such as Font or Numbering - you want to change. Figure 743 4. Click OK after
you've changed each attribute, and then repeat for any additional attributes you want to change.

180 Basic Computer Skills MS-Word is equipped with a number of software tools and utilities that enhance the user's
work and provides extra word-processing power to the user. They help users make their work accurate and faster. These
tools and utilities are grouped into Tools menu bar of the Ms-Word as shown in the figure below. Figure 744Spelling
andGrammar This utility, as the name suggests, helps users identify spelling and grammatical mistakes in the
document. Moreover, it offers suggestion(s) for possible corrections, from which users may choose the right one. For this
MS-Word maintains internal dictionaries. At one time one dictionary is active. Online Spelling and Grammar Checking As
you type, Word automatically checks your document and underline possible spelling and grammatical errors. Spelling
errors by default are underlined in RED color and grammatical errors are underlined in GREEN. Note that the
incorrectness of a word only means that the particular word is not available in the active dictionary. To correct the
Spelling of words and Grammar: 1. Right click at the word to check. A context menu will appear with a list of suggested
correct spellings nearest to the word concerned. It also has a list of command options. 2. Select the best suitable spelling
or grammar. The misspelt word is replaced by the word you chose. 3. If you think that the word you typed is correct then
you would like to add it in the active dictionary so that Word will treat it as correct word thereafter. You can add that
word in the active dictionary using Add option.

181 Microsoft Word 2000 Figure 745 4. If you don't want to add the word and yet you want Word not to treat it as
incorrect, you can ignore it. Usi ng the Spe [ li ng and Grammar Chec ke r The spell checker lets you check the spelling
and grammar of an entire document all at once. You won't really need to use it if you use automatic spelling checking to
fix your spellings. However, if you are working on a rather larger document, the spelling and grammar checker comes
handy. To check your document with spelling and Grammar checker: 1. Click on the Spelling and Grammar button of
Format toolbar, or Spelling and Grammar option on Tools menu, or press F7 key. Spelling and Grammar Spelling and
Gram m ar Figure 7.46 2. MS-Word will bring you the following dialog box with the first error it encounters within the red
color text and the suggestions in the next window. 3. Sometimes, Word doesn't offer the correct spelling or the grammar
for a misspelt word. If this happens, select the word in the top half of the dialog box and type the correct grammar or the
word there. 4. If the word is rightly spelled, then click the Add button to add it to the dictionary.

a. Microsoft Wordisa __________ based word processing application. b. File or document related oprations can be
performed through __________ menu.

Microsoft Excel 2000UNIT8INTRODUCTION
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To start Excel: 1. Click on the Start button at windows taskbar. 2. Select

Programs option 3. Select Microsoft Excel option. Figure 8.1

MATCHING BLOCK 238/291 w

LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Introduction ? Components of Excel Window ? Start Working with Menu Options ? Data Entry and Editing ?
Reversing/Reapplying Commands ? Find, Replace and Goto Options ? Working with Toolbars ? Resizing of Columns and
Rows

186 Basic Computer Skills Clicking on this option will open up the Microsoft excel and you will see the following screen:
Figure 82COMPONENTSOFEXCELWIND O W A normal Excel window has the following components. 1. Title
Bar 2. Menu Bar 3. Standard Toolbar 4. Formatting Toolbar 5. Status Bar 6. Formula Bar 7. Cell 8. Rows 9. Columns 10.
Name box 11. Help Assistant 12. Scroll Bars 13. Worksheets

187 Microsoft Excel 2000 Figure 8.3 Function of
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Various Components of Microsoft Excel Functions of various components of Microsoft Excel is given below: 1. Title

69% MATCHING BLOCK 240/291 SA Computer Application.pdf (D166063658)

Title Bar: Title bar shows the name of the document and is situated in the top of the window application. 2. Menu Bar:
Menu bar contains various commands under various topics to perform some special tasks. Menu bar is located below
the title bar 3. Standard Toolbar: Toolbar is nothing more than the shortcuts of different Menu options to execute or
perform the menu options in the easier and faster way. Standard toolbar contains icons for the Excel's most frequently
used commands. 4. Formatting Toolbar: Formatting toolbar contains the various

short cut icons for

90% MATCHING BLOCK 242/291 SA Computer Application.pdf (D166063658)

the commands related to the formatting of the document. 5. Status Bar: It displays the positioning of the cursor,
displays the status of some important keys of keyboard, shows the messages for the toolbar button when a mouse
points to it, displays messages for menu option when a menu option is selected or pointed out by a user. 6.

98% MATCHING BLOCK 243/291 SA Computer Application.pdf (D166063658)

Formula Bar: Formula bar shows you the formula instead of the result whenever you click on a cell in which you have a
formula. 7. Rows: Rows are combination of all the cells joined together in

I |
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single horizontal line. An Excel workbook has maximum 65,536 rows in a worksheet 188 Basic Computer Skills 8.
Columns: Columns are combination of all the cells joined together in

97% MATCHING BLOCK 245/291 SA Computer Application.pdf (D166063658)

Im

single vertical line. An Excel workbook has maximum 256 columns in a worksheet 9. Cell: A Cell is an intersection of

arowanda
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column. It is used to store data. There are 65536 x 256 = 16777216 cells in a single worksheet. 10. Name Box: This box
shows the name or the address of the currently active cell. 11. Office Assistant: Office assistant provides you online help

and
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real-time tips while working. 12. Scroll Bars: There are two scroll bars The scroll bar is used to move the Worksheet in
either directions.

i. Horizontal Scrollbar ii. Vertical Scrollbar 13. Worksheets: As the
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name suggests, it is the working area in which you can work. Each worksheet of a single workbook has its own identity

and is
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separate from other worksheets. The maximum limit of the worksheets in a workbook is 255.

STARTWORKINGWITHMENUOPTION S The eight menus in the Excel 2000 are 1. File Menu 2. Edit Menu 3.
View Menu 4. Insert Menu 5. Format Menu 6. Tools Menu 7. Data Menu 8. Window Menu 9. Help Menu We will discuss
each of the menus in different unit. To start with here is the
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File menu. File Menu To open a new workbook: 1. Click on the File Menu (Figure 8.4) 2. Select option New or press
Ctrl+N.
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To open a new workbook: 1. Click on the File Menu (Figure 8.4) 2. Select option New

You will get the following window (Figure 8.5)
189 Microsoft Excel 2000 Figure 8.4 Figure 8.5 3.
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Click the OK Button. Now you will get a fresh new workbook to work on.

Figure 8.6
190 Basic Computer Skills To Save
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a Workbook 1. Click on the File-&lt;save option. OR Press Ctrl+S OR Click the Save Button on standard toolbar If you
are saving the file for the first time the, Save as window will appear. 2. Choose the appropriate folder from Save in
combo box. Figure 8.7 3. Write the proper file name in the File name text box 4. Press the Save button Save and Save As
options do the same work of saving a document

if you are saving the document for the first time.
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The difference between both options is that the Save as command every time gives you the Save as dialog box and you
can save the file with different name also, but the Save option gives you the Save As dialog box when you are saving
the document for very first time. Next time it will save the document with the previous name without showing any
dialog box.

You can also set password and some other options by clicking the Tools drop down list in save as dialog box. Clicking on
the General option window will give you the following dialog box: Figure 8.8
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191 Microsoft Excel 2000 Options you can Set 1. Password to open: If you set the Password to open then it will restrict
any unauthorized user to open a workbook. Setting the Password to open option will ask the user for the password when
anyone tries to open the document. 2. Password to modify: Password to modify will decide if to allow the user to modify
a workbook or not. If user knows the password he/she will be allowed to work on workbook and can make the changes.
The user who doesn't know the password to modify but knows the password to open can only read the workbook but
can't make any change. 3. Always create backup: Checking this option will result in a backup copy of the workbook
when it is saved.
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Opening an Existing Workbook To open an existing workbook following steps are required: 1. Select the Open option
from the File menu OR Press Ctrl+O OR Click on the Open tool from the standard toolbar Then the open dialog box
will appear

as shown in Figure 8.9. Figure 8.9 2.
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Select the appropriate folder from Look in combo box. 3. Select the required file from the file window OR Write the
required file's name in the File name window 192 Basic Computer Skills 4. Click on open button on the right hand side
OR Press Enter Closing

Document
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To close an already opened workbook just choose the close option from

the file menu but keep it in your mind that the only current window or document will get closed because the
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Microsoft Excel works in MDI (Multi Document Interface) environment unlike notepad which works in SDI(Single
document interface).

Save as Web Page Save as Web page option will save the Excel workbook in the Web page format i.e., in the html format
with the extension of .htm. You can view it in the web browser. To save a Workbook as a Web page follow the following
steps: 1. Click on the File Menu. 2. Choose the Save as Web page option. It will show you the following dialog box. Figure
8.10 3. Select the option what you want - to save Entire workbook or Selection. 4. Change the Title by clicking on the
Change Title button. 5. If you want to save it click on the save button. But if you want to publish it, click on the Publish
button. 6. If you have chosen the publish button then the following dialog box will appear.

193 Microsoft Excel 2000 Figure 8.11 Note: The difference between saving a file or publishing a file is that saving a file
saves the file only in html format. But publishing a file means it not only saves the workbook but also any other object
you have inserted in the workbook e.g. picture, sound etc. 7. You can choose the item you want to publish from the
Choose combo box. 8. Click the browse button if you want to change the path of publishing file. 9. Click on publish
button after finishing off. This will save your file in appropriate folder. Figure 8.12 10. Open the file from windows explorer
to see the result.

194 Basic Computer Skills Web Page Preview Web page preview will make you able to see how your document will look
like on the web browser before saving it as web page or before publishing it. Save Workspace By creating a workspace
file you can open a group of workbooks in one step. A workspace file saves information about all open workbooks, such
as their locations, windows size, and screen positions. When you open a workspace file by using open command,
Microsoft Excel will open all workbooks saved in the workspace. The workspace file does not contain the workbooks
themselves, and you must continue to save changes you make to the individual workbooks. 1. Open all the workbooks
that you want to open as a group. 2. Size and position the workbook windows, as you want them to appear the next time
you use the workbooks. 3. On the File menu, click Save Workspace option. The following dialog box will appear: Figure
8.13 4. Give a suitble name to the Workspace and Press Ok button.
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Page Setup From the Page setup option, one can setup the page layout according to his work.

To use

87% MATCHING BLOCK 260/291 SA Computer Application.pdf (D166063658)

the Page setup option you have to perform the following steps: 195 Microsoft Excel 2000 1. Click on the Page setup
option from the file menu then

the following
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window will appear: Figure 8.14 2. Select the page Orientation from Portrait or Landscape options. 3. Setting the Adjust
to scaling option will reduce or enlarge the printed worksheet. Select the Adjust to check box, and then enter a
percentage number in the % normal size box. You can reduce the

size of worksheet to 10 per cent of its normal size or enlarge it to 400 per cent of its

SA
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normal size. 4. Change the value in Fit to option to fit the worksheet or selection you

want to printin
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the specified number of pages. Select the Fit to check box; enter a number in the page(s) wide by box; and enter a
number in the tall box. To fill the paper width and use as many pages as necessary, type 1 in the pages(s) wide by box
and leave the tall box blank. 5. Select the Paper size 6.

Click on the Margins tab to set the Margins. You will find the following dialog box (Figure 8.15): Figure 8.15
196 Basic Computer Skills 7. Adjust different margins or apply different options from the margins tab i. In the
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top option enter the distance you want between the top of the page and the first line on the page. ii. In the Bottom
option enter the distance you want between the bottom of the page and the last line on the page. iii. In the Left option
enter the distance you want between the left edge of the page and the left edge of unindented lines. iv. In Right option
enter the distance you want between the right edge of the page and the right end of a line with no right indent. v. In
Header option enter the
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enter the distance you want between the top of the page and the first line on the page. ii. In the Bottom option enter
the distance you want between the bottom of the page and the last line on the page. iii. In the Left option enter the
distance you want between the left edge of the page and the left edge of unindented lines.
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Right option enter the distance you want between the right edge of the page and the right end of a line with no right
indent.
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Header option enter the distance you want from the top edge of the paper to the top edge of the header. If the Header
setting is larger than the Top setting, Excel prints the body text below the header. vi. In Footer option enter the distance
you want from the bottom edge of the paper to the bottom edge of the footer. If the Footer setting is larger than the
Bottom setting, Excel stops printing the body text above the footer 8.
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distance you want from the top edge of the paper to the top edge of the header. If the Header setting is larger than the
Top setting, Excel prints the body text below the header. vi. In Footer option enter the distance you want from the

bottom edge of the paper to the bottom edge of the footer. If the Footer setting is larger than the Bottom setting,
Excel stops printing the body text above the footer 8.

Click on the Header/Footer tab to set the header and footer for the Worksheet. You will find the following dialog box.
Figure 8.16 9. Set the header by clicking on the Custom Header button. 10. Set the footer by clicking on the Customer
Footer button.
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Print Option For taking the printout, you have to select the print option of the file menu. After selecting the print option
from file menu the window given below will appear. You can set various options before taking printout. 197

Microsoft Excel 2000 Figure 8.17 i.
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From the Name combo box you can select the printer if

there are more than one printers installed on your system. ii.
MATCHING BLOCK 270/291 SA Computer Application.pdf (D166063658)

You can select the range of pages i.e. all pages or current page or number of pages you require from Print range frame.
iii From the print what option you can choose which part of a worksheet you want to print i.e. some selection or Entire
workbook or active sheets only. iv. You can choose number of copies

to be printed from Number of copies option under Copies frame. DATAENTRYANDEDITING

A cell contains the data entered by you. At any time, one cell is always highlighted which is called the currently active
cell. The address of this currently active cell is shown in the ‘Name' box, which lies in the upper left corner of the screen,
exactly above the column letter A. You can place your data in any portion of the worksheet. Move your cell pointer
wherever you want to enter your data,

in any portion of the worksheet. You can select

the cell either with the help of mouse pointer or you can move to that particular cell with the help of arrow keys.
Similarly, in order to select a group of continuous cells, take your mouse pointer

to

the cell from where you want your range to start. Click at that cell and then drag your mouse pointer diagonally to the
opposite corner, release the mouse pointer when the desired range is selected. All the cells in the range become
selected and highlighted. Range Operations There may be a situation when you have to perform a task on a single cell.
Performing this action is very simple. Just put the cursor on the cell and perform the task. But



198 Basic Computer Skills consider the situation when you have to perform the same action with a group of cells. Lets
Ogﬁgﬁg%e of deleting data in a group of cells. One way to delete text in all cells is that you can go to each cell and
lelolt; key until the entire text is deleted. But this is very tedious job to perform. A better solution for this is
to entire the range of the cells and then perform the action on the whole group of cells with single command i.e. if you
want to delete the text of entire range, then select the range of the cells and press &gt;del&lt; key only once. Making
Range of the Cells Selection of cells (or creating range of cells) can be performed in the following ways. 1. Selecting a
group of cells 2. Selecting a row 3. Selecting a column 4. Selecting the whole worksheet To select a group of cells: i.
Place the mouse pointer on the first cell from where you want to start the range Figure 8.18 ii. Press the left button of
mouse and drag it till the last cell up to which you want the range OR Place the cursor on the first cell from where you
want to start the selection and then press shift+arrow key till the last cell up to which you want the range (Figure 8.18).
To Select a row: i. Point the mouse pointer on the row number. ii. Click the left mouse button only once.
199 Microsoft Excel 2000 Figure 8.19 To select a Column i. Point the mouse pointer on the column Name. ii. Click the
left mouse button only once. Figure 8.20 To select entire worksheet i. Point the mouse pointer on the common point of
row and column i.e. before starting of rows and before starting of columns. ii. Click the left mouse button only once.
Figure 8.21
200 Basic Computer SkilsREVERSING/REAPPLYINGCOMMAND S Undo

MATCHING BLOCK 271/291 SA Computer Application.pdf (D166063658)

To reverse changes while editing undo command is used. To undo you can i. Click on the Undo option under Edit
menu OR
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Click on the Undo button on Standard toolbar OR iii. Press Ctrl+z. Redo If an undo has to

be performed on the
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last reversed action, this is known as Redo. To perform redo you can: i. Click on the Redo option under Edit Menu OR ii.
Click on the Redo button on Standard Toolbar OR iii. Press Ctrl+y

Cut and Paste Cut and Paste operations are used to move

the Contents of a cell or a range of cells to some other

location. To move the text, first we have to cut the text from its current location and then we have to paste it at the
desired new location. The procedure to move the text is being discussed in the following steps: To cut text or cells: i.
Select the cells or make the range of the cells as required ii. Select cut from
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Edit menu OR Click on the cut button of standard toolbar OR Press

the ctrl+x button OR Place the mouse pointer on the selected text, click right mouse button and select cut from the
context menu as shown in the Figure 8.22:

201 Microsoft Excel 2000 Figure 8.22 To Paste the Selection i. Place the cursor at the location where the text is to be
pasted ii. Select Paste from Edit menu OR Click paste button on the standard toolbar OR Press Ctrl + v Or Place the cell
pointer on the first cell of the new locatin. Click the right mouse button and select paste from the context menu as
shown in the Figure 8.23: Figure 8.23

202 Basic Computer Skills Copy and Paste

MATCHING BLOCK 276/291 w

Copying means duplicating the contents of the document at some other desired place. The procedure for copying text
is almost the same as that of moving text with a little difference, which is being discussed in following steps:

To copy a particular text i. Select the cell or make the range of the cells ii. Select copy from
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Edit menu OR Click on the copy button of standard toolbar OR Press

the ctrl + c button OR Place the mouse pointer on the selected text, click right mouse button and select copy from the
context menu as shown in Figure 8.24. Figure 8.24 Paste operation is same as described in the cut and paste section F I N
DREPLACEANDGOTOOPTIONS Find Sometimes while working on a Worksheet you need to find a particular
text. This is how you can find a particular text:

203 Microsoft Excel 2000 i. In
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the Edit menu, click Find. Find what dialog box will appear (Figure 8.25). ii. In the Find what box, enter the text that you
want to search for. iii. Select the direction of search from Search list box. iv. Select any other options that you want.
Match Case: To find the characters that are a word by themselves and are not a part of another word. Find Entire Cell
Only: To find the characters that are

SA
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In the Find what box, enter the text that you want to search for.

contained in a single cell and not spread over multiple cells. Figure 8.25 v. For Help on an option, click the question mark
and then click the option. vi. Click Find Next. vii. If you want to
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find similar word again in the rest of the document click on the Find next button. Replace If you have to replace a word
in the document with another word you can use find and replace command

to do that. i. On the Edit menu, click Replace. A dialog box will show up. ii.
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In the Find what box, enter the text that you want to search for.
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the Find what box, enter the text that you want to search for. iii. In the Replace with box, enter the replacement text. iv.
Select other options that you want. 204

Basic Computer Skills v. For Help on an option, click the question mark and then click the option. vi
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Click Find Next, Replace, or Replace All. vii To cancel a search in progress, press ESC. Figure 8.26 Goto To go to a
particular location or particular item use Goto option under the Edit menu.

Steps to do so are as follows: 1.
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Click on the Goto option under the Edit menu. Then the following window will appear on the screen.

Figure 8.27

205 Microsoft Excel 2000 2. Enter the parameter as page number or cell name in the reference text box. 3. Click on the
Ok button. Fill in a Series of Numbers, Dates or other Items (A utoFil |) 1. Select the first cell in the range you want to fill,
and then enter the starting value for the series. To increment the series by a specified amount, select the next cell in the
range and enter the next item in the series. The difference between the two starting items determines the amount by
which the series is incremented. 2. Select the cell or cells that contain the starting values. 3.

Drag the fill handle over the range you want to fill.

To fill in increasing order, drag down or to the right. To fill in decreasing order, drag up or to the left. Figure 8.28 Note:
Fill handle : ? The small black square in the corner of the selection.

When you point to the fill handle, the pointer changes to a black cross. To copy contents to adjacent cells or to fillin a
series such as dates, drag the fill handle. ? To display a shortcut menu that contains fill options, hold down the right
mouse button as you drag the fill handle. ? To specify the type of series, use the right mouse button to drag the fill
handle over the range, and then click the appropriate command on the shortcut menu.

206 Basic Computer Skills For example, if the starting value is the date JAN-2002, click Fill Months for the series FEB-
2002, MAR-2002, and so on; or click Fill Years for the series JAN- 2003, JAN-2004, and so on. ? To manually control
how the series is created, or use the keyboard to fill in a series, use the Series command. 4. In the Step value box, enter
the value that you want to increase the series by. In a linear series, the step value is added to the first starting value and
then added to each subsequent value. In a growth series, the first starting value is multiplied by the step value. The
resulting product and each subsequent product is then multiplied by the step value. 5. Under Type, click Linear or
Growth. 6. In the Stop value box, enter the value you want to stop the series at. Clear Command Clear command is used
to clear a cell from its contents, format, comments etc. Figure 8.29 1. Format: Clearing format means that if there is any
content with some format in the current cell then by issuing clear format command will clear only the format not its
contents. The content will remain same as it is but the format of the cell or the format of the content will be cleared. 2.
Contents: Clearing content means that if there is any content with some format in the current cell then by issuing clear
content command will clear that content only, not the formats. The format remains same as it is but the contents of the
cell will be cleared.

207 Microsoft Excel 2000 3. Comments: Clear Comments will clear the comments attached in a cell for reference. 4. All:
Clearing All means to clear all i.e. format, content, comments etc., whatever is there in the cell or in the range. Delete
Issuing Delete command from Edit menu will allow you four options for deletion. These are: 1. Delete cell and shift the
right cell in the place of current cell, which is going to be deleted. 2. Delete cell and shift the left cell in the place of
current cell, which is going to be deleted. 3. Delete the entire row. 4. Delete the entire column. Figure 8.30 Delete Sheet
Delete sheet command is used to delete the current sheet. Remember that once a sheet is deleted it can't be recovered.
So be careful while issuing this command to make sure that you actually want to delete the sheet. Move or copy
Worksheet A sheet can be copied or moved to the same workbook as well as to the other workbook. To do this the user
has to make use of the Move or copy sheet option from the edit menu.

208 Basic Computer Skills To copy or to move a worksheet, follow these steps. 1. Select the workbook from To book list
box in which you want to copy or move the current worksheet. 2. If you want to create a copy of the current work sheet
check mark the Create a copy option. Otherwise if you want to move the current worksheet, keep the Create a copy
option unchecked. 3. Press OK button. Figure 8.31 Vi e w View menu includes the following options: Figure 8.32

209 Microsoft Excel 2000 There are two different ways to view a work book. 1. Normal view: In this view the entire
worksheet is displayed with no reference to pagination. The print area is not specified. 2. Print Layout view: Shows you
what data will go on each page and lets you quickly adjust the print area and page breaks. In this view you can see the
page number as the background of the page. But it will not appear in the printout. Also in the page break view the view
of the page is limited up to the data i.e. up to the position where the data ends. Figure 8.33 Full Screen View If you like
working in a completely spick and span environment, you'll like the Full Screen view. To switch to this view, choose Full
screen option from view menu. Your document enlarges to cover the entire desktop. The title bar and toolbars in the
Excel window are temporarily hidden to give you as much room as possible to see your text. Full screen view of a
worksheet is given below. Figure 8.34
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210 Basic Computer Skills Zooming the Views The Zoom feature of MS-Excel lets you increase or decrease the size of
the display to make the text easily visible. The zoom percentage can be set between 10% and 400% of actual size. To set
the zoom percentage either use the Zoom box on the standard toolbar or the Zoom dialog box can be used. To zoom
the view using the Zoom box on the Standard toolbar: 1. Display the Standard toolbar if it isn't visible, using the Toolbars
command from the view menu. 2. Click the drop-down control of the Zoom box to display a list of zoom percentage. 3.
Select a percentage from the list or type a different percentage in the Zoom box as shown in figure Figure 835 W O R K |
NGWITHTOOLBARToolbar is a quicker way to issue a command. Excel comes with 14 toolbars. By default it
displays only two toolbars i.e. standard toolbar and formatting toolbar. One can display any toolbar from the other
fourteen toolbars or can hide any toolbar. To display or to hide a toolbar

100% MATCHING BLOCK 284/291 SA Computer Application.pdf (D166063658)

you have to perform the following steps. 1. Click on the

view menu. 2. Select the Toolbar option 3. This will display all the toolbar names. Toolbars that are currently displayed
have check marks in front of them and those, which are hidden, don't have any check mark. 4. Check mark the toolbar
name which you want to view.

211 Microsoft Excel 2000 5. Remove the check mark from toolbar name, which you want to hide. Figure 8.36 With the
format menu one can give a new format to cell, row, column or even worksheet and can have control over how they are
displayed or behave. Options of format menu are given below. Figure 8.37 Formatting Cells Different Cell Formats
Format a cell entry in a particular number format. To give a particular number format to a cell i. Select a range of cells on
which you want to apply a number format. ii. Choose Cell option from format menu.

212 Basic Computer Skills Figure 8.38 iii. Select the number format you want to apply on the cells or a range of cells. iv.
Adjust the Decimal places. v. Select the other settings. vi. Preview of the number can be seen from Sample Frame. vii.
Click on the Ok button. Formatting Alignment of the Cell To change the Alignment of the cell follow the following steps.
i. Select the cell on which you want to change the alignment. ii. Click on the Cell option from format menu. iii. Select the
Alignment tab. Figure 8.39

213 Microsoft Excel 2000 iv. Set the vertical and horizontal alignment. v. Select the orientation of the Text, e.g. set it to 45
degrees. Then the selected cell's text will rotate to 45 degrees upward. Figure 8.40 vi. In the option you can select the
wrap text to make the text to fit in one cell only if it is going outside the cell. It will adjust the text in one cell and in
multiple lines. Figure 8.41 vii. To fit the text within the cell without wrapping you have the option of shrinking text. It will
shrink the text within the cell. viii. To merge two or more cells select the cells and check mark the merge cell option and
press Ok button.

214 Basic Computer Skills Change the Formatting of the Text The format of the text (i.e. font, font size, font color, font
style etc.) can be changed as desired. To change the formatting of the text i. Select the cells in which you want to format
the text. ii. Select the Cell option from Format menui. iii. Select the Font tab. iv. Select the options you want to change. v.
Click on the Ok button. Figure 8.42 Formatting the Border Settings To change the format of the border of the cells i.
Select the cells for which you want to change the border formatting. ii. Choose the Cell option from the Format menu.
iii. Click on the Border tab. Figure 8.43

215 Microsoft Excel 2000 iv. Select the desired border and border styles. v. Click on Ok button. vi. Do it again with other
cells until your task gets completed. Changing the Pattern of the Cell To change the pattern of the cell i. Select the cells
for which you want to change the pattern. ii. Choose the Cell option from Format menu. iii. Select the Pattern tab. Figure
8.44 iv. Select the color and the pattern of the cells. v. Click on the Ok button. Figure 845

216 Basic Computer Skills Resizing of Columns and Rows Resizing of Row Height Sometimes it is needed to change the
row height according to the text due to certain reasons. To change the row height
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you have to follow these steps: 1. Put the cursor on the cell
whose row's height you want to change. 2. Drag the boundary below the row heading until the row is the height you

want. Or Select the height option from row option of format menu. Figure 8.46 3. Fill in the row height manually. Figure
847
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217 Microsoft Excel 2000 4. Press the OK button. The other options in row option of format menu are 1. Fit the contents:
To make the row height fit the contents, double-click the boundary below the row heading. 2. Hide and Unhide the
rows: Some times you may need to hide particular rows. To do so you have to follow these steps: i. Select the rows
which you want to hide ii. Choose the option Row under Format menu. iii. Select the Hide option Figure 8.48 iv. After
clicking the hide option the rows will be hidden. Figure 849 v. To again unhide these rows select the respective row and
click on unhide option.

218 Basic Computer Skills Resizing Column Width 1. Drag the boundary on the right side of the column heading until the
column attains the width you want. Or 2. Manually change the width: To manually change the width, select the column,
point to Column in the Format menu, click Width, and then enter a number in column width manually. Figure 8.50 The
result will be: Figure 8.51 3. Fit the contents: To make the column width fit the contents, double-click the boundary to
the right of the column heading. To do the same for all columns on the worksheet, click the Select All button, and then
double-click a boundary to the right of one of the column headings.

219 Microsoft Excel 2000 4. Copy a width: To copy the width of one column to another, select a cell in the column, click
Copy on the Standard toolbar, and then select the target column. In the Edit menu, click Paste Special, and then click
Column widths. AutoFormat Microsoft excel provides you some predefined formats of the table that be can applied to
your cells. To select the predefined formats of a table, perform the following steps: 1. Select the range to provide auto
format 2. Click the Format 3. Select the option AutoFormat. Figure 8.52 4. Select the format you want. 5. Select the
options you want. 6. Press Ok Button. Figure 8.53

220 Basic Computer Skills EXE R C | S E Fillin the Blanks: a. Microsoft Excelworksin ___________ environment. b. By
creating a file you can open a group of workbooks inonestep.c. _____________ will clear the
comments attached in a cell for reference. d. The zoom percentage can be set between 10% and _____________ of

actual size. Unsolved Questions 1. Differentiate between the Normal, Print and Web views of an Excel2000 worksheet. 2.
Describe the protection mechanism in Excel2000. 3. Is there a limitation on number of worksheets in a workbook? If yes
how many? 4. Explain the purposes of options available for ptinting a worksheet. How can the worksheet be printed
without the cell gridlines? 5. Explain the purposes of Custom header and footer. 6. Can a range of cells formed with non-
rectangular selection of cells? How? 7. Differentiate between Clearing content and Clear Format commands. 8. What
purpose is served by AutoFill command? 9. Explain the difference between deleting cells and a complete row. 10.
Comment on usefulness of Find and Replace commands. 11. Which aspects of a cell or a range of cells may be
formatted? 12. Write a short note on formatting of rows and columns. 13. What is conditional formatting? What is the use
of conditional formatting? 14. Explain the purpose of auto format?

INTRODUCTIO N There is computer in the car you drive, there could be a PC on your desk or your study table at
home. The weather report you get daily also involves computer but all of them do not fall into the same category. They
are different by means of hardware, software, built purpose and everything. Initially computers were classified on the
basis of their size, speed and cost but now there are many more attributes attached to them. Each and every computer
must fall in one of the four categories described below: 1. Supercomputer 2. Mainframe computer 3. Mini computer 4.
Micro computer Whereas super computers are most powerful and largest, micro computers are the smallest ones.
Supercomputers are the most powerful computer available today. It is another thing that microcomputer of 21st century
might be as powerful as of super computer of today. Today technology is developing so fast that it has become difficult
to predict anything for the future. Although all the above four computers have been around for quite some time but the
capabilities of each type have changed tremendously. Supercomputers are highly sophisticated computers used for very
special tasks like scientific researches etc. Mainframes are large and expensive and are designed to meet the needs of a
large organization. Minicomputers, although smaller than mainframes, are still big enough to cater to a medium sized
organization or a small- scale business. PCs or the microcomputers solely cater to individuals. Microcomputers
Classification of Computers UN T 9

LEARNINGOBJECTIVES After completing this unit, you will be able to understand: ?

Introduction ? Work Stations and Personal Computers
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222 Basic Computer Skills could be PCs or the desktops or laptops or even the notebooks. All the computers around us
like those in microwave ovens, washing machines, automobiles etc. are embedded computers which are special purpose
and are generally used to perform control functions. Super Computers These are the most powerful computers made till
now. They are made to process huge amounts of data. Many users can access them at the same time. They are primarily
used for scientific research that are mathematically intensive such as in aerospace, satellites, chemical, electronics,
petroleum, nuclear power industries. Supercomputers are used in weather forecasts. It would not have been possible to
warn the people around the coastal areas when there would be a hurricane but for a computer. It is because of
computers only that such a large scale devastation can be controlled well in time saving human lives of financial and
infrastructural resources. Computers are also found in public, private and government research centres such as
universities, government labs and R&D departments of organizations. One main area where these supercomputers are
used is when nuclear fissionable material approaches a critical mass, the researchers are required to know what is
happening at every nanosecond of the nuclear chain

reaction. A supercomputer can monitor the actions and reactions of million of atoms when they interact.

Another main area where supercomputers were used was to find out the pollution in Los Angeles. The model comprised
of more than 5,00,000 variables including geographic elevation, temperatures, airborne chemicals etc. and it was
required to create an accurate simulation of Los Angeles Basin to decide upon various strategies to be used to control air
pollution. This would have taken months with less powerful computers but supercomputers did it in just half an hour.
Figure 9.1

223 Classification of Computers The 1st supercomputer was built in 1960's for US Department of Defense. That was
supposed to be the fastest and most powerful computer of that time. Millions of dollars are being spent on R&D of the
technology enhancement of supercomputers. The main feature of supercomputer is multiprocessing that enables the
computer to perform number of operations simultaneously. The first supercomputer had 4 CPUs. Today's
supercomputers have hundreds of processors. The speed of supercomputer is measured in nanosecond and gigaflops.
Nanosecond (10-9 of a second), Gigaflop (1 billionth floating-point arithmetic operation per second). A supercomputer
can perform upto 128 gigaflops. Market and R&D leaders of supercomputers include IBM, Silicon Graphics, Cray
Research Corporation, Fuifitsy and Intel, Thinking Machines etc. Thinking Machines has produced a supercomputer
called Connection Machine, which has over 64,000 processors. Its price is about $5 million. Supercomputers are priced
from $2 million to $20 million and they consume electricity enough to lighten about 100 homes. Mainframes
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The largest type of computer commonly used is mainframes. Mainframe computers are used where many people in a
large organization need frequent access to the same information, which is usually organized

information of one or more large databases. After UNIVAC | was sold in 1951, the mainframes caught attention of the
computer industry. IBM, the computer giants captured the mainframes market in late 1950's and made their name and
money in mainframes market. A mainframe computer system is generally made up of several computers, called terminals
(

A terminal is a keyboard and a screen wired to mainframe. It does not necessarily have its own CPU or storage it

just Figure 9.2

224 Basic Computer Skills has input and output devices that functions as the windows of the computer placed
elsewhere), in addition to the mainframes, or host processor. The host processor is responsible for controlling rest of the
processors, operations and the peripheral devices attached to it. A front-end processor is the one who handles
communication to and from all the remote terminals connected to the computer system. At times, a backend processor
is also used to handle data retrieval operation. Although host computer is capable of doing all the operations by itself but
it is still better to have rest two processors to share the load and saving time and increasing speed. Figure 9.3 The
mainframe computer has processor that handles input, controls the database and output needs of the terminals attached
to it. Each user has access to the contents of database. It is difficult to store such massive amount of data and it would be
too slow also. Many modem MFS have multiprocessing capabilities however they are generally limited to 8 or less
processor. They are slower than supercomputer and their speed is measured in megaflops and not in gigaflops.
Mainframes can cost anything above $35,000.
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entire roof$"Gr even an entire floor of a high rise building. Typically, they were placed inside glass offices with special
air conditioning to keep them cool and on raised floors to accommodate all the wiring needed to tie the systems
together. This setup is not used anymore. Mainframes today,

look more like a file cabinet although they still need the same type of environment. These computer can support upto
several hundred user simultaneously. It supports all of them by keeping number of programs in primary memory and
rapidly switching backs and forth between programs. These operations are so fast that users even do not come to know
that it is working on others tasks. This property of processing many tasks concurrently for multiple user's called as
"multiprogramming”. No one really knows from where this

term mainframe originated from. Earlier IBM documents define the term frame as an integral part of a computers: "the
housing .... Hardware supports structures, .... And all the parts and components

there in". It was only when computer of various sizes and shapes came into existence, the big computers were referred
as mainframes and eventually became one-word mainframes.

225 Classification of Computers Minicomputers This era started in 1960's when DEC (Digital Equipment Corporation)
began shipping its PDB series computer, the press name them as minicomputer because of their small sizes as compared
to other prevailing computers. The easiest way to explain minicomputer is that they lie somewhat in between
mainframes and microcomputer. They can handle a great amount of data like mainframe. It can also support number of
terminals. Although they are also designed for 100's of terminals, but they differ in speed i.e. minicomputers are slower
than mainframes and they can not supports as many terminals as a mainframe can. They have less storage capacity and
their printers too are slow. They are meant for smaller organizations which can neither afford mainframe's nor do they
require such big computer. They range from $18,000 to $50,000. The major manufactures of minicomputers are DEC,
Data General, IBM and Hewlett Packard. WO RKSTATIONSANDPERSONALCOMPUTERS Clients and Ser
vers A configuration in which several workstations/PCs are interconnected by a communication network is called a
distributed computer system. A common use of distributed computers is the so-called client-server computing. In this
mode several specialized-services are provided by servers. For example, there may be workstations providing high speed
CPU for numeric intensive programs, another with high speed printers, third with plotters and a fourth with a large disk to
store big files. A user having a PC or a smaller workstation may do some local computing, debugging, etc., and may then
requisition the services of the other workstations for storing files, providing language translators and carrying out
intensive numeric computing. The workstation requisitioning services is called the client and the workstation providing
the services is known as a server. Sometimes there are problems requiring either large storage or high speed processing
which cannot be solved using it may be single workstation in a network. In such a case it may be possible to get a set of
workstations connected in the network to cooperate and solve the problem. In a client-server computer system it often
happens that many workstations are not fully utilized; either they are idle because no one is presently logged on or the
user may be doing task such as editing or word processing which does not use the available computing power. In such a
case a user requiring more CPU resources than what he has in his workstation can steal CPU cycles from idle processors
to do his job. Software systems have been designed which permit this. The client-server computing system allows only
one message to be communicated between two computers at a time. The network is usually a Local Area Network.

226 Basic Computer Skills When working on minicomputer and mainframes through the terminals, the users can just
control the input and output of the computer. Whereas a single user computer gives you the power of controlling the
total processing cycle i.e. input and output, processing and storage, you can select your own programs and do not need
to be dependent on mainframes or mini's for storage. They are designed to meet the needs of an individual and thus
called as Personal Computer also. Terms PC and microcomputers are interchangeable. When we talk about computers
today, we generally mean a PC or a microcomputer. Microcomputers have a great impact on the computer industry. Till
1975, they did not even exist and in 1995 the sale of PC was $16 billion. Microcomputers are the fastest growing segment
of computer industry. One of the sources of the PC's popularity is the rate at which improvements are made in the
technology. As the technology is growing, microprocessor, memory, chips and storage devices keep getting faster and
better and bigger. Today, a typical PC (
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that is at least 100 times faster than a PC 10 years earlier. Analysts believe that the pace of this growth will be same for
another 20 years. In 1981, IBM called its first microcomputer the IBMPC. Within few years there were many more
companies in the race to design computer compatible to IBMPC. Thus the term IBMPC became the name of the family
of computer that included IBM's and IBM compatibles. The vast majority of computers fall in this family except Apple
Macintosh. It is another family of microcomputer made by Apple computer. It is appropriate to say that Macintosh is
personal computer but not a PC. Presently IBM has about 28 percent of the market where as Apple holds about 8
percent of market share. Figure 9.4 Few years ago, Apple computers, IBM and Motorola joined to develop the Power PC
chip, which enables Apple computer to run IBM applications and vice versa. Most Apple Macintosh computer and
compatible computers are based on this chip.

227 Classification of Computers Single computer can actually fall into category of either microcomputer or workstation.
A workstation is a powerful desktop computer designed to meet the computing needs of engineers, architects and other
professionals, who need graphic display. Workstations are generally used for CAD (Computer Aided Design) applications.
For this type of complex programs the computer needs great processing power and much storage. They are also used as
services for LANs (Local Area Networks). Workstations are sometimes called "Supermicros”. Although they look like
desktops but the chip inside is different. Most workstation use RISC (Reduce Instruction Set Computer ) microprocessors.
RISC processors are used in special purpose applications, where speed is criticle. Now boundary between workstations
and PC is becoming less distinct. Today's PCs are better than workstations of past. Pentium pro has multiprocessing
capabilities. Most microcomputers support multitasking (enabling the user to switch between the tasks). Multitasking
saves a lot of time. The user can open another activity when one activity task is being processed, for example till the
computer is down loading one thing in the browser, user can open another window for writing a mail (say notepad) or a
calculator to perform some calculation. This not only saves time but rescues also. One style of PC is desktop. These type
of computer are small enough to fit on a desk but are too big to carry around. There are number of models in desktops.
The cabinets come in flat (horizontal) and vertical (tower model) depending upon the space management of the user.
Laptop Computers They were the first portable computer and weighed about 28 pounds. Infact they were called
"luggables” initially. As the size reduced the term also changed to "laptop”. They weigh about 10 to 12 pounds. The name
was probably given because they are used by keeping it on the laps while users are on move (in a car, an airplane or
train). Figure 9.5 Notebook Computers As the name suggests, their size is about 8.5 by 11 inch and can easily fit inside a
briefcase. They were initially called laptops only but gradually as the size decreased

228 Basic Computer Skills smaller ones were called notebooks. They can be operated on batteries also. They are fully
functional microcomputers. They can have input devices Hard Disk Drives, Floppy Disk Drives, a CD-ROM, a modem and
an inbuilt mouse. Personal Digital Assistants (PDA's) These are the smallest portable computers and are no bigger than
chequebooks. They all also called palmtops. They are not as powerful as notebooks and laptops. They are used for some
special applications like keeping record of phone numbers, dates, agendas and calculations. They can be connected with
large computer to exchange data. They also come with electronic pen that lets user write on a touch- sensitive screen.
The latest PDA's can use infrared light to communicate with nearby computers. They may also have built in fax, cellular
phones, faxes and e-mails. Figure 9.6 They are meant for the people who avoid carrying lot of weight and do not need
the full collection of applications while away from home or office. These computers use inexpensive batteries. They do
not have any disk drivers. They use PC card, a card of a size of credit card, to store programs and data. Notebook and
desktop computers now adopt these PC cards also. They are version of smart cards, small cards developed in France.
They were earlier used to pay highway tolls, making STD calls, to pay bills etc. A smart card has a microprocessor and a
memory chip. Figure 9.7

229 Classification of Computers Embedded Computers Have you ever noticed that computer everywhere surrounds
you. Be it your car, kitchen, bathroom, entertainment and everywhere. You start using computers the time you get up in
the morning and keep using it till you go off to sleep. These type of computers, which are working inside another
machines, are called embedded computers. Cars use computer to control the engine, alarm clocks use these computers
and to wake you up VCR and TV's also use computers. The users do not even realize while using these equipments that
they are using the embedded computers. EXER CISEFillintheBlanks:a. ____________ are used for scientific
research etc. b. A mainframe computer system is generally made up of several computerscalled ____________ . C.
Workstations are sometimes called ____________ . d. Laptop were the first portable computer and weighted above
____________ pounds. Unsolved Questions 1. Define the following: ? Mainframe Computers ? Super Computers ?
Micro Computers 2. Write a note on workstation and personal computers.
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Computer components can be broadly divided into two
categories - Hardware and Software. Hardware refers to
any physical component of a computer. For example,
CPU, Monitor, Keyboard, Hard Disk, Floppy Disk etc. are
physical components and thus, are hardwares. Software
refers to the programs which are required to operate the
computer. For example, DOS (Disk Operating System),
BASIC, COBOL, dBASE, An Accounting Software etc. are
all softwares. An analogy of hardware can be the book
which you are reading and then software would be the
text written on this book. Another analogy could be -
‘brain’ is a hardware but ‘'memory stored in brain’is a
software. Both hardware and software are dependent on
each other. CPU, Memory Unit, Hard Disk etc. are useless
unless they are provided with instructions and data for
storage and processing. Similarly, BASIC or COBOL
language has no
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board, hence it is like
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motherboard by different packing methods. There are
three different types of packing of RAM chips - DIP, SIMM
and SIPP. DIP (Dual Inline Package) is the most common
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sides. SIMM (Single Inline Memory Module) packing
contains a number of chips soldered on an expansion
board having an edge connector. SIPP (Single Inline Pin
Package) is similar to SIMM, but uses pin rather than an
edge connector. Expansion slots are connectors on
motherboard where expansion cards like display card,
hard disk controller card etc. can be connected. I/O
interface is the channel between the CPU and peripheral
devices (keyboard, monitor etc.).
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The lower spherical ball moves in a socket. The joystick
can be moved in all four directions. The function of
joystick is similar to that of a mouse. It is mainly used in

Computer Aided Designing (CAD) and playing computer
games.
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or pencil. It is used where one out of a few alternatives is
to be selected and marked. It is especially used for
checking the answer sheets of examination having
multiple choice questions.
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time. These printers are again of two types - Daisy Wheel
and Dot Matrix Printers. Daisy Wheel Printers: These
printers print the characters by a mechanism that uses a
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characters are embossed on the radiating spokes and
printed by striking these spokes against the ribbon and
paper. Daisy Wheel printers give a good quality but they
are more expensive than Dot Matrix printers.

93% MATCHING TEXT 76 WORDS
Character Printers: These printers print one character at a
time. These printers are again of two types Daisy Wheel
and Dot Matrix Printers. Daisy Wheel Printers these
printers print the characters by a mechanism that uses a
plastic or metal hub with spokes, called daisy wheel. The
characters are embossed on the radiating spokes and
printed by striking these spokes against the ribbon and
paper. Daisy Wheel printers give a good quality but they
are expensive than Dot Matrix printers. Printers

W https://www.docsity.com/en/computer-applications-in-management/2326921/



Ouriginal

by Turnitin

83/291 SUBMITTED TEXT
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putting dots onto the paper. They do not give better
printing quality than daisy wheel printers, but are faster in
speed. The printing speed of a dot matrix printer can be
upto 360 cps (characters per second). They are widely
used with microcomputers in most of the offices.
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without striking against the ribbon and onto the paper,
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Laser Printers: These printers look and work like
photocopiers. They are based on laser technology, which
is the latest development in high speed & high quality
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the image on a paper. First, the image is formed by
electrically charging thousands of dots on a paper by
laser beam. Then, the paper is sprayed with a toner
having the opposite charge and is passed over a heated
roller to make the image permanent. Laser printers are
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with electrically charged ink. These printers give better
quality than character printers but not better than laser
printers. They are cheaper than laser printers, hence used
widely in many offices. They also offer an option of using
colour cartridges for multi-colour printing. iii. Thermal
Printers: These printers print the characters by melting a
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tremendous savings in paper and document handling
costs.
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working of hardware and aid in effective execution of a
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editing, storage management, resource accounting, 1/O
management, database management, etc. Some of the
examples of system software are DOS (Disk Operating
System), Windows, BASIC, COBOL and PC TOOLS. These
software are developed by System Programmers. Types
of System Software System software can be further
categorised into following three types: i. System
Management Software (Operating Systems, DBMSs,
Operating Environments) ii. System Development
Software (Language Translators, Application Generators,
CASE Tools) iii. System Software Utilities
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applications. Oracle Used for development of relational
database applications on any operating environment.
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Environment’ which lets the application program to
interact with CPU and 1/O devices. Many application
software require DOS for running. The common among
these are word processors like Wordstar, Professional
write; spreadsheet programs like Lotus 123, VP Planner
Plus; accounting software like Tally, EX, etc. Each
software package has a specific command to get itself
running on DOS. For example, in order to run the
spreadsheet program, Lotus 123, you will have to enter
123 at the DOS prompt. DOS will run Lotus 123 for you.
Once any application software shuts down, the control
again has to come back to DOS and the DOS prompt can
be seen again on the screen. Now, DOS is ready to
accept more commands from you. MS DOS (Microsoft
Disk Operating System), a product of Microsoft
Corporation of USA., is the most popular operating
system for PCs. Another operating system available in the
market is the PC DOS, a product of IBM, which is almost
similar to MS DOS. Whether you use MS DOS or PC DOS,
the basic commands of DOS remain the same.
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C:\&lt; or A:\&lt; is the DOS Prompt. Looking at DOS
Prompt, you can easily make out the currently active
drive. If you want to switch yourself over to another drive,
then simply type its drive letter after the prompt and hit
the &gt;Enter&lt; key as shown below: C:\&lt;A:
&at;Enter&lt; A:\&lt;_ Now again if you want to go back
to the C drive, then type in C: and hit the &gt;Enter&lt;
key.
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be unique. A look at a few valid and invalid filenames:
VALID INVALID MYHUNT MY BOOK.DOC DRAGON.TXT
B.R.ARORA UPHILL.UP S?JAIN.BAS VIJAYA EXCELBOOKS
EMPLOYEE.EMP ANURAG*.* 157.IN VICKY.MEHTA The
rules for naming a directory are the same as that of
naming files.
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A number (0-9) 3. Special characters such as: S, #, &, @, |,
%, (), -, {.}." A etc. except *, ?, full stop (.) and space ().
It is a good practice to give meaningful names to your
files. However, no two files can have exactly the same
name on the disk. Thus, a name given to a file on a disk
has to be unique. A look at a few valid and invalid file
names: VALID INVALID MYHUNT MY BOOK.DOC
Dragon.Txt B.R. Arora Uphill.up S?JAIN.BAS VIJAYA
EXCELBOOKS Employee.Emp ANARAG.** 157.IN
VICKY.MEHTA The rules for naming a directory are the
same as that of naming files.
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DOS offers a variety of commands to perform various
functions. With the help of DOS commands, you can
display the list of files and directories that are present on
the disk, create new files and directories, remove
unwanted files and directories and much more. DOS
commands can be entered either in uppercase or
lowercase letters. The format of a DOS command is
called syntax. All DOS commands begin with command
name. When DOS carries out the instructions given by
you, it is called the execution of DOS command. Let us
discuss some of the DOS commands in detail. 104
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functions. With the help of DOS commands, you can
display the list of files and directories that are present on
the disk, create new files and directories, remove
unwanted files and directories and much more. DOS
commands can be entered either in uppercase or
lowercase letters. The format of a DOS command is
called syntax. All DOS commands begin with command
name. When DOS carries out the instructions given by
you, it is called the execution of DOS command. Let us
discuss some of the DOS commands in detail. (
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Directory Commands of DOS The directory commands
help you to create new directories and remove existing
ones. They also allow you to travel from one directory to
another. You can also view the listing of files and
directories that are present on the disk. Displaying a List
of Files on the Disk — DIR Command This particular DOS
command helps you in displaying a list of files or
directories present on
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disk. Thus, to see the contents of your hard disk, issue the
following command: C:\&lt;DIR &gt;Enter&lt;
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windows are Windows 1.x, Windows 2.x, Windows 3.0,
Windows 3.1, Windows 3.11, Windows for Workgroups
3.11, Windows 95, Windows 98 and Windows NT.
Windows 1.
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Volume in drive C has no label Volume Serial Number is
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If you wish to view the contents of the floppy drive, then

you
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If you wish to view the contents of the floppy drive, then
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First switch yourself to the floppy drive and then issue the

DIR command.
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first switch yourself to the floppy drive and then issue the
DIR command
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if you wish to view the contents of the sub-directory
EXPENSE, issue the following command: C:\&lt;DIR
\EXPENSE &gt;Enter&lt;
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If you wish to view the contents of the sub-directory
EXPENSE, then issue the following command: C\&lt;DIR
\EXPENSE &gt;Enter&lt;
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Let us assume that there is one more sub-directory by

the name BUSINESS existing under EXPENSE. To view the

contents of this sub-directory, issue the following

command: C:\&lt;DIR \EXPENSE\BUSINESS &gt;Enter&lt;
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Let us assume that there is one more sub-directory by
the name BUSINESS existing under EXPENSE. To view the
contents of this sub-directory, issue the following
command: C:\&lt;DIR \EXPENSE\BUSINESS &gt;Enter&lt;
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If you have a large number of files on the disk, then on
issuing DIR command, the screen scrolls up and only a
few filenames are shown. In such a case, issue the
following command: C:\&lt;DIR/P &gt;Enter&lt; This
command will show the contents of the disk pagewise.
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If you have a large number of files on the disk, then on
issuing, DIR command, the screen scrolls up and only a
few file names are shown. In such a case, issue the
following command: C:\&lt;DIR/P &gt;Enter&lt; The
above command will show the contents of the disk
pagewise
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if you are interested only in seeing the filenames, issue
the following command: C:\&lt;DIR/W &gt;Enter&lt; This
command shows the names of files and directories
widthwise. So, in one line only five names of files and
directories are shown. The other details like the size of
file, the 106
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if you are interested only in seeing the file names, then
issue the following command: C:\&lt;DIR/W &gt;Enter&lt;
The above command shows the names of files and
directories widthwise. So, in one line only five names of
files and directories are shown. The other details like the

size of file, the
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date and time of each file creation are not shown. The
directories are shown in square ([ ]) brackets. Making a
Directory — MD Command In the earlier part of this
chapter, we discussed that all the related files should be
clubbed at one place, called a directory or sub-directory.
So, to club all the related files under one head, new
directories and sub-directories have to be created. Let us
create a new sub-directory by the name INCOME under
the Root directory. The following command can achieve
this: C:\&lt;MD INCOME &gt;Enter&lt; where MD stands
for Make Directory Further, let us create another sub-
directory by the name HOSPITAL under the sub-
directory INCOME. C:\&lt;MD INCOME\HOSPITAL
&at;Enter&lt; Removing a Directory — RD Command With
times, certain directories grow old and are no more
needed. It is better to delete such directories because
they can save
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date and time of each file creation are not shown. The
directories are shown in square ([]) brackets. 2. Making a
Directory: MD Command In the earlier part of this unit,
we discussed that all the related files should be clubbed
at one place, called a directory or sub-directory. So, to
club all the related files under one head, new directories
and sub-directories have to be created. Let us create a
new sub-directory by the name INCOME under the Root
directory. The following command can achieve this:
C:\&lt;MD INCOME &gt;Enter&lt; where MD stands for
Make Directory. Further, let us create another sub-
directory by the name HOSPITAL under the sub-directory
Income. C:\&lt;MD INCOME\HOSPITAL &gt;Enter&lt; 3.
Removing a Directory: RD command With time, certain
directories grow old and are no more needed. It is better
to delete such directories because they can save
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many precious bytes on the disk. So, let us delete the
sub-directory HOSPITAL with the following command:
C:\&lt;RD INCOME\HOSPITAL &gt;Enter&lt; where RD
stands for Remove Directory A directory or a sub-
directory has to be essentially empty before removing it.
For example, in order to remove the sub-directory
HOSPITAL, there should not be any directories and files
under it. So, you must first delete all the files and remove
all the sub-directories present under the sub-directory
HOSPITAL before removing it. We will discuss the method
for deleting files
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sub-directory HOSPITAL with the following command:
C:\&lt;RD INCOME\HOSPITAL &gt;Enter&lt; where RD
stands for Remove Directory A directory or a sub-
directory has to be essentially empty before removing it.
For example, in order to remove the sub-directory
HOSPITAL, there should not be any directories and files
under it. So, you must first delete all the files and remove
all the sub-directories present under the sub- directory
HOSPITAL before removing it. We will discuss the method
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CD Command Let us again refer to the Figure 5.1.
Suppose you are under the EXPENSE sub-directory and
you want to access the files or directories in the
ACCOUNT sub-directory. This would involve the
changing of directory from EXPENSE to ACCOUNT. This
will make the ACCOUNT directory active. The task of
changing directories can be accomplished with the help
of CD command. Look at the following example:
C:\&lt;CD ACCOUNT &gt;Enter&lt; where CD stands for
Change Directory The above command will take you to
the sub-directory ACCOUNT as shown by following
prompt: C:\ACCOUNTé&lt;_ 107
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CD command Let us again refer to the Figure 2.2.
Suppose you are under the EXPENSE sub-directory and
you want to access the files or directories in the
ACCOUNT sub-directory. This would involve the
changing of directory from EXPENSE to ACCOUNT. This
will make the ACCOUNT directory active. The task of
changing directories can be accomplished with the help
of CD command. 46 Computer Application in
Management Look at the following example: C:\&lt;CD
ACCOUNT &agt;Enter&lt; where CD stands for Change
Directory The above command will take you to the sub-
directory ACCOUNT as shown by the following prompt:
C: \ACCOUNT®&t;
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If you want to go to the sub-directory CASHSALE straight
from the sub-directory EXPENSE, issue the following
command: C:\&lt;CD ACCOUNT\CASHSALE &gt;Enter&lt;
After the above command, the following prompt will
come: C:\ACCOUNT\CASHSALESLt;_ The command for
going to the root directory from the above prompt is:
C:\ACCOUNT\CASHSALESt;CD\ &gt;Enter&lt; But, the
command for going to the parent or previous directory
(whether it is root or sub-directory) is:
C\ACCOUNT\CASHSALESIECD.. &gt;Enter&lt; If you are
in the sub-directory CASHSALE, the above command will
take you to ACCOUNT sub-directory as shown below:
CA\ACCOUNTSE;
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If you want to go to the sub-directory CASHSALE straight
from the sub-directory EXPENSE, issue the following
command: C:\&lt;CD ACCOUNT\CASHSALE &gt;Enter&lt;
After the above command, the following prompt will
come: C:\ACCOUNT\CASHSALESLt; The command for
going to the root directory from the above prompt is:
C\ACCOUNT\CASHSALESt;CD\ &gt;Enter&lt; But, the
command for going to the parent or previous directory
(whether it is root or sub-directory) is: C: \ACCOUNT\
CASHSALESL;CD.. &gt;Enter&lt; If you are in the sub-
directory CASHSALE, the above command will take you
to ACCOUNT sub- directory as shown below: C:
\ACCOUNT®&t;
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FILE COMMANDS OF DOS DOS offers a number of
commands for performing various operations on your
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File Commands of DOS DOS offers a number of file
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At times, you may have to work on some other machine.
So, this involves copying files from one disk to another.
Copying of files can happen from hard disk to floppy or
vice- versa. Files can also be copied onto the same disk
with a different name. The COPY command helps us to
accomplish all these tasks. The syntax of the copy
command is: COPY &gt;Source drive&lt;: (File spec 1)
&gt;Target drive&lt;: (File spec 2) where, Source drive
refers to the drive from where the file has to be copied. It
can be A, B or C. "File Spec 1' refers to the path from
where the file that has to be copied. ‘Target drive' refers
to the drive where the file is going to be copied. ‘File Spec
2' refers to the destination where the file is going to be
copied. 108 Basic Computer Skills Copying a File to
another Drive under the Same Name A file can have the
same name if it is stored on different disks. Thus, to copy
a file by the name SCENE from hard disk to floppy disk,
issue the following command: C:\&lt; COPY C:SCENE
A:SCENE &gt;Enter&lt; After the
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At times, you may have to work on some other machine.
So, this involves copying files from one disk to another.
Copying of files can happen from hard disk to floppy or
vice-versa. Files can also be copied onto the same disk
with a different name. The COPY command helps us to
accomplish all these tasks. The syntax of the copy
command is: COPY &gt;Source drive&lt;: (File spec 1)
&gt;Target drive&lt;: (File spec 2) Where Source drive
refers to the drive from where the file has to be copied. It
can be A, B or C. 'File Spec | refers to the path from
where the file that has to be copied. ‘Target drive' refers
to the drive where the file is going to be copied. ‘File Spec
2' refers to the destination where the file is going to be
copied. (i) Copying a file to another drive under the same
name: A file can have the same name if it is stored on
different disks. Thus, to copy a file by the name SCENE
from hard disk to floppy disk, issue the following
command: C: \&lt; COPY C:SCENE A:SCENE
&at;Enter&lt; As the
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drive can be very easily avoided. On similar grounds, if the
filename remains unchanged then there is no need
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copied from the active drive, then there is no need to
specify the source drive in the above command. On
similar grounds, if the file name remains unchanged then

there is no need

W  https://www.docsity.com/en/computer-applications-in-management/2326921/

SUBMITTED TEXT 40 WORDS
specify it after the target drive. Thus, the above command
can also be given in the following way: C:\&lt; COPY
SCENE A: &gt;Enter&lt; Copying a File to another Disk
under a Different Name The name of the file can be
changed very easily while copying.
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specify it after the target drive. Thus, the above command
can also be given in the following way: C:\&lt; COPY
SCENE A: &gt;Enter&lt; (i) Copying a file to another disk
under a different name: The name of the file can be

changed very easily while copying.
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The following command copies the file SCENE from the
hard disk onto floppy disk by the name SERENE.
C:\&lt;COPY SCENE A:SERENE &gt;Enter&lt;
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The following command copies the file SCENE from the
hard disk onto floppy disk by the name SERENE. C:

\&lt;COPY SCENE A:SERENE &gt;Enter&lt; 49
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the following command: C:\&lt;DIR O *.* &gt;Enter&lt;
The above command will list the
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the following command: C:\&lt;DIR/P &gt;Enter&lt; The
above command will show the
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hard disk to floppy, issue the following command:
C:\&lt;COPY \EXPENSE\*. A: &gt;Enter&lt; The
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hard disk to floppy disk, issue the following command: C:
\&lt; COPY C:SCENE A:SCENE &gt;Enter&lt; As the
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giving the above command, the following message will
come on the screen: Are you Sure (Y/N)?_ Press "Y' if you
really want to delete all files otherwise press any key.
Never try the above command on root directory of hard
disk, otherwise your most important DOS file
COMMAND.COM will also be deleted and thereafter you
will not be able to boot the 112
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giving the above command, the following message will
come on the screen: Are you Sure (Y /N)? _ Press "Y' if
you really want to delete all files otherwise press any key.
Never try the above command on root directory of hard
disk, otherwise your most important DOS file COMMAND.
COM will also be deleted and thereafter you will not be
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the directory and file commands of DOS. Now, let us
make ourselves familiar with other commonly used
commands. Displaying and/or Changing the
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the directory and file commands of-DOS. Now, let us
make ourselves familiar with other commonly used

commands. (A) Displaying and/or changing date: The
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C:\&lt;DATE &gt;Enter&lt; After issuing the above
command the following screen appears: C:\&lt;DATE
Current date is Thu 11-12-98 Enter new date (mm-dd-
yy):_ So, key in the new date in 'month-date-year’
format. However if you do not want to change this date
simply hit the &gt;Enter&lt; key. The current date will be
taken as new date.
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C:\&lt;DATE &gt;Enter&lt; After issuing the above
command the following screen appears: Current date is
Thu 11-12- Enter new date (mm-dd-yy):_ So, key in the
new date in ‘month-date-year' format. However if you do
not want to change this date simply hit the &gt;Enter&lt;

key. The current date will be taken as new date. (
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and/or Changing the Current Time — The Time
Command The TIME command is used to display and
change the current time. C:\&lt; TIME &gt;Enter&lt; On
issuing this command, the following screen appears:
C\&lt, TIME
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and/or changing the current time: The TIME Command
The TIME command is used to display and change the
current time. C: \&lt; TIME &gt;Enter&lt; On issuing this

command, the following screen appears: Current time
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Current time is 11:05:10:01 Enter new time:_ Enter the
new time in hours: minutes: seconds format. Hit the
&at;Enter&lt; key if you do not want to change the time.
The new time can also be specified along with TIME
command. C:\&lt;

100% MATCHING TEXT 36 WORDS
Current time is 11:05:10:01 Enter new time: Enter the new
time in hours: minutes: seconds format. Hit the

&gt Enter&lt; key if you do not want to change the time.
The new time can also be specified along with TIME

command. (C)
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Clearing Screen — The CLS Command In order to clear
the cluttered and clumsy screen, issue the CLS
command. This will remove the contents shown on your
screen thus making it look neater and cleaner. The CLS
command is given in the following manner. C:\&lt;CLS
&at;Enter&lt; Creation
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Clearing screen: The CLS Command In order to clear the
cluttered and clumsy screen, issue the CLS command.
This will remove the contents shown on your screen thus
making it look neater and cleaner. The CLS command is
given in the following manner. C:\&lt;CLS &gt;Enter&lt;

(D) Creation 01
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a New File — The COPY CON Command Text Files can be a new file: The COPY CON Command Text Files can be
created created
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COPY CON command. Look at the following example: COPY CON command. Look at the following example:
C:\&lt;COPY CON HELLO.TXT &gt;Enter&lt; This C:\&lt;COPY CON HELLO.TXT &gt;Enter&lt; 50 Computer
command tells DOS to copy the information from the Application in Management This command tells DOS to
keyboard or console and put it in the file HELLO.TXT. On copy the information from the keyboard or Console and
issuing the command the following screen appears: put it in the file HELLO.TXT. On issuing the command the
C:\&lt;COPY CON HELLO.TXT _ You will find a blinking following screen appears: C:\&lt; COPY CON HELLO.TXT
cursor in the second line. Enter the text and terminate _ You will find a blinking cursor in the second line. Enter
each line by pressing &gt;Enter&lt; key as illustrated the text and terminate : each line by pressing
below: My first DOS file. The name given to this file is &at;Enter&lt; key as illustrated below: My first DOS file.
Hello.Txt. &gt;Enter&lt; It is very easy to create files in The name given to this file is Hello.Txt.&gt;Enter&lt; It is
DOS. &gt;Enter&lt; Once all the required text is entered, very easy to create files in DOS. &gt;Enter&lt; Once all the
hit the &gt;Ctrl+Z6&lt; keys together to mark the end of required text is entered, hit the &gt;Ctrl+Z&lt; keys
text. &gt; Ctrl+Z&lt; keys tell DOS that no more text is together to mark the end of Text. &gt;Ctrl+Z&lt; keys tell

going to be entered now. Again hit the &gt;Enter&lt; key. DOS that no more text is going to be entered now. Again
hit the &gt;Enter&lt; key. (
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Displaying Contents of Files — The TYPE Command The Displaying contents of files: The TYPE Command The
contents of any file can be viewed very easily by giving contents of any file can be viewed very easily by giving
the TYPE command followed by the filename. Let us see the TYPE command followed by the file name. Let us see
the contents of file HELLO.TXT that we have just created the contents of file HELLO.TXT that we have just created
by issuing the following command. C:\&lt; TYPE by issuing the following command. C:\&lt; TYPE
HELLO.TXT &gt;Enter&lt; HELLO.TXT &gt;Enter&lt;
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My first DOS file. The name given to this file is HelloTxt. It My first DOS file. The name given to this file is
is very easy to create files in DOS. Hello.Txt.&gt;Enter&lt; It is very easy to create files in DOS.
&at;
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You can also send the output of a file to the printer. The
following command starts the printing job, provided the
printer is on. C:\&lt; TYPE HELLO.TXT &lt;PRN

&gt Enter&lt;

26 WORDS

100% MATCHING TEXT 26 WORDS
You can also send the output of a file to the printer. The
following command starts the printing job provided the
printer is on. C:\&lt; TYPE HELLO.TXT &lt;PRN

&gt;Enter&lt; (
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At times you may require to display a text on the screen
while executing a set of commands. The ECHO
command helps you to display a meaningful message on
the screen. This command is issued as illustrated below:
C:\&lt; ECHO Please insert floppy in drive A: &gt;Enter&lt;
The ECHO command is a special DOS command used
exclusively in batch files (files containing a set of DOS
commands)
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At times, you may require to display a text on the screen
while executing a set of commands. The ECHO
command helps you to display a meaningful message on
the screen. This command is issued as illustrated below:
C:\&lt; ECHO Please insert floppy in drive A: &gt;Enter&lt;
The ECHO command is a special DOS command used
exclusively in batch files (the files containing a set of DOS
commands).
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There is one more form of ECHO command i.e. ECHO
OFF as shown below: C:\&lt;ECHO OFF &gt;Enter&lt; The
above command tells DOS not to display other
commands in the batch file.
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Users always prefer to see the prompt for currently
logged sub-directory. The PROMPT command tells DOS
to include the sub-directory, greater than (&lt;) sign, date,
time or any text as a part of the prompt. The various
forms of PROMPT command are discussed below: i. To
display the path designation (e.g. \ACCOUNT\EXPENSE)
and the greater than sign as a DOS prompt, issue the
following command: C:\&lt;PROMPT SpSg &gt;Enter&lt;
After giving the above command, if you are logged to
EXPENSE sub-directory of ACCOUNT sub-directory in
the root directory, then the following prompt will come
on the screen: C:\ACCOUNT\EXPENSEG&t;_ 115
Introduction to
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Users always prefer to see the prompt for currently
logged sub-directory. The PROMPT command tells DOS
to include the sub-directory, greater than (&lt;) sign or
any text as a part of the prompt. The various forms of
PROMPT command are discussed below: (i) To display
the path designation (e.g., \ACCOUNT\EXPENSE) and the
greater than sign as a DOS prompt, issue the following
command: C:\&lt; PROMPT SpSg &gt;Enter&lt; After
giving the above command, if you are logged to EXPENSE
sub-directory of ACCOUNT sub-directory in the root
directory, then the following prompt will come on the
screen: C: \ACCOUNT\EXPENSE&lt;_ (i) To
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along with path designation and greater than prompt,
issue the following command: C:\&lt;PROMPT Welcome
to IMT $pSg &gt;Enter&lt; The above command will
display the following prompt: Welcome to IMT C:\&lt;_ iii.
To display
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along with path designation and greater than prompt,
issue the following command: C:\&lt;PROMPT | Love pSg
&gt;Enter&lt; The above command will display the
following prompt: | Love C: \&lt;_ 51 PC-Software

Packagesliii) To display
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issue the following command: C:\&lt; PROMPT $d St SpSg
&gt;Enter&lt; The above command will display the
following prompt: SUN 11-15-1998 13:21:23.36 C:\&lt;_
iv. To display just greater than sign without path
designation, you can give the following command:
C:\&lt;PROMPT &gt;Enter&lt; The command will display
the following prompt: C&lt;_ Specifying a Sub-directory
PATH — The PATH
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issue the following command: C:\&lt;PROMPT | Love
India SpSg &gt;Enter&lt; The above command will display
the following prompt: | Love India C: \&lt;_ 51 PC-
Software Packages(iii) To display just greater than sign
without path designation, you can give the following
command: C:\&lt;PROMPT &gt;Enter&lt; The command
will display the following prompt: C &lt;_ (H) Specifying a
sub-directory PATH: The PATH

W  https://www.docsity.com/en/computer-applications-in-management/2326921/

170/291 SUBMITTED TEXT 20 WORDS
By this time, you must be familiar with the directory
structure of DOS. Suppose your program (say
PRINCE.COM file) lies
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PRINCE.COM file) lies
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the GAME sub-directory of the root directory and you
want to execute it from any other sub-directory (say
WINDOWS). To execute PRINCE.COM file, first you will
have to make GAME as the currently active sub- directory
and then issue the following command:
C:\GAMES&t;PRINCE &gt;Enter&lt; DOS provides a
shortcut way to locate and run the above program from
any other sub— directory by specifying the path as
illustrated below: C:\WINDOWS§&lt;PATH C:\GAME
&gt;Enter&lt; The above command tells DOS that GAME
sub-directory is in the current search path of DOS. DOS
will first search the required program file in the currently
logged drive and then GAME sub-directory. Thus, the
PRINCE.COM file can be executed directly from
WINDOWS or any sub-directory as shown below:
CAWINDOWSHLt;PRINCE &gt;Enter&lt; The PATH
command is generally used in batch files
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The commands which are a part of the main files of DOS
(i.,e. COMMAND.COM and two hidden files) are known as
Internal Commands. They are loaded in the RAM as soon
as the computer is switched on. The important internal
commands are DIR, COPY, DEL, REN, MD, CD, RD, TYPE,
COPY CON, DATE, TIME, CLS, ECHO, PROMPT and PATH.
We have already discussed all these commands quite in
detail. These commands are very frequently used.
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as Internal Commands. They are loaded in the RAM as
soon as the computer is switched on. The important
internal commands are: DIR, COPY, DEL, REN, MD, CD,
RD, TYPE, COPY CON, DATE, TIME, CLS, ECHO, PROMPT
and PATH. We have already discussed all these
commands quite in detail. These commands are very
frequently used.
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External commands are those commands which are
stored on disks as separate program files. These files have
the same primary name as the command name. The
extension of these files is either COM or EXE. So, at the
time of execution of these commands, the corresponding
program file should be present in the DOS sub-directory
of the harddisk and DOS sub-directory should also be in
the path search. The commonly used external commands
are— FORMAT, DISKCOPY, CHKDSK, XCOPY and LABEL.
Let us learn about these commands.
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At this point, insert the diskette whose contents are to be
copied and then hit any key. Another message appears on
the screen as shown below: Insert TARGET diskette in
drive A Press any key to continue So, after this message
appears, insert the diskette into which the files are to be
copied. Thereafter, press any key to continue the process.
Once the process of copying is completed, the following
screen appears: Copy Complete Copy Another (Y/N)?_
Press the "Y' (for Yes) key if you want to copy the contents
of some other diskette. DOS will again prompt you to
enter the source diskette. However, if you want to stop
the DISKCOPY process, press ‘N’ (for No). DISKCOPY
command first formats the target diskette if it is
unformatted and then copies files onto it. So, if any
contents exist on the target diskette, they are all going to
be removed. The DISKCOPY command
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DISKCOPY command needs the program file
DISKCOPY.COM for execution. 5. Copying files and

directories: XCOPY Command XCOPY
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XCOPY Command The XCOPY command is used to copy
the files present in sub-directories. The command 'COPY
* *' copies the files of the currently working directory and
DISKCOPY command copies the entire contents from
one floppy to another. So, they are not helpful in copying
files selectively. The XCOPY command offers three
special advantages: a. It prompts you to specify the files
that you want to copy. b. It can also copy directories and
other lower level directories. c. It can be used to copy
files from the hard disk to the floppy disk. Now, let us
explore the XCOPY command. If you wish that DOS
should ask for your confirmation for copying a file, then
use the /P option along with the XCOPY command.
Consider the following example: C:\&lt; XCOPY
C:ACCOUNT A:ACCOUNT /P &gt;Enter&lt; If you want to
copy the directories and lower level directories, then use
the /S option alongwith the XCOPY command. Look at
the following example: C:\&lt;XCOPY C: ACCOUNT
A:ACCOUNT /S &gt;Enter&lt; This command will copy
the directory and all the sub-directories onto the A disk.
However, if the /S option is not specified, then the XCOPY
command works within the single directory. You can also
use /P and /S option simultaneously with the XCOPY
command as shown below: 120
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C:\&lt;XCOPY C:ACCOUNT A:ACCOUNT /P/S
&at;Enter&lt; The whole path can be specified with the
XCOPY command. This command again needs the
program file XCOPY.EXE in order to get executed.
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program file XCOPY.EXE in order to get executed.
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Very often, you keep keying in the same sequence of
commands to do a repetitive job. For example, everyday,
when you start your work on the computer, you first see
the listing of files present on the hard disk. Then, you
copy all the files with extension EXE and TXT from the
floppy disk to hard disk. Thus, for achieveing your task,
you have to issue the following commands everyday.
C:\&lt;DIR/P &gt Enter&lt; C:\&lt; COPY A: *.EXE C:

&gt Enter&lt; C:\&lt; COPY A: *TXT C: &gt;Enter&lt; DOS
can really simplify your task. All the sequence of
commands can be put in a file which is called a batch file.
This file offers a great advantage. Any number of
commands given in a batch file can be executed by just
giving a single command at the DOS prompt. DOS
executes all these commands one by one.
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PC-Software PackagesDOS can really simplify your task.
All the sequence of commands can be put in a file which
is called a batch file. This file offers a great advantage. Any
number of commands given in a batch file can be
executed by just giving a single command at the DOS
prompt. DOS executes all these commands one by one.
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All the batch files can have any primary name but the
extension given to these kinds of files is BAT. The method
of creating a batch file is exactly similar to that of creating
any other file on DOS. Let us see it through an example.
C:\&lt;COPY CON PREETI.BAT &gt;Enter&lt; DIR/P
&gt;Enter&lt; COPY A: *.EXE C: &gt;Enter&lt; COPY A:
*TXT C: &gt;Enter&lt; &gt CTRL+Z&lt; &gt;Enter&lt; In the
above example, a batch file by the name PREETI.BAT has
been created.
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All the batch files can have any primary name but the
extension given to these kinds of files is BAT. The method
of creating a batch file is exactly similar to that of creating
any other file on DOS. Let us see it, through an example:
C:\&lt;COPY CON MY. BAT &gt;Enter&lt; DIR/P
&gt;Enter&lt; COPY A: *.EXE C: &gt;Enter&lt; COPY A:
*TXT C: &gt;Enter&lt; &gt CTRL+Z&lt; &gt;Enter&lt; In the
above example, a batch file by the name MY.BAT has
been created.
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if you want to execute this file, simply type in the name of
the file at the DOS prompt as shown below:
C:\&lt;PREETI.BAT &gt;Enter&lt; or C:\&lt;PREETI
&gt;Enter&lt; The commands given in this batch file are
going to be executed one by one in the sequence
specified. The AUTOEXEC.BAT F | L E The AUTOEXEC.BAT
is an autoexecutable batch file. It is a special kind of a
batch file. This file is executed as soon as the operating
system is loaded in the computer's memory. The
AUTOEXEC.BAT file is needed when you want it to be
executed automatically each time the system is switched
on. Now, as soon as the computer is switched on, DOS
searches for the AUTOEXEC.BAT file in the root directory
of the bootable disk. If the system finds this file, then all
the commands given in it are executed 121
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of the file at the DOS prompt as shown below:
C:\&lt;MY.BAT &gt;Enter&lt; or C:\&lt;MY &gt;Enter&lt;
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executed one by one in the sequence specified. The
AUTOEXEC. BAT File The AUTOEXEC.BAT is an
autoexecutable batch file. It is a special kind of a batch
file. This file is executed as soon as the operating system
is loaded in the computer's memory. The AUTOEXEC.BAT
file is needed when you want it to be executed
automatically each time the system is switched on. Now,
as soon as the computer is switched on, DOS searches
for the AUTOEXEC.BAT file in the Root directory of the
bootable disk. If the system finds this file, then all the
commands given in it are executed
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one by one instantly without even asking for date and
time. The AUTOEXEC.BAT file is created like any other
batch file. Look at the following example: A:\&lt; COPY
CON AUTOEXEC.BAT &gt;Enter&lt; ECHO OFF
&at;Enter&lt; CLS &gt;Enter&lt; ECHO My first
Autoexec.bat file successfully executed &gt;Enter&lt;
PROMPT SPSG &gt;Enter&lt; PATH C:\DOS;C:\WINDOWS
&at;Enter&lt; &gt;CTRL+Z&1t; &gt;Enter&lt; Enter the
above commands on the root directory of bootable
floppy disk. Reset your system. You will notice the above
created batch file being executed automatically.

100% MATCHING TEXT 68 WORDS
one by one instantly without even asking for date and
time. The AUTOEXEC.BAT file is created like any other
batch file. Look at the following example: A:\&lt; COPY
CON AUTOEXEC.BAT &gt;Enter&lt; ECHO OFF
&at;Enter&lt; CLS &gt;Enter&lt; ECHO My first
Autoexec.bat file successfully executed &gt;Enter&lt;
PROMPT SPSG &gt;Enter&lt; PATH C:\DOS;C:\
WINDOWS &gt;Enter&lt; &gt;CTRL+Z&lt; &gt;Enter&lt;
Enter the above commands on the root directory of
bootable floppy disk. Reset your system. You will notice
the above created batch file being executed
automatically.

W  https://www.docsity.com/en/computer-applications-in-management/2326921/

18 WORDS

183/291 SUBMITTED TEXT

If it is not present on the floppy disk, then DOS is
searched for on the hard disk
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If it is not present on the floppy drive, the DOS is

searched for on the hard disk.
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various components of Microsoft word window: 1. Title
Bar: Title bar shows the name of the document and
situated in the top of the window application. 978154
32 9 147 Microsoft Word 2000 2. Menu Bar: Menu bar
contains the various commands under the various topics
to perform some special tasks. Menu bar is located
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margins and indents in easier way and they also provide
measurement for the page formatting. 5. Cursor: Cursor
is
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and it also provides measurement for the page

formatting. Microsoft Word Window 6. Cursor: Cursor is
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bar displays the position of the cursor; status of some
important keys of keyboard; the messages for the toolbar
button when a mouse points to it, messages for menu
option, when a menu option is selected or pointed out by
a user
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There are two types of scroll bars: i. Horizontal Scrollbar
i. Vertical Scrollbar
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View Buttons: View buttons are shortcuts of various views
in the View Menu,
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Document Navigator: Document Navigator allows
navigating the document in different types of objects and
is activated when clicked on the ball type button on the
vertical scroll bar. 10. Office Assistant: Office assistant
provides you the online help and real-time tips while
working

SUBMITTED TEXT 40 WORDS

SA Computer Application.pdf (D166063658)

194/291 SUBMITTED TEXT

When you open the Word a blank document appears.
You can start typing on it directly. But for performing
various other activities, you need to learn about the
different menus in the menu bar and the options available
under these menu bars.
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status of some important keys of keyboard, shows the
messages for the toolbar button when a mouse 158
points to it, displays messages for menu option when a

menu option is selected or pointed out by a user. 9.
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When you open the word a blank document opens. You
can start typing on it directly. But for performing various
other options you have to learn about the different
components in the window and the options under these

bars. 157 1.
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or Ctrl+Page Down Start or end of the document
Ctrl+Home or Ctrl+End File-Related Operations
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a New File 1. Click on the File menu. Click on the New
option or press Ctrl+N through the keyboard
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Select the Blank document from the General Tab from
the dialog box and then press OK button.
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Save a Document For saving a document: 1. Click on the
File-&lt;save option. 150
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standard toolbar If you are saving the file for the first time,
the Save as window will appear on the
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a new file, Click on the File menu. Then Click on the new
option or you can directly press the Ctrl+N from the

keyboard.
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the following dialog box and then press OK button.
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Save a Document: For saving a document, Click on the

File» Save option.
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standard toolbar. If you are saving the file for the first

time, the Save As... window 183 will appear. Choose the
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Choose the appropriate folder from Save in combo box.
3. Write the proper file name in the File name text box. 4.
Then press the Save button.
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Save and Save as options do the same work of saving a
document. However, the difference between both option
is that the Save as command
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Opening of an Existing Document To open an existing
document: 1. Select the Open option from the File menu.
OR press Ctrl+O OR Click on the Open tool icon at the
standard toolbar. Then the Open dialog box will appear
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Select the appropriate folder from look-in combo box. 2.
Select the required file from the file window. OR Write the
required file's name in the file name window. 3. Click on
open button on the right hand side OR Press Enter
Closing of Document To close an already opened
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Document Interface).
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Page Setup From the Page setup option one can setup
the page layout (margins etc.). To use the Page setup
option you have to perform the following steps: 1. Click
on the Page setup option from the file menu then
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enter the distance you want between the top of the page
and the start line on the page. ii. In Bottom margin, enter
the distance you want between the bottom of the page
and start last line on the page. iii. In Left option, enter the
distance you want between the left edge of the page and
the left edge of unindented lines.
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Gutter option, enter the amount of extra space you want
to add to the margin for binding. Word adds the extra
space to the left margin of all pages, if you clear the
Mirror margins check box, or to the inside margin of all
pages if you select the Mirror margins check box.
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enter the distance you want from the top edge of the
paper to the top edge of the header. If the Header setting
is larger than the Top setting, Word prints the body text
below the header. vii In Footer option, under From edge
frame, enter the distance you want from the bottom
edge of the paper to the bottom edge of the footer. If the
Footer setting is larger than the Bottom setting, Word
stops printing the body text above the footer.
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Adjust the different margins or apply different options
from the margin tab. i. In top margin, enter the distance
you want between the top of the page and the start line
on the page. ii. In Bottom margin, enter the distance you
want between the bottom of the page and start last line
on the page. iii. In Left option, enter the distance you
want between the left edge of the page and the left edge
of unindented lines. iv. In Right option, enter the distance
you want between the right edge of the page and the
right end of a line with no right indent. v. In Gutter option,
enter the amount of extra space you want to add to the
margin for binding. Word adds the extra space to the left
margin of all pages, if you clear the Mirror margins check
box, or to the inside margin of all pages if you select the
Mirror margins check box. vi. In Header option, under
From edge frame, enter the distance you want from the
top edge of the paper to the top edge of the header. If
the Header setting is larger than the Top setting, Word
prints the body text below the header. vii In Footer
option, under From edge frame, enter the distance you
want from the bottom edge of the paper to the bottom
edge of the footer. If the Footer setting is larger than the
Bottom setting, Word stops printing the body text above
the footer. viii. Check Mirror margin checkbox to adjust
left and right margins so that when you print on both
sides of the page, the inside margins of facing pages are
the same width and the outside margins have the same
width. ix. Check the 2 pages per sheet checkbox to print
the second page of a document 155
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box. vi) In Header option under From edge frame enter
distance you want from the top edge of the paper to the
top edge of the header. If the Header setting is larger than
the Top setting, Word prints the body text below the
header. vii) In Footer option under From edge frame,
enter the distance you want from the bottom edge of the
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setting is larger than the Bottom setting, Word stops
printing the body text above the footer. viii) Check Mirror
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facing pages are the same width and the outside margins
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left and right margins so that when you print on both
sides of the page, the inside margins of facing pages are
the same width and the outside margins have the same
width.
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click the portion of the document you want to apply the
current settings to in the Page Setup dialog box.
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document you want to apply the current settings to in
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From the Paper size tab you can set the length or width
of the page. When you click on the Paper size tab the
following window will appear.
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In the above window you can adjust the following: i.
From Paper size list box you can select the predefined
Paper sizes. ii.
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Width and Height text boxes, the custom Paper size can
be defined by adjusting the Height and width of the
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iii. Select the orientation of the paper as Landscape or
Portrait from orientation frame.
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Print Option For taking the printout, you have to select
the print option of the file menu. After selecting the print
option from file menu, the window given below will
appear: Figure 7.13 You can set various options before
taking printout. i. From the Name combo box you can
select the printer if
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ii. You can select the range of pages i.e. all pages or
current page or number of pages you require from Page
range frame. iii From the Print option you can choose
which part of
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document you want to print i.e. the whole document or
comments or anything else. iii. From print option the
pages can be selected to printi.e. all pages or all even
pages or all odd pages. iv. You can choose number of
copies from Number of copies option under Copies
frame. v. From Pages per sheet option under Zoom
frame, you can select the number of pages in the
document that you want to print on single sheet of paper.
vi. From Scale to paper size option, you can select the
paper size on which you want to print the document. For
example, you can specify that a B4-size document
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on A4-size paper by decreasing the size of the font and
the graphics. This feature is similar to the reduce/enlarge
feature on a photocopy machine.
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The collate check box can print the copies of the
document in proper binding order.
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Once the text of a document has been typed, it is
required to be formatted.
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MS-Word provides format menu to give a meaningful
format your document so that a user can read and
understand the document in an easy
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Format of font i.e. the font type, font size, font style, font
color, character spacing etc. can be changed through the
option Font of Format menu.
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Select the desired text to change the font. 2. Select the
Font option from Format menu. 161 Microsoft Word
2000 Figure 7.17 3. Scroll through the Font list and select
the font that you want. 4. Select the color; underline style
and
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effects of your choice. 5. Select the font style according
to the text. 6. Click on Ok button.
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Alignment of Paragraph Alignment refers to the way the
right and left edges of a paragraph line up along the right
and left margins of your document. Word gives you four
alignment choices-left, centered, right and justified
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you have to perform the following steps: 1. Click on the
paragraph in which you want to change the
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Working with Columns You can use columns to create
documents such as newsletters or book pages. The
column option controls the width and number of
columns. Narrower column widths make your text easier
to red. Often, creating columns enables you to fit more
text on a single page. Columns work particularly well
where you have several shorter topics making up a larger
document, as a newspaper.
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To Create a Column: 1. Select the text which you want to
convert in column . 2. Click on the column button in the
Standard toolbar. 3. A drop-down list appears with four
columns across it. Click on the first column in the drop-
down list and drag across to highlight desired number of
columns.
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documents such as newsletters or book pages. The
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Various Components of Microsoft Excel Functions of
various components of Microsoft Excel is given below: 1.
Title
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Title Bar: Title bar shows the name of the document and
is situated in the top of the window application. 2. Menu
Bar: Menu bar contains various commands under various
topics to perform some special tasks. Menu bar is located
below the title bar 3. Standard Toolbar: Toolbar is nothing
more than the shortcuts of different Menu options to
execute or perform the menu options in the easier and
faster way. Standard toolbar contains icons for the Excel's
most frequently used commands. 4. Formatting Toolbar:
Formatting toolbar contains the various
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stop
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the commands related to the formatting of the
document. 5. Status Bar: It displays the positioning of the
cursor, displays the status of some important keys of
keyboard, shows the messages for the toolbar button
when a mouse points to it, displays messages for menu
option when a menu option is selected or pointed out by
a user. 6.
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Formula Bar: Formula bar shows you the formula instead
of the result whenever you click on a cell in which you
have a formula. 7. Rows: Rows are combination of all the
cells joined together in
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is situated in the top of the window application. 2. Menu
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Formatting Toolbar: Formatting toolbar contains the
various
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the various commands related to the graphics and the
drawing options. 8. Status Bar: It displays the positioning
of the cursor, displays the status of some important keys
of keyboard, shows the messages for the toolbar button
when a mouse 158 points to it, displays messages for
menu option when a menu option is selected or pointed
out by a user. 9.

98% MATCHING TEXT 36 WORDS
Formula Bar: Formula bar shows you the formula instead
of the result whenever you click on a cell in which you
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single horizontal line. An Excel workbook has maximum
65,536 rows in a worksheet 188 Basic Computer Skills 8.
Columns: Columns are combination of all the cells joined
together in
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columns in a worksheet 9. Cell: A Cell is an intersection
of
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column. It is used to store data. There are 65536 x 256 =
16777216 cells in a single worksheet. 10. Name Box: This
box shows the name or the address of the currently
active cell. 11. Office Assistant: Office assistant provides
you online help
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real-time tips while working. 12. Scroll Bars: There are
two scroll bars The scroll bar is used to move the
Worksheet in either directions.
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name suggests, it is the working area in which you can
work. Each worksheet of a single workbook has its own
identity
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separate from other worksheets. The maximum limit of
the worksheets in a workbook is 255.
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To open a new workbook: 1. Click on the File Menu
(Figure 8.4) 2. Select option New
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File menu. File Menu To open a new workbook: 1. Click
on the File Menu (Figure 8.4) 2. Select option New or
press Ctrl+N.
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Click the OK Button. Now you will get a fresh new
workbook to work on.
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a Workbook 1. Click on the File-&lt;save option. OR Press
Ctrl+S OR Click the Save Button on standard toolbar If
you are saving the file for the first time the, Save as
window will appear. 2. Choose the appropriate folder
from Save in combo box. Figure 8.7 3. Write the proper
file name in the File name text box 4. Press the Save
button Save and Save As options do the same work of
saving a document
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a document, Click on the File» Save option. OR Press
Ctrl+S OR Press the Save tool from standard toolbar. If
you are saving the file for the first time the Save as
window will appear. Choose the appropriate folder from
Save in combo box. Write the proper file name in the File
name text box. And then press the Save button Save and

Save As options do the same work of saving a document
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The difference between both options is that the Save as
command every time gives you the Save as dialog box
and you can save the file with different name also, but the
Save option gives you the Save As dialog box when you
are saving the document for very first time. Next time it
will save the document with the previous name without
showing any dialog box.
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Opening an Existing Workbook To open an existing
workbook following steps are required: 1. Select the
Open option from the File menu OR Press Ctrl+O OR
Click on the Open tool from the standard toolbar Then
the open dialog box will appear
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Select the appropriate folder from Look in combo box. 3.
Select the required file from the file window OR Write the
required file's name in the File name window 192 Basic
Computer Skills 4. Click on open button on the right
hand side OR Press Enter Closing
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To close an already opened workbook just choose the
close option from
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Microsoft Excel works in MDI (Multi Document Interface)
environment unlike notepad which works in SDI(Single
document interface).
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Page Setup From the Page setup option, one can setup
the page layout according to his work.
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the Page setup option you have to perform the following
steps: 195 Microsoft Excel 2000 1. Click on the Page
setup option from the file menu then
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window will appear: Figure 8.14 2. Select the page
Orientation from Portrait or Landscape options. 3. Setting
the Adjust to scaling option will reduce or enlarge the
printed worksheet. Select the Adjust to check box, and
then enter a percentage number in the % normal size
box. You can reduce the
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normal size. 4. Change the value in Fit to option to fit the
worksheet or selection you
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the specified number of pages. Select the Fit to check
box; enter a number in the page(s) wide by box; and
enter a number in the tall box. To fill the paper width and
use as many pages as necessary, type 1 in the pages(s)
wide by box and leave the tall box blank. 5. Select the
Paper size 6.
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Page Setup From the Page setup option, one can setup

the page layout according to his work.
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the Page setup option, you have to perform the following
steps: 1. Click the Page setup option from the file menu.

Then
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window will appear. 2. Select the page Orientation from
Portrait or Landscape. 3. Setting the Adjust to setting will
Reduces or enlarges the printed worksheet. 4. Select the
Adjust to check box, and then enter a percentage number

in the % normal size box. You can reduce the
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normal size. 184 Give the value to ‘Fit to'. Setting to ‘Fit

To' reduces the worksheet or selection when you
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the specified number of pages. Select the ‘Fit to’ check
box, enter a number in the page(s) wide by box, and enter
a number in the tall box. To fill the paper width and use as
many pages as necessary, type 1in the pages(s) wide by
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enter the distance you want between the top of the page
and the first line on the page. ii. In the Bottom option
enter the distance you want between the bottom of the
page and the last line on the page. iii. In the Left option
enter the distance you want between the left edge of the
page and the left edge of unindented lines.
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top option enter the distance you want between the top
of the page and the first line on the page. ii. In the Bottom
option enter the distance you want between the bottom
of the page and the last line on the page. iii. In the Left
option enter the distance you want between the left edge
of the page and the left edge of unindented lines. iv. In
Right option enter the distance you want between the
right edge of the page and the right end of a line with no
right indent. v. In Header option enter the
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distance you want from the top edge of the paper to the
top edge of the header. If the Header setting is larger than
the Top setting, Excel prints the body text below the
header. vi. In Footer option enter the distance you want
from the bottom edge of the paper to the bottom edge
of the footer. If the Footer setting is larger than the
Bottom setting, Excel stops printing the body text above
the footer 8.

73 WORDS

SA Computer Application.pdf (D166063658)

267/291 SUBMITTED TEXT

Right option enter the distance you want between the
right edge of the page and the right end of a line with no
right indent.
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top enter the distance you want between the top of the
page and the top of the first line on the page. ii) In
Bottom margin enter the distance you want between the
bottom of the page and the bottom of the last line on the
page. iii) In Left option enters the distance you want
between the left edge of the page and the left edge of
unindented lines. iv) In Right option enter the distance
you want between the right edge of the page and the
right end of a line with no right indent. v) In Gutter option
enter the
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distance you want from the top edge of the paper to the
top edge of the header. If the Header setting is larger than
the Top setting, Word prints the body text below the
header. vii) In Footer option under From edge frame,
enter the distance you want from the bottom edge of the
paper to the bottom edge of the footer. If the Footer
setting is larger than the Bottom setting, Word stops
printing the body text above the footer.
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Print Option For taking the printout, you have to select
the print option of the file menu. After selecting the print
option from file menu the window given below will
appear. You can set various options before taking
printout. 197

38 WORDS

SA Computer Application.pdf (D166063658)

269/291

From the Name combo box you can select the printer if
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You can select the range of pages i.e. all pages or current
page or number of pages you require from Print range
frame. iii From the print what option you can choose
which part of a worksheet you want to print i.e. some
selection or Entire workbook or active sheets only. iv. You
can choose number of copies
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To reverse changes while editing undo command is used.
To undo you can i. Click on the Undo option under Edit
menu OR
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Header option enter the distance you want from the top
edge of the paper to the top edge of the header. If the
Header setting is larger than the Top setting, Excel prints
the body text below the header. vi. In Footer option enter
the distance you want from the bottom edge of the
paper to the bottom edge of the footer. If the Footer
setting is larger than the Bottom setting, Excel stops
printing the body text above the footer 8.
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Print Option For taking the printout you have to select the
print option of the file menu. After selecting the print
option from file menu the window given below will
appear. 185 You can set various options before taking
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From the Name combo box you can select the printer if
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You can select the range of pages i.e. all pages or current
page or number of pages you require from Print range
frame. 3. From the print what option you can choose that
which part of a worksheet you want to print i.e. some
selection or Entire workbook or active sheet only. 4. You

can choose number of copies
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To reverse changes while editing, undo command is
used. To perform undo you can Click on the Undo option

under Edit menu Or
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Click on the Undo button on Standard toolbar OR iii.
Press Ctrl+z. Redo If an undo has to
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last reversed action, this is known as Redo. To perform
redo you can: i. Click on the Redo option under Edit
Menu ORii. Click on the Redo button on Standard
Toolbar OR iii. Press Ctrl+y
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Edit menu OR Click on the cut button of standard toolbar
OR Press
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Copying means duplicating the contents of the
document at some other desired place. The procedure
for copying text is almost the same as that of moving text
with a little difference, which is being discussed in
following steps:
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Edit menu OR Click on the copy button of standard
toolbar OR Press
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the Edit menu, click Find. Find what dialog box will appear
(Figure 8.25). ii. In the Find what box, enter the text that
you want to search for. iii. Select the direction of search
from Search list box. iv. Select any other options that you
want. Match Case: To find the characters that are a word
by themselves and are not a part of another word. Find
Entire Cell Only: To find the characters that are
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toolbar Or Press
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the Edit menu, click Find or Ctrl+F. Then you will see the
window shown In the Find what box, enter the text that
you want to search for. Select the direction of searching
from Search list box. Select any other options that you
want. 166 Match case: To find the characters that are a
word by themselves and are not a part of another word.
Find whole words only: To find the characters that are
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find similar word again in the rest of the document click
on the Find next button. Replace If you have to replace a
word in the document with another word you can use
find and replace command
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In the Find what box, enter the text that you want to
search for.
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on the Find next button. Replace: If you have to replace a
word in the document with another word you can use

find and replace command.

71% MATCHING TEXT 14 WORDS

SA Fundamental of PC Software BLOCK 1.pdf (D164969260)

281/291 SUBMITTED TEXT 29 WORDS

the Find what box, enter the text that you want to search
for. iii. In the Replace with box, enter the replacement
text. iv. Select other options that you want. 204
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Click Find Next, Replace, or Replace All. vii To cancel a
search in progress, press ESC. Figure 8.26 Goto To go to
a particular location or particular item use Goto option
under the Edit menu.
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Click on the Goto option under the Edit menu. Then the
following window will appear on the screen.
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you have to perform the following steps. 1. Click on the
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search in progress, press ESC. 167 Go to: Togo toon a
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LEARNINGOBJECTIVES After completing this
unit, you will be able to understand: ?
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The largest type of computer commonly used is
mainframes. Mainframe computers are used where many
people in a large organization need frequent access to
the same information, which is usually organized
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It used to be common for mainframe computers to
occupy
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In the Find what box, enter the text that you want to
search for.
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The largest type of computer in common use is the
mainframe. Mainframe computers are used in large
organizations like insurance companies and banks many
people need frequent access to the same data, which is

usually organized
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It used to be common for mainframe computers to
occupy
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entire rooms or even an entire floor of a high rise
building. Typically, they were placed inside glass offices
with special air conditioning to keep them cool and on
raised floors to accommodate all the wiring needed to tie
the systems together. This setup is not used anymore.
Mainframes today,
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RAM, 150 times more storage capacity and a

much RAM, about 100 times more storage capacity, and a
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